
 Welcome! 

Welcome to the documentation hub for eM Client, a fully-featured email client for 
Windows and macOS. 

eM Client also offers features for calendars, tasks, contacts, notes, and chat in one seamless 
package for professionals and home users alike. 

The documentation material describes and explains everything about eM Client - from getting 
started, accounts management and settings, through the entire functionality, to advanced features. 

Where to begin 

• What's New - Check out the list of new features for this version of eM Client.

• Key Features - Take a look at some of the features that are unique and important.

• Tour of the Interface - Become familiar with eM Client's user interface first-hand.

• Getting Started - Now that you downloaded and familiarized yourself with eM Client, get
started. 

Boost your email and skyrocket your productivity with eM Client! 
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What's New  
The list of implemented features is constantly growing. Here are just a few new features that have 
been added in version 10.0 & 10.1:  

  

General 

- Search moved to the middle above toolbar 

- Folder selector for search redesign 

- NOT and OR operators in search 

- Mentions in emails and chat 

- Emoticons lookup 

- Data files 

- Overall UI and visual improvements 

- Blacklist editable in settings 

- Scrollbar options moved to Settings 

- Postbox Importer 

  

Email 

- Generative AI integration 

- Customizable email classification into Inbox Categories 

- Quick Actions 

- Conversations UI redesign with preview 

- Change the Conversation order 

- Conversations sync with Exchange 

- Folder colors 

- Folder filter 

- Preview for PDF attachments 

- New synchronization options for IMAP 

- Custom color for unread messages 

- Upload indicator 

- HTML Reply/Forward headers 

- Improved table editing 

- Recent badges for new messages 

- Delegated accounts and public folders as subaccounts 

- Ignored paths for IMAP 

- Server-side whitelist and blacklist for IceWarp and SmarterMail 

- Search in whitelist and blacklist 

  

Contacts 

- Improved printing of contacts 

  



Calendar 

- Redesigned Invites section in the sidebar 

- Support for Gmail Default visibility calendar setting 

- Read-only calendars support 

  

Chat 

- Chat redesigned to be a left pane section 

- Support for multichat and groupchat (Slack, MS Teams, IceWarp TeamChat) 

- Support for Rocket.Chat 

  

And much more 
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Key Features 

eM Client’s key features offer a unique mix of functionality for efficient work and communication, 
suitable for individuals as well as for teams. 

Email 

This product is first and foremost an Email client, it supports all the standards email servers, and 
provides you with all the functionality of a modern Email client. In addition it also provides you with 
innovative ways to organize and explore your Email communications with tools such as the Sidebar. 
Moreover eM Client enables you to view your messages in three different conversation modes, to 
learn more about them go to Conversations. 

Rules 

One of the most important and powerful tools which will help you organize and manage your Emails 
is the use of Rules. Rules are a set of logical conditions acting as filters; with Rule Based Filtering 
you can construct rules containing various conditions to separate and categorize all your incoming 
Emails according to their origins, subjects and time stamp; and apply different actions to each 
incoming Email accordingly, such as blocking spam mails or moving them to different locations. 

Follow these links to find out more about Rules, how to construct rules, or how to apply rules. 

Contact Management 

One of the staple roles of most modern Email clients is to act as a virtual contact book for all your 
contacts. This product being more than "most modern Email clients" takes the role of virtual contact 
book several steps further. Following its commitment to be the communications center for its users, 
the application has the ability to merge your email contacts with your chat contacts, creating a 
unified roster of contacts. And based on this central roster, this product parses all your emails and 
Chat messages and recompiles them into communications history logs for each contact. This way 
you can read all your email and Chat chat exchanges that have taken place between you and a 
particular contact in one chronological log, and all this is done in real time in the Sidebar. 

Follow these links to find out more about contacts, how to add new contacts, and the use of 
Communications History. 

Calendar 

This product's Calendar service is more than a simple calendar, it has the ability to maintain 
multiple types of calendar events, separating your professional and private engagements, keeping 
track of the different activities and aspects of your daily life. 

The Calendar has the additional ability to help you arrange meetings and activities with its 
integrated event invite system that can automatically send invitations to and collect responses from 
the participants of your events. 

Follow these links to learn more about the Calendar, how to use the Calendar or how to share 
your calendar events. 

Tasks 

While the Calendar can help you organize your daily activities, Tasks function can act as your 
virtual personal assistant and help you manage all your important daily tasks. Tasks will provide you 
information on your tasks and keep track of their progress. 

Follow these links to find out more about Tasks. 



Chat 

The Chat tool will let you talk to all your contacts in all your Chat/Instant messaging networks, 
without leaving the interface. XMPP, Slack, MS Teams and Rocket.Chat are currently supported. 

Find out more about Chat here. 
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Shortcuts 
You can modify shortcuts by your own choice and preference. To learn how visit section Shortcuts 
in Settings section.  

These are the defaults: 

Main window 

Ctrl + 1 - Mail section 

Ctrl + 2 - Calendar section 

Ctrl + 3 - Tasks section 

Ctrl + 4 - Contacts section 

Ctrl + 5 - Notes section 

Ctrl + 6 - Attachments section 

Ctrl + 7 - Widgets section 

  

Ctrl + Shift + 1 - Sidebar - Contact details 

Ctrl + Shift + 2 - Sidebar - Agenda 

Ctrl + Shift + 3 - Sidebar - Invitations 

Ctrl + Shift + 4 - Sidebar - Chat 

  

F1 - Help 

F5 - Send and Receive + Refresh 

Ctrl + N - Create new Mail / Event / Task / Contact. Depends on the opened section. 

Ctrl + Shitf + N - New all day event / New distribution list. Depends on the opened section. 

Ctrl + Shift + M - New mail 

Ctrl + Shift + K - New contact 

Ctrl + Shift + L - New disctribution list 

Ctrl + Shift + E - New event 

Ctrl + Shift + T - New task 

  

Ctrl + B - Select Contact dialog 

Ctrl + R - Reply 

Ctrl + Shift + R - Reply All 

Ctrl + F - Forward 

Ctrl + Alt + F - Forward as attachment 

Ctrl + Alt + R - Resend 

  

Insert - Flag 

Ctrl + Q - Mark as Read 

Ctrl + U - Mark as Unread 

Ctrl + J - Move to Spam/Inbox. Depends on opened folder. 



Ctrl + P - Print 

Ctrl + Shift + C - Copy to Folder 

Ctrl + Shift + V - Move to Folder 

Ctrl + Shift + A - Archive 

Delete - Delete 

Shift + Delete - Delete Permanently 

  

Ctrl + A - Select All 

Ctrl + X - Cut 

Ctrl + C - Copy 

Ctrl + V - Paste 

Ctrl + Z - Undo 

Ctrl + Y - Redo 

Ctrl + Shift + S - Save As 

Ctrl + Shift + F - Find 

Ctrl + . - Next message 

Ctrl + , - Previous message 

  

Mail window 

F1 - Help 

F4 - Find in body 

Insert - Flag 

Ctrl + P - Print 

Ctrl + Q - Mark as Read 

Ctrl + U - Mark as Unread 

Ctrl + Shift + S - Save As 

Ctrl + R - Reply 

Ctrl + Shift + R - Reply All 

Ctrl + F - Forward 

Ctrl + Alt + F - Forward as attachment 

Ctrl + Alt + R - Resend 

Delete - Delete 

Ctrl + Shift + A - Archive 

Ctrl + Shift + C - Copy to Folder 

Ctrl + Shift + V - Move to Folder 

Ctrl + J - Move to Spam/Inbox. Depends on opened folder. 

Ctrl + . - Next message 

Ctrl + , - Previous message 



  

Send Mail / Compose window 

F1 - Help 

Ctrl + Enter - Send 

F7 - Check Spelling 

Ctrl + T - Translate 

Ctrl + A - Select All 

Ctrl + X - Cut 

Ctrl + C - Copy 

Ctrl + V - Paste 

Ctrl + Shift + V - Paste as text 

Ctrl + Shift + I - Insert image 

Ctrl + M - Insert image as link 

Ctrl + K - Insert link 

F4 - Find 

Ctrl + H - Replace 

Ctrl + S - Save 

Ctrl + Shift + S - Save as 

Ctrl + Z - Undo 

Ctrl + Y - Redo 

Ctrl + P - Print 
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Getting Started 

First steps 

After you run eM Client for the first time, you will be asked if you want to import your data from 
other applications detected on your device (Mozzila Thunderbird, Windows live Mail, Microsoft 
Outlook etc.). Following screen will appear: 

Select an application from which you want the data to be imported and click on Next 

In the case of importing the data from Microsoft Outlook, please notice that data migration from 
IMAP4 servers will be synchronized automatically, but in the event of importing data from local 
servers (or if you choose to import from IMAP4 server locally), you can choose from importing up to 
5 types of data (icons in the upper right corner) - messages, calendars, tasks, contacts, tags.  

If you want to skip some of these five areas, just simply click on the icon and it will disappear. 

The process of importing data from other applications is similar to the one described above, 
just via Menu > File > Import.  

Creating a New Account 
Account wizard will help you to easily create a new account, giving you all the necessary information 
to successfully complete the process in few steps. 

To learn more about creating a new account visit: Create New Account 



Interface 
eM Client offers an industry standard environment that is found on most mainstream email clients, 
such as MS Outlook. This tried and true layout is well-arranged, easy-to-use and intuitive. 

This product's user interface consists of various sections: 

Left side panel: 



 
  

Menu, Search field and Toolbar: 

 
  



Central panel: 

 
  

At the top is the Menu and New button. From there, all the important functions can be accessed.  

In the middle is the "Search " on page 241 which you can use to lookup items. 

 
  

Using the search bar, you can simply search for your emails. A list of several useful command tools 
will appear in the context menu when you type a question mark in the search bar. 

Click on the pointing down arrow to bring up the context menu for search bar: 

 
  

Here you can select, deselect or change area or areas that you want to use for your search. 

Next to the drop-down menu is the Advanced Search icon  - click it to open the Advanced 



search pop-up and quickly specify more details so you can find the messages you're looking for. You 
can also create Search Folders from this pop-up. 

Also at the top is the Main Toolbar which allows you to quickly take actions. 

On the left side panel is the list of Accounts, Favorite folders , and Local folders and their 
folders/subfolders which you will use to navigate between all of your added accounts and saved 
data. This side panel is shown as the Mail View in the picture, but similar left side navigation panels 
occur for all the other services (Calendar, Contacts, Tasks, etc.) in eM Client as well. 

The side panels contain icons and can be collapsed to save screen space! 

If you have more than one account you can use Inboxes section above the favorite folders - this 
section will store each of your Inbox folders separately so you can check your new messages, but 
unlike with 'All Inboes' favorite folder you can keep the accounts separate. If you do not want these 
folders, you can hide them via the setting in Menu > Settings > General> Folders. 

If you right-click on any folder (for example "Inbox") you will bring up the context menu, which 
gives you additional options. 



Show in new Window - This will open a new eM Client Window which is focused on the selected 
folder. Opening multiple windows in eM Client is useful for multi-tasking so you don’t need to switch 
back and forth between things in the application. 

New Folder - creates a new folder 

Rename - renames the folder 

Copy Folder - copies the folder to another location/account 

Move Folder - moves the folder and its contents to another location/account 

Delete - deletes the folder and its contents 

Mark All Message as Read - All messages in the folder will be marked as Read 

Apply Rule - runs a chosen rule on that folder 

Collapse All - will collapse the entire left side panel folder structure to save screen space 

Show - the folder will be shown in the left side bar 

Show if unread - serves for the situation when you do not want the particular folder to be displayed 
unless there are some unread messages. If there are none, the particular folder will be hidden 
under the More folder 

Hide - the folder will be hidden under the More folder 

Add to Favorites - the folder will be linked to the favorite folder 

Folder Color - change the color of the folder, for Google accounts the color is taken from Labels in 
Menu>Tags, additional options on what to apply the color to are available in Folders settings 
section. 

Properties - Gives more information on the folder and allows for additional options/settings for that 
specific folder 



Navigation Panel 

The Navigation Panel can be found in the lower left corner of eM Client and allows you to navigate 
to different functions of the eM Client application. Based on the size of the left side panel and which 
customization options you chose, the display will show different icons representing each section. If 
an icon for a section doesn’t appear due to limited space, it still always be accessible by clicking on 
the three dots 

The Mail icon is used for navigating among your email folders and managing mail. 

 The Calendar icon provides you with access to your Calendar events. 

The Contacts icon provides you with access to your Contacts. 

The Tasks icon provides you with access to your Tasks. 

The Attachments icon can be used to access your Attachments. 

The Notes icon can be used to access your Notes. 

The Widgets icon can be used to access your Widgets. 

The Chat icon can be used to access your Chats. 

You can add or remove any of these items by right-clicking them and selecting the Customize 
Navigation Panel option. 



The Show icons only option will hide the text of the buttons, so you can fit more features on the 
toolbar. You can hover over the buttons to have the title pop up. 

The central panel of the interface can display various contents according to which navigational 
bookmark you are currently working under in the left vertical panel. In this panel you can find the 
contents of your emails, your calendar events, your tasks or your contact details. 
Most sections include a Quick filter in the top right corner, find more about Quick filters here. 

Right Sidebar 

On the right hand side there is the Sidebar. It is a powerful tool in your communication toolbox. It 
provides dynamic contents which will help you manage your contacts, send instant messages, and 
make sense of your email communication. For a full description of what you can do with the Sidebar 
click here. 

Context menu 

The Context Menu is a flexible and useful way to interact with the contents of the application. It is 
useful because you can depend upon it to provide you with the most appropriate options according 
to where you are in the program and what you are currently doing. 

Context menu is accessed simply by right-clicking on any desired item (email, calendar event, task 
etc.). A simple menu will pop up, contained within is a list of all the actions you can perform on the 
selected item. In the Context Menu left-click an action to select it. 

The content of the Context menu changes according to the type of the selected item or the location 
of your right-click. For instance email messages will have different options in their context menu 
than calendar events. Right click on an email would give you the option to reply to the email, 
whereas right-click on a calendar event will give you the option to edit the event. 

Grouping 



This product allows you to group your items (messages, contacts etc.) in the central panel according 
to the column that is currently being used for sorting. This feature was designed to make navigation 
easier for you. It is enabled by default, but if you wish to disable it, just right-click the column 
header and choose Show in Groups from the context menu (the tick next to this option will have 
disappeared when you right-click the column headers again). 

You can easily expand / collapse all groups by right-clicking the group header and selecting Expand 
All Groups or Collapse All Groups from the context menu. 

Grouping also works for your Chat contacts listed in the Sidebar. 

Columns 

You can configure your columns by clicking Columns Configuration - you will see the following 
window: 



 
You can add or remove any of the items to make your view more efficient for you. For example you 
might want to keep the contact avatar or message Preview to quickly see who the message is from 
and what's it about or you might want to remove them to save up space and see more messages at 
once in your message list, since the lines in the list will be thinner. 

 
You can choose to have all of these columns visible: 

• Flag - a typical flag/follow up indicator 

• Read status / Icon - orange dot that indicates that the message is unread, once marked 
as read the dot turns into an empty circle 

• From - sender of the message 

• Subject - subject line of the email 

• Received - time the message was received 

• Size - size of the email, this option will be available only when Conversations are disabled 
(Menu > View > Conversations) 

• Tag - tags and labels assigned to this message 

• Priority - important emails will show an exclamation mark icon 

• Encrypted - a lock icon will show if this message is encrypted with PGP or S/MIME protocol 

• Signed - a seal icon will show if this message has been digitally signed 

• Snoozed - a bell icon will indicate if this message has been snoozed before 

• Tracking pixel - a target icon will indicate that eM Client detected a tracking pixel in this 
message 

• Notes - if you add a note to this email there will be a note icon indicating you can edit or 
remove it, read more about Notes for Emails 

• Attachment - a paperclip icon will show that this email contains an attachment 

• Preview - a 1-3 line preview of the email body 



• Avatar - a contact avatar of the sender, you can decide if you want to see the avatars or
not or change its size in Menu > Settings > Mail > Read

• Folder - what folder is the message saved in, available only with Conversations disabled
(Menu > View > Conversations)

• Sent - time that the message was sent from eM Client, usually shown in Sent folder

• Delivered - confirmed sent time from the mail server, usually shown in Sent folder

• To - who the message was sent to, usually shown in Sent folder

If you click on Customize Current View, you will be redirected to the Mail tab of the Appearance 
section in Settings, where you can customize the appearance of your Lists settings. 

Once you are happy with your setup, you can easily apply your column configuration also to the 
other folders, just right-click the column header, choose Apply Column Configuration to Other 
Folders... from the context menu and then select the folders to which you would like the column 
configuration to be applied. 
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Main menu and toolbar 



Toolbar 

Toolbar provides you with different quick-access options depending on which section of the 
application you are currently working in. When you are in the email section, the email toolbar is 
displayed, which provides you with quick access to various email operations. The same toolbar will 
provide you with different options to perform different operations when you are in calendar mode or 
task mode. 



Menu 

The Menu contains some of the most common functions and settings sections: 

• Print... - you can print your messages, calendar, events or contacts using our print preview
where you can adjust many aspects of the final layout of the page about to be printed.

• Backup... - You can backup your data.

• Check for Update...- if you click on this option, the application will try to look for available
updates for your license online. If an update is found, a list of new features will be displayed
and you will be prompted to confirm that you want to install the update.

• Operations... - You can view ongoing operations, any errors that might have popped up or
the operations log that can be useful for troubleshooting.

• Rules...- You create rules here. You can find further information about creating rules in the
topic Rules.

• Quick Actions... - You can manage Quick Actions here.

• Tags... - Here you can manage your tags active in the eM Client. You can find more
information about managing tags in the topic Working with Tags.

• Reminders... - View the Reminder window with pending reminders for your events or tasks.

• Settings...- When you click on this button, a window with settings will appear. You can find
more information about settings in the topic Settings.

• Accounts...- When you click on this button, a window for working with the accounts will be
displayed. You can find more information in the topic Accounts.



• Data Files... - Opens the Data Files manager.

It also contains six further sections - File, Edit, View, Message, Tools, and Help. 

Those further options can be brought up only by clicking on the menu button first.  

Under all these you have the Exit option to fully close down the app. 

File 

Menu File has these items: 

• Open - You can open a saved email (an eml file).

• Save as - You can save a chosen email to an eml file.

• Close - Close current window.

• Import... - You can import data to the application.

• Export... - You can export data from the application.

• Restore... - You can restore your data.

• Work offline - When you choose this setting, the application will work without connecting
to Internet. If you send an email, it will be saved and it will be sent after connecting to
Internet.

Back to menu. 

Edit 

Menu Edit has many items: 



• Undo - If you delete something, you can undo the operation of deleting.

• Redo - If you performed undo operation, you can now perform redo and the retrieved
operation will be deleted.

• Cut - Cutting copies selected item into clipboard and removes the item from its current
place.

• Copy - When you click on this button, it will make a copy of the selected item.

• Paste - Paste will insert the item currently stored in clipboard (one that was previously cut
or copied).

• Select all - All items will be selected.

• Find... - You can perform textual search - either simple, or you can specify advanced
options for your search.

• Clicking on Find option will bring your focus to the Search in the top right corner of
the window, opening the Advanced Search pop-up (see below).

• Find in Body... - This option will bring up a simple search window to search inside the body
of currently opened message.

• Empty All Trash Folders - This option, as the name suggests, will permanently delete all
messages in all Trash folders in the program (the Local folders and all your accounts'
folders).

Advanced Search 

Advanced search represents a smart utility that enables you to search with predefined rules which 
will filter out particular emails from the global folders, i.e. folders where all your emails are stored. 
As you can see in the picture, search window consists of two parts: textual form of query and the 
visual form of query.  

To learn more about working with search queries and about creating a filtered folder see Search 
Folders.  



Back to menu. 

View 

Menu view has many items: 

• Columns... - You can select columns which you want to see in the list of emails. You can
also change the order of columns.

• Layout - You can change position of the panel with messages - Messages on the bottom,
Messages on the right, Messages panel off.

• Sidebar- You can change layout of the sidebar.

• Conversations - Enables you to customize and specify conversations.

• Show tag bar - Enable or disable the bar with assigned Tags above the message header in
message preview.

• Previous message - The selected item is changed to previous message.

• Next message - The selected item is changed to next message.



Back to menu. 

Message 

Actions menu differs according to the section where you currently are (mail, calendar, tasks, 
contacts etc.) 

Actions Menu has several items: 

• Reply - When you click on this button, you will reply to a selected email.

• Reply All - When you click on this button, you will reply to all people in a selected email.
(for example to people in CC)

• Forward - You can send a selected email to another person. Moreover you can choose from
three actions: Forward..., Forward as Attachment..., Forward as Original... and Resend...

• Flag - by clicking this, you will add a flag to your message (event etc.) - for example to
mark the emails you need to reply to etc.

• Tag- you can choose a color tag that will be added to the message.

• Mark as Read - You can mark your unread email as read.



• Mark as Unread - You can mark your email as unread. It is useful when you read an email
but you don't have a time to answer it so you can mark it as unread.

• Mark All as Read - You can mark all your emails as read.

• Snooze - Snooze your message to be re-added to your inbox at a more convenient time.

• Archive -Move the message into the Archive folder.

• Move to Junk - You can select from three options: Move to Junk, Move to Junk and
blacklist email, Move to Junk and blacklist domain.

• Copy to Folder… - You can copy a selected item into another folder. Last 10 folders you
copied messages to will be remembered in copy history.

• Move to Folder... - You can move a selected item to another folder. Last 10 folders you
moved messages to will be remembered in move history.

• Download Selected for offline use - You can download selected items.

• Create Meeting from Message - You can create a meeting directly from the message.

• Create Task from Message - You can create a task directly from the message.

• Create Rule from Message- Quickly create a rule based on this messages sender or
subject.

• Add Note - Add a local note to your message without altering the original.

• Format - Easily switch the view of current message from HTML to Plain text and vice versa.

• Delete - Deletes the message.

Back to menu. 

Tools 

Menu Tools has these items: 

• Subscribe to Internet Calendar…  - You can set up a calendar access directly from
here.

• Contacts - Clicking on Contacts will bring up the Address Book (see below). This feature can
be used for selecting the particular contact that you want to send a message to. Start writing
contacts's initial letters to search for particular contact.



• Deduplicator... - Deduplicator is a tool which enables you to get rid of duplicate (multiple)
items in following areas: mails, events, tasks, contacts. Click on Deduplicator to bring up
following window:



Select the item type and click on Next: 

Here you can select folders that will be searched for duplicate files and moreover you can specify 
whether you want to search for duplicates in each individual folder or over a group of folders. When 
you are finished click on the Next button. 



Here specify the action to be done for duplicated items found. Click on Finish to finish the process. 

• Automatic Replies - With a Google, Exchange/Office365 or IceWarp account you can set
up automatic responses for all your messages when you're out of office or away on holiday.

• Mail Forwarder - With an IceWarp account you can set up automatic forwarding for your
messages.

• Theme Editor - Open the Theme Editor to create your own theme or tweak one of the
existing ones to your preference, find more details in Themes settings.

• QR Export - used to export data to mobile version of eM Client via a QR code.

Back to menu. 



Help 

Menu Help has several items: 

• Documentation - When you click on this button, a web browser window with the eM Client
documentation will display.

• FAQ - link to the Frequently Asked Questions section of our website

• Video Tutorials

• Blog - link to the company blog which can provide more details on certain features and
updates or current issues.

• Forum - Community forum for all users, main support hub for users with Free licenses and
expired VIP Support

• License - Here you can view, activate or deactivate your license.

• Get VIP support -link to the online support web pagefor Pro license users with active
VIP Support subscription.

• Open Log Directory - opens the Logs folder containing all created .log files

• Profile for 10 seconds - Create profile log that runs for 10 seconds and then saves into a
text file, which can befound in the Logs folder. This can be useful for freezes and other issues
in eM Client that do not have dedicated logging options in the Advanced settings.

• Record Memory Usage - Creates special log file to analyze memory usage of the
program.

• Terms of Use - link to eM Client Terms of Use

• Privacy Policy- link to eM Client's Privacy policy

• Invite to eM Client - when you click on this button, a window with invitation to eM Client
for your friends will appear. You can invite them using: email, Twitter or Facebook.



• About - You can click on this button to see more information about this product and can
copy the currently installed version here.

Back to menu. 

Touch Input interface 

eM Client supports touch-operated devices, if your device has such utility, you will be able to switch 
to touch-operated mode by clicking on the appropriate icon in the right upper corner of eM Client 
window: 

If you switch to the touch mode, all icons and features of the application will become a little larger 
in order to easily control the application. 

In the touch mode: 

• You can scroll in all menus by touch movement (context menus etc.).

• In calendar view you can move in all directions by touching the screen.

• By the pinch-to-zoom action you can change the number of weeks displayed in the month
view of the calendar as well as zoom in/out in the week view.
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Sidebar 
The Sidebar will allow you to quickly access your contacts and their details, your communications 
history with a specific contact, list of tasks that you planned to do and a list of attachments 
exchanged between you and specific contacts. 

There are four sections that make up the Sidebar:  Contact details, Agenda, Invitations and 
Calendar. It can also show Threads for Chat conversations. 

You can hide the Sidebar by clicking on the arrow near the right edge of the bar. 

Just click on the arrow to hide the sidebar. 

Contact Details 

 Contact Details window provides you with quick access to contact details of a selected contact that 
include your contact's email address, mobile/telephone number, skype contact details, and chat 
message contacts.  

Search - Just start typing and search bar will appear. While using the search bar, you can 
search for all types of messages (i.e. mails, chat messages) that you have exchanged with 
your contact in the past. You can switch between History and Attachments by simply 
clicking on the proper button. 



 History panel is called so because it gathers all your written conversations with the contact. It 
includes Emails, Chat messages and also Skype chat messages into one chronological 
communications log. And thereby provide you with a holistic sense of your communications 
with that particular contact. 

Attachments panel contains all the attachments that are attached in the emails exchanged 
between you and the contact. Attachments are sorted in a chronological order, which you can 
customize(ascending/descending) in the Attachment history Options.  

Contact Details settings -You can customize your Contacts Details settings simply by left-

clicking on the Options button. This options button  will appear by hovering with your mouse 
cursor over the area next to the Contact Details header. You can choose the manner in which you 
would like to sort the order of the messages (descending/ascending) and you can also adjust what 
type of messages (mails, chat messages, skype calls) you would like to display or hide. By checking 
the option Include Other Senders you can adjust if you want to include the third party of the 
conversation (f.e. emails , where other participants are included in Bcc or Cc of the particular email) 
and by checking the option Include Entire Domain you can adjust displaying of all emails that may 
have different name of sender/addressee, but the same domain in the particular email address. You 
can select Choose Folders... to select folders from which you would like the contacts to be 
displayed. 



Agenda Section 

Agenda section provides you a quick review of the tasks that you planned to do, upcoming 
birthdays, upcoming events and email messages marked as flagged. All those items are sorted in 
the order of the upcoming date, i.e. the most up-to-date items will be always on top. The Agenda 
also uses the 'Getting Things Done' methodology for your tasks, read more about it in the "Task 
List Display" on page 441. 

Search bar - you can use the search bar for searching within your tasks and events by simply 
starting to write and the search query will appear. Simply enter the "key word" of the item that you 
want to find and the requested item will appear.  

Adding new task - You can add new tasks directly from the sidebar. First and foremost, write the 
title of the new tasks in the field (lower arrow in the picture) and then press enter. Newly created 
task will appear in the "Date:Today" section. By double-clicking on the task the window with 
possible editing of the newly created item will appear. 

For creating and editing tasks see Creating and Editing of Tasks for more detailed description. 

To choose folders from which you would like to display upcoming events, birthdays, tasks and 
flagged emails, simply hover next to the Agenda title and click on the cogwheel icon that pops up. 
Context menu will appear and your next step is choose the option Choose Folders... and a window 
with list of various folders will appear as you can see in the following picture.  



Moreover, you can choose the time horizon in which the displayed upcoming birthdays and events 
will be shown. This time horizon can be changed by selecting various points of time from the 
context menu, again the one which is evoked via the cogwheel icon next to the Sidebar section title. 



Show of Flagged Mails, Upcoming Birthdays, Upcoming Events and Tasks is active by default. 

Invites Section 

This section will automatically take note of the invites in your mailbox and show them in this 
section, so you can quickly resolve all meeting invitations in one place and not scroll through your 
mailboxes to find them. You can also list invites by account or use the search next to the title to 
look up specific events. 



Calendar Section 

The Calendar sidebar can show a single-day in any section - so you can have your emails open 
while checking your daily agenda on the side. The red line will show you current time to see which 
event is near. 

Using the Settings button next to the title you can select which calendars should be taken into 
account in this view. 



Threads 

The thread sidebar will only pop up when you're in the Chat section and decide to open a thread - 
this way you can keep the main conversation in the middle section, and view or reply to the side-
conversations in the separate thread on the right. 
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Creating a New Account 

When setting up a new account, you can choose from several options: 

- Automatic setup - In most cases eM Client enables you to set up your account automatically
with just two simple steps - entering your email address and the password. We strongly recommend
using this method of setting up your account unless you possess thorough details about your
account's settings. The first step is typing in the email address of your existing email account as
well as the account password. The rest of the automatic setup is realized in 3 steps:

• server settings for pre-defined service providers

• try to use Auto-discover protocol

• try to detect server setting by special heuristics

- Connecting to standard email servers: eM Client will attempt to automatically retrieve the
server settings (this works for the most frequently used email servers i.e. Gmail, Yahoo etc.)

- Auto-discover technology: If eM Client is unsuccessful with the first attempt, it will try to use
the so called auto-discover technology, which basically tries to assess the predefined credentials of
email servers. This service is fully automatic and it can autonomously detect the settings if the
correct email information is provided.



- Predicting less usual email servers: In this case, the application tries to search for access
to your account details on the internet, it works on predicting how the address of your email
provider is realized. (For example, this service will be utilized in the cases when a private
company's email addresses will be prompted to set up.)

If all three services fail you will be prompted to specify the settings manually. Learn more about 
setting up email manually here.  

Automatic Account Setup 

Step 1 - Account Details 

In this dialogue you can enter additional information regarding your new account, such as the 
account name and the name that you would like to be displayed in the "From" field of your outgoing 
messages. 

Step 2 - Set up Encryption (optional) 

Next you’ll be asked if you want to set up PGP encryption for your account. This is an advanced 
feature which encrypts your emails to provide better security and privacy. If you would like more 
information on how to set up encryption, you can read about it here. Otherwise, simply click 
“Continue without encryption” to continue setting up your account. 



Step 3 - Finishing up 

Here you can enable/disable services for this account (Mail, Calendar, Contacts, Chat). These 
settings can be changed at any time in Menu > Accounts. 

Depending on if you chose a POP3, IMAP or Exchange incoming server, the final 
options will change. 

Sync Options 

Message sync time period:This setting allows you to synchronize only the newest emails from 
your server with a custom-set time frame. 
The default option is to synchronize messages from All time, which will pose no limit on your 
messages, all the ones on your server will be synchronized with eM Client.  
In case you want to keep only the latest in the app, you can choose from Last 1 day, Last 3 
days, Last week, Last 2 weeks, Last month, Last 3 months or Last year. 

In case you need to check your older emails, at the end of the message list is a button Load more. 
It allows you to download some of the older messages or all messages if the need arises. 

Download options allow you to choose if you’d like to download messages so you can read your 
previously received emails even when you’re not connected to the internet (you will still need to 
reconnect to the internet in order to receive new messages) and you can choose if you’d like the 
search option to also work for your email attachments. 



Finally, you can click on the Finish button to start using the application with your newly added 
account. 

Setting up particular email addresses: 
In this section, you can select particular email accounts that you would like to set up. The first five 
email providers displayed will always be the most used ones in the location where you currently are. 
These five displayed providers will also always have predefined configuration and their server 
settings will be retrieved automatically.  



Manual Account Setup 

In case the automatic setup didn’t work or your email provider isn’t shown, click on the Other 
button to manually set up a different email account. In this case, the setup will be a little more 
complex. It’s performed in seven steps and you will be asked to fill in all the email settings. You can 
find out your account’s server settings by asking your email provider. 

Step 1 - Identity: 
Enter your email address to begin. 



Step 2 - Account type and incoming server information 

Select if your incoming mail server type should be POP3 or IMAP. 

Enter your incoming mail server address. 

Enter your username (usually either the whole email address or just the part before the @ sign 
depending on the provider) and your email account password. 



Step 3 - Outgoing server information 

Enter your outgoing mail server address. This section could be prefilled based on what you entered 
for your incoming mail server, but it's possible that you’ll need to change it to something else 
depending on the provider. 

Your username and password will also be prefilled based on your answers in Step 2. Usually the 
credentials stay the same. 



Step 4 - Testing configuration 

During this step, your configuration will be tested. If your account details were typed in correctly, a 
green checkmark will appear. If there are some problems with the configuration (for example if your 
password was not entered correctly), a red cross will be displayed (as you can see in the picture). 
You can always change your configuration by clicking on the Fix button. 



Step 5 - Adding additional information about your new account: 

In this dialogue you can enter additional information regarding your new account, such as the 
account name and the name that you would like to be displayed in the "From" field of your outgoing 
messages (e.g. jerry@x1solar.com) 



 
  

Step 6 - Set up encryption (optional) 
Next you’ll be asked if you want to set up PGP encryption for your account. This is an advanced 
feature which encrypts your emails to provide better security and privacy. If you would like more 
information on how to set up encryption, you can read about it here. Otherwise, simply click 
“Continue without encryption” to continue setting up your account. 



 

  

Step 7 - Finishing up 

Account avatar - Choose which image you’d like to have to represent your newly added account. 
You can choose from one of our default avatar images or select your own custom image by 
uploading it from your computer. 

  

Depending on if you chose a POP3 or IMAP incoming server, the final options will 
change. 

  

POP3 option: 

On this final screen you can specify if you want the application to create a separate folder tree for 
the messages for your POP3 account, or if the messages should be stored in Local Folders. 



 
  

IMAP option: 

Sync Options allows you to choose if you’d like to download messages so you can read your 
previously received emails even when you’re not connected to the internet (you will still need to 
reconnect to the internet in order to receive new messages) and you can choose if you’d like the 
search option to work for your email attachments. 



 

Setting up Chat 
Here you can add a XMPP/Jabberchat, Slack, MS Teams or rocket.chat account. 

For exact steps, go to the Add a Chat account section. 

  



 
 

  



Setting up your Calendar 

 

CalDAV / CardDAV 

  

CalDAV is a calendar sharing service and CardDAV allows you to share your contacts. In order to set 
up a CalDAV / CardDAV account, you first have to have a CalDAV / CardDAV account on your mail 
server (e.g. IceWarp eMail server). 

Enter the account name, password and its internet location, and you are done! 



 
  

Setting up Contacts 
Here you can set up synchronization with your Google contacts, Yahoo contacts, iCloud Contacts 
and Fruux Contacts. Please note that, in the case of Google, it's Google's native technology, 
whereas in the case of Yahoo and others, this service works on CardDAV technology. 
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Accounts 
  

If no existing accounts are detected, the account wizard will appear automatically, as you can see in 
the following picture. 

  

 
  

Otherwise, the path to create a new account is Menu -> Accounts and then click on New account... 

button.  

  

To add a new account click on Menu in the top left and in the drop-down menu select Accounts. 
You will see the following account management window. 



 
  

Here you can create new accounts, delete existing accounts or select your default account. 

  

Please note the two arrows in the Accounts window toolbar. These can change the order of 
accounts which will affect the order of the folders in the main window on the left.  

  

Create a new account  
Click on +Add account to create an email, calendar, contacts, chat or any other account. You can 
read more about creating new accounts in the section: Create New Account . 

  

Account Avatars 

On the right side of your account details you can see an avatar. Account avatars will help you 
determine which email account your messages belong to in mixed views or search results. You can 
also use them for quick navigation when using minimized left pane.  
For more details on how to change the avatar please go to Edit Account . 

  



Delete an existing account 
To delete an account, select the account you wish to delete and click on Remove account button 

. You will be prompted to confirm the deletion.  

  

This action can endanger your data in case of POP accounts. 

POP protocol downloads messages from your server into your device and deletes them from the 
server - this means that deleting this account from your device might delete the only copy of your 
messages. 

We suggest making a backup or exporting your messages before deleting a POP account. 

  

IMAP and Exchange Web Services accounts synchronize data with the mail server, removing 
these accounts is therefor safe. 

  

Set a default account 
Select the account you wish to be set as your default account and click on Set as default 

. The default account will be active when the application starts.  

Default account will be used when a specific account cannot be detected for use. This means the 
Default account will be applied to new messages, contacts, events, etc. when the focus is set in 
Smart folders or Local folders. 

If you default account does not have its own Calendar and Contacts services you can specify default 
folders in the General tab of the Default account. 
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Accounts 
  

If no existing accounts are detected, the account wizard will appear automatically, as you can see in 
the following picture. 

  

 
  

Otherwise, the path to create a new account is Menu -> Accounts and then click on New account... 

button.  

  

To add a new account click on Menu in the top left and in the drop-down menu select Accounts. 
You will see the following account management window. 



 
  

Here you can create new accounts, delete existing accounts or select your default account. 

  

Please note the two arrows in the Accounts window toolbar. These can change the order of 
accounts which will affect the order of the folders in the main window on the left.  

  

Create a new account  
Click on +Add account to create an email, calendar, contacts, chat or any other account. You can 
read more about creating new accounts in the section: Create New Account . 

  

Account Avatars 

On the right side of your account details you can see an avatar. Account avatars will help you 
determine which email account your messages belong to in mixed views or search results. You can 
also use them for quick navigation when using minimized left pane.  
For more details on how to change the avatar please go to Edit Account . 

  



Delete an existing account 
To delete an account, select the account you wish to delete and click on Remove account button 

. You will be prompted to confirm the deletion.  

  

This action can endanger your data in case of POP accounts. 

POP protocol downloads messages from your server into your device and deletes them from the 
server - this means that deleting this account from your device might delete the only copy of your 
messages. 

We suggest making a backup or exporting your messages before deleting a POP account. 

  

IMAP and Exchange Web Services accounts synchronize data with the mail server, removing 
these accounts is therefor safe. 

  

Set a default account 
Select the account you wish to be set as your default account and click on Set as default 

. The default account will be active when the application starts.  

Default account will be used when a specific account cannot be detected for use. This means the 
Default account will be applied to new messages, contacts, events, etc. when the focus is set in 
Smart folders or Local folders. 

If you default account does not have its own Calendar and Contacts services you can specify default 
folders in the General tab of the Default account. 
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Creating a New Account 
  

 
  

When setting up a new account, you can choose from several options: 

- Automatic setup - In most cases eM Client enables you to set up your account automatically 
with just two simple steps - entering your email address and the password. We strongly recommend 
using this method of setting up your account unless you possess thorough details about your 
account's settings. The first step is typing in the email address of your existing email account as 
well as the account password. The rest of the automatic setup is realized in 3 steps: 

• server settings for pre-defined service providers  

• try to use Auto-discover protocol   

• try to detect server setting by special heuristics 

  

- Connecting to standard email servers: eM Client will attempt to automatically retrieve the 
server settings (this works for the most frequently used email servers i.e. Gmail, Yahoo etc.) 

  

- Auto-discover technology: If eM Client is unsuccessful with the first attempt, it will try to use 
the so called auto-discover technology, which basically tries to assess the predefined credentials of 
email servers. This service is fully automatic and it can autonomously detect the settings if the 
correct email information is provided. 

  



- Predicting less usual email servers: In this case, the application tries to search for access 
to your account details on the internet, it works on predicting how the address of your email 
provider is realized. (For example, this service will be utilized in the cases when a private 
company's email addresses will be prompted to set up.) 

  

If all three services fail you will be prompted to specify the settings manually. Learn more about 
setting up email manually here.  

  

Automatic Account Setup 

Step 1 - Account Details 

In this dialogue you can enter additional information regarding your new account, such as the 
account name and the name that you would like to be displayed in the "From" field of your outgoing 
messages. 

 
  

Step 2 - Set up Encryption (optional) 

Next you’ll be asked if you want to set up PGP encryption for your account. This is an advanced 
feature which encrypts your emails to provide better security and privacy. If you would like more 
information on how to set up encryption, you can read about it here. Otherwise, simply click 
“Continue without encryption” to continue setting up your account. 



 
  

  

Step 3 - Finishing up 

Here you can enable/disable services for this account (Mail, Calendar, Contacts, Chat). These 
settings can be changed at any time in Menu > Accounts. 

Depending on if you chose a POP3, IMAP or Exchange incoming server, the final 
options will change. 

Sync Options 

Message sync time period:This setting allows you to synchronize only the newest emails from 
your server with a custom-set time frame. 
The default option is to synchronize messages from All time, which will pose no limit on your 
messages, all the ones on your server will be synchronized with eM Client.  
In case you want to keep only the latest in the app, you can choose from Last 1 day, Last 3 
days, Last week, Last 2 weeks, Last month, Last 3 months or Last year. 

In case you need to check your older emails, at the end of the message list is a button Load more. 
It allows you to download some of the older messages or all messages if the need arises. 

  

Download options allow you to choose if you’d like to download messages so you can read your 
previously received emails even when you’re not connected to the internet (you will still need to 
reconnect to the internet in order to receive new messages) and you can choose if you’d like the 
search option to also work for your email attachments. 



Finally, you can click on the Finish button to start using the application with your newly added 
account. 

  

 
  

Setting up particular email addresses: 
In this section, you can select particular email accounts that you would like to set up. The first five 
email providers displayed will always be the most used ones in the location where you currently are. 
These five displayed providers will also always have predefined configuration and their server 
settings will be retrieved automatically.  

  



 
  

Manual Account Setup 

In case the automatic setup didn’t work or your email provider isn’t shown, click on the Other 
button to manually set up a different email account. In this case, the setup will be a little more 
complex. It’s performed in seven steps and you will be asked to fill in all the email settings. You can 
find out your account’s server settings by asking your email provider. 

  

Step 1 - Identity: 
Enter your email address to begin. 



 
  

  

Step 2 - Account type and incoming server information 

Select if your incoming mail server type should be POP3 or IMAP. 

Enter your incoming mail server address. 

Enter your username (usually either the whole email address or just the part before the @ sign 
depending on the provider) and your email account password. 



 
  

  

Step 3 - Outgoing server information 

Enter your outgoing mail server address. This section could be prefilled based on what you entered 
for your incoming mail server, but it's possible that you’ll need to change it to something else 
depending on the provider. 

Your username and password will also be prefilled based on your answers in Step 2. Usually the 
credentials stay the same. 



 
  

Step 4 - Testing configuration 

During this step, your configuration will be tested. If your account details were typed in correctly, a 
green checkmark will appear. If there are some problems with the configuration (for example if your 
password was not entered correctly), a red cross will be displayed (as you can see in the picture). 
You can always change your configuration by clicking on the Fix button. 



 
  

Step 5 - Adding additional information about your new account: 

In this dialogue you can enter additional information regarding your new account, such as the 
account name and the name that you would like to be displayed in the "From" field of your outgoing 
messages (e.g. jerry@x1solar.com) 



 
  

Step 6 - Set up encryption (optional) 
Next you’ll be asked if you want to set up PGP encryption for your account. This is an advanced 
feature which encrypts your emails to provide better security and privacy. If you would like more 
information on how to set up encryption, you can read about it here. Otherwise, simply click 
“Continue without encryption” to continue setting up your account. 



 

  

Step 7 - Finishing up 

Account avatar - Choose which image you’d like to have to represent your newly added account. 
You can choose from one of our default avatar images or select your own custom image by 
uploading it from your computer. 

  

Depending on if you chose a POP3 or IMAP incoming server, the final options will 
change. 

  

POP3 option: 

On this final screen you can specify if you want the application to create a separate folder tree for 
the messages for your POP3 account, or if the messages should be stored in Local Folders. 



 
  

IMAP option: 

Sync Options allows you to choose if you’d like to download messages so you can read your 
previously received emails even when you’re not connected to the internet (you will still need to 
reconnect to the internet in order to receive new messages) and you can choose if you’d like the 
search option to work for your email attachments. 



 

Setting up Chat 
Here you can add a XMPP/Jabberchat, Slack, MS Teams or rocket.chat account. 

For exact steps, go to the Add a Chat account section. 

  



 
 

  



Setting up your Calendar 

 

CalDAV / CardDAV 

  

CalDAV is a calendar sharing service and CardDAV allows you to share your contacts. In order to set 
up a CalDAV / CardDAV account, you first have to have a CalDAV / CardDAV account on your mail 
server (e.g. IceWarp eMail server). 

Enter the account name, password and its internet location, and you are done! 



 
  

Setting up Contacts 
Here you can set up synchronization with your Google contacts, Yahoo contacts, iCloud Contacts 
and Fruux Contacts. Please note that, in the case of Google, it's Google's native technology, 
whereas in the case of Yahoo and others, this service works on CardDAV technology. 
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Edit existing accounts 
  

General 

 
  



In the Account name field, enter a label for the account. It will not appear on your outgoing 
emails, and is useful if you have multiple accounts. 

In the Name field, enter the name which will be displayed in your outgoing emails and will be seen 
by their recipients.  

In the Email field, enter your email address. 

Click Aliases.. to manage both your server-set aliases or to manually add those that this account 
can use. You will then be able to select these aliases as a From email address. 
+Add Alias button alows you to connect other aliases from other services or set just the ones you 
plan to use and uncheck the option Use the following aliases from linked accounts, which is 
a list of aliases synchronized from the server. 

 
  

In the Login name, enter your login name for that account. 

In the Password, enter your password for that account. 

Note: Accounts set up using oAuth authentication (via external window) will not 
have the Authentication section available, as a secure login token is used instead of 
actual username and password. 

  



The Copies field you can set Bcc email address to automatically make blind copies of your 
messages - the actual recipients in the To and Cc fields will not see this copy. 

In the Send field you can decide if you want to save a copy of sent messages for this account 
in Sent folder or not. 

Signing and Encryption is for custom settings of your PGP or S/MIME encryption of this account 
- you can also change this setting in Account policies. 

  

For accounts without native Calendar, Contact and Task services, meaning you only have the Mail 
service available, you will be able to set Default Folders. Select folder for incoming scheduling 
messages, taska and contacts by clicking on Select... button and choosing your preferred folder.  

Under Services you can disable or enable any of the available services for a given account. For the 
default account you will not be able to disable incoming and outgoing mail service, as the default 
needs to have both to work correctly. 

The box "Include when sending/receiving mails" is checked by default, you can uncheck it to 
temporarily stop using the account (though IMAP and EWS messages will still update when the 
server sends any new information). 

  

SMTP 

 
  

In the Host field, enter the address of your outgoing server. 

In the Port field, specify the port number to be used by the SMTP protocol. Default is port 25 . You 
can read about email protocols in Advanced Information. 

In the Security policy field, select a security protocol. Read more about Security Protocols. 



Select Authentication method: Use Identity credentials or manually fill in user name and 
password. 

  



IMAP 

 

In the Host field, enter the address of your incoming server. 



In the Port field, specify the port number to be used for IMAP protocol. Default is Port 143. You can 
find out more information on Email protocols in Advanced Information. 

In the Security policy field, select the type of security protocol the server uses. For more 
information, check out Security Protocols. 

Select Authentication method: Use Identity credentials or manually fill in login name and 
password. 

You can select Download messages for offline use to download email messages to your computer 
when you are connected to the internet, making the emails fully readable when you work offline.  

Checking the option Include attachments and images will download not only the messages but also 
the attachments and images for use while offline. 

By checking Automatically detect special folder names the folder names for incoming emails will be 
detected automatically. You can also enter your custom settings into the following fields: Sent, 
Draft, Trash, Junk.  

  

Sync Options 

Message sync time period:This setting allows you to synchronize only the newest emails from 
your server with a custom-set time frame. You can change the time frame here at any time. 
The default option is to synchronize messages from All time, which will pose no limit on your 
messages, all the ones on your server will be synchronized with eM Client. In case you want to keep 
only the latest in the app, you can choose from Last 1 day, Last 3 days, Last week, Last 2 
weeks, Last month, Last 3 months or Last year. 

Download options allow you to choose if you’d like to download messages so you can read your 
previously received emails even when you’re not connected to the internet (you will still need to 
reconnect to the internet in order to receive new messages) and you can choose if you’d like the 
search option to also work for your email attachments. 

  



POP3 

 
  

In the Host field, enter the address of your incoming server.  

In the Port field, specify the port number you want to use with the POP3 protocol. Default port 
number is 110. You can find more information on email protocols in Advanced Information. 

In the Security policy field, select the type of security protocol you wish to use. Find out more 
about Security Protocols. 

Authentication - select between using your account credentials, or manually filling in the user 
name and password. 

Server settings 

Leave a copy of messages on the server - eM Client will keep a copy of your emails on the 
server after downloading them into your computer. 

Remove from server after x days - when checked, eM Client will remove your emails from the 
server after a specified number of days after they are downloaded to your computer. 

Remove from server when deleted from "Deleted" folder - your emails will be removed 
from the server when you delete them from the Deleted folder.  

  



Tip: For POP3 Email users, it is safer to have the "Leave a copy of messages on server" box 
checked. Make sure that you check the space left in your mailbox from time to time. 

You can learn more about email protocols in chapter Email Protocols. 



  

Chat 

 
  

Server 

In the Host field, enter the address of the XMPP host server.  

In the Port field, enter XMPP service port value, you wish to be used. Default XMPP service port 
value is 5222.  

Authentication - Select between using your identity credentials, or manually filling in the 
user name and password. 

Check in SSL (Secure Socket Layer) if you want your messages to be encrypted. This should be 
checked if you want to keep your data secure. 

  



CalDAV/CarDAV 

 

  

CalDAV is the standard calendar and personal data sharing protocol. Read more about Calendaring 
Protocols. 



Server 

In the URL field, enter the CalDAV/CardDAV server address you want eM Client to synchronize your 
calendar with.  

Tip: For Gmail users, the URL address is 
https://www.google.com/calendar/dav/yourusername@gmail.com. 

Authentication 

Select a method of Authentication - Anonymous or manually specify login name and 
password. 

Default Folders 

Select the default calendar to which mail invitations to Events, Tasks and Contacts will be saved.  

Delegation 

This option will enable you to entrust other users with the privilege to share Calendar and Contacts 
with you. You can specify accounts you can access as well as users who can access your account.  



  



Diagnostic 

 
  

In this section you can troubleshoot your account settings and attempt to fix potential problems 
with the setup.  

The Diagnose button will prompt eM Client to try different Port settings to connect to your server. 
 
Accounts that do not use direct password login will not have the Diagnose option available, as the 
authentication token is connected to specific settings. 

  

You can also specify for which of the following would you like to enable diagnostic logs: SMTP, IMAP, 
XMPP, CalDAV / CardDAV. 
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Settings 
eM Client offers a wide range of settings that allow users to customize even the most technical 
details under the hood and tailor the program to their preference. 

To access Settings, click Menuat the top and then select the Settings... option from its drop-down 
menu. 

The Settings window: 

 
  

In the top menu, you have the Save & Close button on the left side to save any changes made to 
the Settings. 
The Apply button can be used to save any changes you made, the difference is that you will see 
the new changes but the Settings window will stay open. 

Import and Export can be used to import and export these settings from/into a XML file for 
import/export into different eM Client app on another device. 
QR Export is used primarily tp export your data into mobile devices - read more about this feature 
here. 

On the right side you have a Search filed that can be used to easily find specific settings if you are 
not sure which section to look into. 

  

Settings are divided into 12 sections, while each of the sections contains several subsections to 
make it easy to customize the app. 

General: 

• General 

• Language 



• Notifications 

• Confirmations 

• Reminders 

• Storage 

• Password protection 

• Backup 

• Print 

• Spell Checker 

• Shortcuts 

• Folders 

• Swipe 

Appearance: 

• Themes 

• Layout 

• Lists 

• Toolbars 

Mail: 

• Read 

• Conversations 

• Categories 

• Send 

• Compose 

• Replies and Forwards 

• Templates and Signatures 

• QuickText 

• Privacy 

• Blacklist and whitelist 

• Receipts 

• Attachments 

• Automatic archiving 

• Translation 

• Watch for Reply 

• Artificial Intelligence 

Signing and Encryption: 

• General 

• Account policies 

• Certificates and Keys 

• Key Lookup Services 



Calendar: 

• General   

• Weather 

Contacts: 

• General 

Tasks: 

• General 

Chat: 

• General 

Online Meetings: 

• General  

Widgets: 

• General 

Advanced 

• Logging 

You can switch between these sections and subsections by clicking on the bookmarks in the left-
most vertical panel of the Settings window. When you click on any of these bookmarks, the central 
panel of the window will change and it will display the settings of the selected section. 
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General 
The General subsection of the general section of the Settings window contains four sub-panels: 
General,Synchronization, Operations Window, Default Email Application: 

  

 

General 

Minimize application to tray 

Usually, the default behavior of an application window when minimized (e.g. by pressing the 
minimize [dash] button in the top right corner of application window), it goes to the taskbar. But 
when this field is checked, the application will minimize to the tray at the lower right corner of the 
taskbar instead. To restore the application window simply double-click the application's icon (in the 
shape of orange envelope) in the tray. 

Close application to tray 

When checked, the application will minimize to tray (instead of closing) when you click the 
close button (cross). To restore the application window simply double-click the icon in the 
tray. 



Run on system startup 

By checking this option, eM Client will automatically start on Windows startup. 

Empty trash on exit 
By checking this option you will set the application to automatically empty the trash when you exit 
the application.  

Delete spam on exit older than X days 

All messages older than the specified amount of days will be deleted from all recognized Junk E-mail 
and Spam folders. 

Show on startup 

Here you can choose (from the following drop-down menu) what you want to display in the 
central panel upon startup. 

 

Synchronization 

Download messages from POP3 accounts at startup 

When checked, the application will automatically synchronize your items at startup. 



Synchronize items every X minutes 

Check this field to automatically synchronize your items in every X minutes . This action will be 
performed every given number of minutes and you can change this frequency in the numeric field to 
the right of the checkbox. 
Note: IMAP and EWS accounts will synchronize even outside of this interval if the server 
pushes an update. 

Operations Window 

Show window on send and receive  
When checked, an Operations Window will appear displaying the operation details during sending 
and receiving Emails. 

Hide window when send and receive completes 

When checked, the Operations Window will close itself automatically after sending and receiving 
Emails. 

Show window when error occurs  
When checked, the Operations window will only appear when encounters errors during sending and 
receiving Emails. 

Default email application 

Click on Make default button to make this product the default email client or bring you to system 
settings where you can set it. 
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Language 
In this section you can select the application language for the program. You don't need to restart to 
have the change apply - simply select the new language and click Apply or Save & Close. 
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Notifications 
The Notifications Settings window: 

 
  

You can use default settings or modify the settings for all enabled accounts separately. 

  

An icon without a red cross means direct settings and an icon containing the red cross 
means explicitly forbidden. 

  

You can set three forms of notifications, Popup windows, notification icons in tray and 
playing sounds. 

• Notification icon in the tray area is discrete and the least intrusive, suitable for less important 
events. 

• Show popup windows will display a popup window containing all the relevant information 
about the event. 

• You can specify a different sound file to be played for each type of event by choosing the 
option Play sound. 

You can disable notifications when a full-screen application is detected running on the computer by 
checking the appropriate box. 

You can cause pop-up windows to be hidden after a certain period of time by checking the 
appropriate field and specifying the time value in milliseconds. 

  



There are many types of actions that you can set notifications for. You may choose a combination of 
notifications for each event according to their level of importance to you. 

Moreover, you can disable /enable the appearance of sound and popup notification while the main 
window is active.  
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Confirmations 
In this menu you can specify (by checking/un-checking the appropriate field) which actions will 
require confirmation by the user and when the user will be notified of important events. 

 
  

Below the default settings for specific confirmation, you can find Move to Junk and Default rules 
scopes options. 

You can set up your Move to Junk Action by selecting one of the 3 options - 'Move to Junk', 'Move to 
Junk and blacklist email' and 'Move to Junk and blacklist domain'.  

Action that you select here will be automatically performed when you hit the Move to Junk button. 



 
  

Default rules scope is used when you create a quick rule via right-click on the message and use the 
'Create rule from Message' feature. You can either create local rule or server rule for accounts which 
can synchronize rules with the mail server, so your rule is applied no matter which device you check 
your email on. 
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Reminders 
In this menu you can adjust the behavior of Reminders. 

 

Reminders 

Show Reminders window instead of notifications 

By default event reminders are shown the same way as other notifications (set in Menu > 
Settings > General > Notifications), but with this setting enabled you will be able to 
manage all your reminders in one place and easily Dismiss them or postpone them via the 
Snooze button.  

Show reminders on top of other windows 

This setting will ensure that the Reminders window pops up in the forefront so you don't 
miss any events or important reminders. 



Automatically dismiss reminders for past calendar events 

This setting dismissed reminders for events that have already passed, for example if you 
have an event set in the evening, you attend it before it pops up on your device, and then 
open eM Client next day - the reminder will not show up even though you did not dismiss 
it manually. 

Default Reminders 

Default event reminder 

Set a default reminder time before the start of the event for all your calendars. 

Default task reminder 

Set a default reminder time before the start of the tasks for all your task folders. 
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Storage 
Here you can specify the path to the Database directory, in which all your data will be stored. 

If you are moving the database you need to manually move the files - or eM Client will create a 
new, empty database on the new location. 
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Password protection 
In this section you can set up password protection when starting up the application by 
checking/unchecking this option.  
You need to create your password here. This password cannot be reset remotely, so make sure to 
not forget or lose it. 
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Backup 
Here you can set up an E-mail backup.  

 

Target directory: 

click on  to select target directory for backing up your files. 

  

Check Enable periodic backup to allow backup in your email client. 

Frequency: 
Set up your frequency of backup from the range of 1 day to 6 months. When the frequency which 
you have chosen will elapse, eM client will ask you if you are willing to back up. 

The time of backup can be changed in Windows Task Scheduler. 

Preserve last:  
You can select from 1 to 5 backups, which you would like to preserve saved and ready to be 
restored if needed.  

  

Note: eM Client supports Live Backup, so it can create backups while the program is running. 
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Print 
Here you can set up printing preferences. 

 
  

Check Print each mail on a separate page to set the application to print each mail on a 
separate page when you are for example printing larger conversation.  

Check Print user name in page header to adjust the application to display the application 
account's name in the header of the printed page. This can be, for example, useful when various eM 
Client users print emails on a single printing machine.  
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Spell Checker 
The spell checker can help you to avoid typos. It is turned off by default but you can simply turn it 
on by checking the field Use automatic spell checker in individual areas. If you check this field, 
make sure to choose the appropriate Language. Note, that you can use spell-checker also for Chat.  
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Shortcuts 
In this section of general settings you can adjust various shortcuts that you want to function in your 
application.  

Shortcut section is divided into three subsections: Main, Mail and Send Mail. 
To change a shortcut simply click on it in the list, and press the NEW shortcut you want to change 
on your keyboard - eM Client will detect it. 

 
  

Click on Reset to default to reset the single selected function (for example Paste, Find... etc.) to the 
setting by default.  

Click on Reset all to default to reset all shortcuts to the setting by default. 
 
You can view all current shortcuts here - "Shortcuts" on page 6. 
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Folders 
In this section of general settings you can set which special folders to show or hide and set some 
general settings for all folders. 

 

Show folders 

• Inboxes - This seaction is for showing all accounts' Inbox folders, but separately. 

• Favorites - Section for special global folders and for pinning any folders manually  

• All Inboxes 

• Outbox 

• Sent 

• Trash 

• Drafts 

• Junk Mail 

• Unread 

• Flagged 

• Unreplied 

• Snoozed 



• Search Folders 

• Tags in Mail 

• Tags in Notes 

• Local Folders 

You can change these even in the main program window via right-click in the folder list. 

Colors 

Use folder color for sets the behavior for colored folders 

• Ignore folder color 

• Icon only 

• Icon and text (excluding calendars) 

• Icon and text 

Tooltips 

Show tooltip with items count - this option enables a pop-up tooltip when you hover over a 
specific folder to show you the number of items in it. 
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Swipe 
Please note that swipe gestures are currently only supported for the Windows version of eM Client 
on touch screen devices. 

 

Swipe Options 

This allows you to enable/disable long swipe mode for left or right swipes. 

  

A short swipe gives you a chance to confirm if you want to take the swipe action by doing a short 
swipe and then a tap on the icon that appears. 

 
  

A long swipe will take the swipe action without confirmation. 

 

Mail 
Set the swipe actions in the mail view for left and right swipes. 

Notes 

Set the swipe actions in the Notes view for left and right swipes. 
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Themes 
In this menu, you can adjust the look of the user interface - you can choose among the 
default themes Modern, Light, Dark, Classic, Arctic, Mystic, Pink, Bordeaux, System, 
Red Effect, Blue Light, Aqua, Industry, Yellow Jacket, Green, Rose, and Viola themes, 
create a new theme via Theme Editor based on existing theme or color, or import any 
custom theme from a file with .emtheme extension. 

  

 
  

The bottom of the window allows 3 options: 

Import theme 

Import a custom theme file with .emtheme file type, either one you created or edited, or one 
downloaded from our Theme Gallery. 

Theme Editor 

This is a tool you can use to create or edit themes. You can also reach it via Menu > Tools 
> Theme Editor menu. 

https://www.emclient.com/themes


 

Save 

The save button allows you to save changes you made to your theme or save the theme into a new 
file with the 'Save as' option. 

Open 

Open an existing .emtheme file for futher edits. 

+New 

Create a new theme, you will be able to make one from default themes using the Create from 
existing option, Create from file based on an existing .emtheme file or Create from color, 
which will automatically create a whole theme based on the color you pick from the color wheel. You 
can then tweak details using the options in the left pane of the Theme editor window. 



 

Apply 

Apply the changes you made in the Theme editor to the actual app - this way you can preview what 
your current changes look like and you can keep editing or check if everything looks good. 

Pick Element 
If you need to edit a specific part of the app but cannot find the correct section in the left pane, you 
can use this tool to click on the main app window and the Theme editor will take you to the correct 
section. 

  

The left pane you can go through the list of options to customize specific elements of the user 
interface. The panel on the right will show you preview of which type of element you're editing and 
you can see the changes to these specific details.  

Advanced 

This button contains additional options for the Themes settings. 

By clicking on the Advanced button following context menu will appear: 

 

You can Save current theme as(however modified) into a file by clicking the appropriate option. 
You can later customize this file by means of simple XML editing or open the file in Theme editor. 

Change theme directory... changes the folder in which the theme files are saved. 
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Layout 
In this section you can select if you would like to have the messages displayed on the bottom, on 
the right or if you would like to have the messages panel off.  

You also can choose between three options of the visual display of your sidebar. If you check the 
option Expanded your sidebar will appear in its full size on the right-hand side. By checking options 
Minimized and Hidden you can make your sidebar minimized (so it is still available via single click) 
or completely hide it from the main screen. 
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Lists 
In this menu you can specify the appearance settings for the individual parts of the application. The 
changes you will make here will show in following parts of the application: General, Mail, 
Calendar, Tasks, Contacts, Sidebar. Using these options you can customize the appearance so 
that it fits your personal preferences. 

The settings and options you choose here will affect the appearance of the information displayed in 
all parts of the application (in messages, calendar etc.) 

  

 

Item Lists Properties 

Use alternating colors for rows - if checked, the messages in the list will be displayed on a 
background of alternating colors. 

Show grid in list - by checking/unchecking this option, you can show/hide a grid in the list of 
messages. This grid is more visible if you uncheck the previous option.  

Use color of tag as text color - by checking this option you can choose if you would like to 
display the text of an entry in the same color as is the entry's tag in which it is classified.  

Allow in-cell editing - this option applies for editing in main window. If checked, you will be able 
to edit the parameters of the items (contacts, events, tasks) inside the appropriate cell. 



Scrollbar style - instead of using themes, you can now manually switch the scrollbar style in 
settings: 

• Use setting from theme 

• Use narrow scrollbars 

• Use wide scrollbars 

Fonts 

Item lists font: Font for the items listed in the lists for the given items - emails, events 
in Agenda, etc. 

Item lists group font: Font for the group in the list, such as 'Today' 'Yesterday' in emails when 
emails are grouped by received date. 

Folder list font: Font for the folder list on the left side. 

 Row dimensions 

Item lists row height: Row height for the items in the lists in single-line layout. 

Item lists multiline line height: Row height when Compact version of the mail list is used 

Item lists group header height: Row height for the group header. 

Folder lists row height: Row height for the folder list on the left side 

Indentation 

Folder lists indent: Set the indent of the folder list for subfolders in pixels. 

  

The Reset to default button will change all settings in this section to the default amounts. 

Copyright © 2025 eM Client s.r.o. 

Thámova 18 
 Prague, 186 00 
Czech Republic  

info@emclient.com  



Toolbars 
There are many toolbars which exist in eM Client and some of them (especially for Mail) have so 
many available options that we let users customize them to fit their specific needs. 

 

Main Toolbar 

This is the Main Toolbar that appears at the top of the Mail View in eM Client.  

 
By clicking Customize… you can change which buttons appear in this toolbar and in what order. The 
options are a bit different in other sections, but each one can be customized. 



 

The Show icons only option will hide the text of the buttons, so you can fit more features on the 
toolbar. You can hover over the buttons to have the title pop up. 

Mail Compose Window Toolbar 

This is the toolbar which appears when you are writing an email to enable you to quickly change 
things about the email message, such as adding formatting (Bold, Italic, Underline) or adding an 
attachment. 

By clicking Customize… you can change which buttons appear in this toolbar and in what order. All 
the options which you don’t pick to be included in this toolbar can still be accessed by clicking on 
the … button on the far right side of the compose message window. 

 

Mail Detail Toolbar Window 

This is the toolbar which appears at the top of the message window when you open an email. It’s 
similar to the Main Toolbar for Mail, but has some added options such as moving to the 
previous/next message in the folder to open another email. By clicking Customize… you can change 
which buttons appear in this toolbar and in what order. 

 



Toolbar Alignment 
Main toolbar alignment 

This lets you choose if the Main Toolbars which appear at the top of the page should be aligned 
towards the left or center. 

Other toolbars alignment 

This lets you choose if the other toolbars (besides the Main Toolbars) that appear at the top of a 
window should appear at the center or left side of the window. 
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Read 
The Read Settings window. In this section you can specify everything about the way you view your 
messages. 



 



  

Read 

Mark message read after displaying for X seconds 

The application tries to track which emails you have read and which you haven't by marking an 
email as "read" after it's been opened for a certain amount of time. You can specify the amount of 
time in seconds in the numeric field after which you would wish to mark the currently opened email 
as "read".  

Mark messages read after opening in separate window. 
The application will mark messages as read after opening them in separate window.  

Mark messages read after move to Trash. 
This setting will mark messages as read when they are deleted in the application. 

Mark messages read after move to Junk. 
This setting will mark messages as read when they are moved to Junk (or Spam) folder in the 
application. 

Read all messages in plain text 
Check this box if you wish all incoming messages to be displayed in plain text format. 

Replace text smilies with emoticons 

Check this box if you wish to replace text smilies with emoticons/emoji. 

Show email address in email header 

Check this box if you want to have the email address displayed in the email header in the message 
view. 

Show name from contact 
With this option, the name in your opened message will be replaced with the name stored in your 
saved contacts, in case the name in the message code itself is different. 

Close original message window after deleting the message 

If you check this option, the original opened message window will be closed when you delete the 
message. If you leave this option un-checked, the original opened message window will still remain.  

Show tag bar 

Check this box to show tags in the Message detail header. 

Show unsubscribe bar 

Check this option to show the unsubscribe link contained in the message header. 

Show email tracking bar 

This option is for the info line in the message preview informing about the email tracking pixel 
inside the given message. 

Show counter for recent messages instead of unread 

This option will show a red counter next to your folders and category tabs if there are new, unread 
messages that just came in. After you open the folder, the number is again replaced with full 
number of unread messages. 



Preferred style 

Set a style you wish to have your plain text emails to be displayed in. 

Preferred font for messages 

Click "Select" to choose a preferred font for your plain text emails to be displayed in. 

Preferred text color 
Click "Change" to choose a preferred text color for your plain text emails to be displayed in. Or use 
the default for the selected theme. 

Preferred background color 
Click "Change" to choose a preferred background color for your plain text emails to be displayed in. 
Or use the default for the selected theme. 

Use preferred font for fixed-width plain text messages 

By (un-)checking the very last option in the window you can enforce using the mono-space font for 
pre-formatted plain text messages. 

Message list 

Show messages in groups 

Check this option if you want your messages to be displayed in groups. Your messages will be now 
sorted in groups like "Older" , "Two weeks ago" etc. 

Show full date 

If you check this option, the full date of receiving your message will be displayed (including day, 
month, year and exact time instead of the default day and month) 

Show "Delete" icon on mouse hover 
This setting will show a Trash/Delete icon on each message in the message list when you hover over 
it, making it easy to delete it using a mouse. 

Always show "Read" and "Flagged" icons on mouse hover 

This setting will determine if only read indicator or flagged button are shown or both will be 
available with Avatars enabled. 

Show Avatars 

This setting will either show or hide all avatars in message list, this will not change the Columns 
configuration though. 

Avatar size 

Avatar size in the message list can be set to Regular or Small. 

 Message preview 

Message preview can be disabled or set to 1, 2 or 3 lines of the message text. 

 Highlight colors for unread messages 

This setting will use different colors for background and text of Unread messages, making them 
stand out more in your message list. 

• If enabled in theme - if the theme is set to use different colors, they will be used, if not, 
then not.  

• Use highlight colors defined in theme - always use the colors defined in theme, even if 
the theme is not set to have different unread colors by default 



• Don't use highlight colors - never use different colors for unread messages 

Tag in preview field in compact layout 

When viewing tags in the preview field in compact view you can select to see Full if possible to 
see the full names of the tags or Icons only to save space. 

Tag in subject field in single-line layout 

You can view tags in the single-line view Full if possible, Icons onlyor Don't show the tags at 
all. 

Set default date sort order 

You can choose whether you want your message to be displayed on the top or on the bottom from 
the drop down menu: 

 
In addition there is also the Preserve current setting option, which is selected by default. This option 
preserves current setting, which means that the settings which you have for various mail folders will 
be preserved. But on the other hand if you for example choose New messages on the top option in 
this section, the setting will be changed for all your message folders.  

Use compact layout in widths smaller than X pixels  
Here you can customize your compact layouts by selecting the number of pixels. You can also 
uncheck this option and then select one of the 2 options: 

Always use compact layout  
Always use single-line layout 

This way you can have the same layout no matter how thin or wide the message list is in the 
current window. 
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Conversations 
You can find the same settings here as in Menu > View > Conversations. 
Find detailed explanation of the Conversations feature here.  

 

Conversations 

• Show conversations in all views - messages are shown as full conversations in 
Message List and Message Detail/View panel 

• Show conversations in message details only - messages are shown separately in 
Message List, but as conversations in Message Detail 

• Disable conversations - messages are shown separately in all views 

  

Sort Order 

• Latest messages on bottom - read messages chronologically from top to bottom 
• Latest messages on top - read messages starting with newest at the top, with older 

below in reverse order 
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Categories 
In the Categories setting you can enable or disable the feature, specify which categories 
go where and also manage your rules for assigning specific categories.  

Go to this section to read about how to use Inbox Categories. 

 

  

General 

Show Categories - if you uncheck this option the category tabs will be hidden from all 
sections of the app. If you want to use the categories in just selected Inboxes, you can 



make that decision per each account in that specific Inbox folder, reach more in the 
feature description here. 

  

Default categories for Gmail accounts - tabs that will be visible for any Gmail and 
Google Workspace accounts 

Default categories for non-Gmail accounts - tabs visible for all other account types 

Default categories for global folders - tabs visible for Favorite folders such as All 
Inboxes 

Each of these has these customization options: 

• Primary, Promotions and Social 
• Primary and Other 
• Custom - with the Custom selection you get the chance to not only specify which 

tabs to show, but also which categories should be part of the Primary and Other 
tab if you choose to view them, for example if you view specific category as more 
or less important. 

 

  

Category tab shown by default - this will be the tab that is shown when you open your 
Inbox.  

The default option is Primary, but it can be also be All, Promotions, Social, Updates, 
Forums or Other. 

  

Display 

Show number of recent messages 

Show number of unread messages 



Message counters style - this can either be 

• Badge - a number with colored rectangle in the background 
• Parenthesis the number is shown in parenthesis, without any specific background 
• Dot without specific number 

Custom Rules 

In this section is an Account selector since the custom rules for Inbox categories are 
always for that specific account. 

Below you can see rules for each of the specific account and category - click Modify to 
add or remove addresses from specific category rules. 
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Send 
The Send Settings window: 

 

Undo Send - paid feature 

Enable Undo Send - All messages will be held for 3, 5 or 10 seconds so you can hit the Undo 
button to return the message into Drafts folder and edit it. 

  

Send messages immediately 

Check this box to have your emails sent as soon as you click the Send button in the upper left 
corner of the New message window. 

Otherwise the messages will be stored until you click the Refresh button on the toolbar or the 
Synchronization interval(set in General settings) passes. 

  

Send all messages when closing the application 

You can decide what should be done with unsent messages (messages still in Outbox folder) before 
the program is closed. 

• Always ask 

• Close immediately without sending 

• Send messages and then close 

Send later - paid feature 

Enable Send later for all messages - All messages will be sent with a specific delay set in the 
X minutes field 
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Compose 
Compose section enables you to adjust the email lookout.  

 

Compose 

Automatically complete email addresses when composing  
Check this box to let the application attempt an auto-completion of the email address you are typing 
in. 

This function enables you to quickly insert the receiver's address when composing a new email. 
Simply type the first few letters of the desired receiver's address into the email's To: field and the 



application will display a list of all the contacts from your address book whose email addresses begin 
with what you have typed in. 

 

Automatically save emails to drafts every X minutes  
Check this box to have the application periodically save the email message you are currently 
composing in the Drafts folder. Thus if you are interrupted while writing an email, you can recover 
the unfinished email from the Drafts folder. 

In the numeric field you can specify how often the application saves your unfinished email. 

Show CC and BCC field when composing  
By checking or un-checking this field you can show/hide the CC and BCC fields in the message 
window when you are composing a message. 

Capitalize first letter of sentences  
This utility works on a principle that every first letter of a new sentence will be automatically 
capitalized. (This can basically save your time, in means that you do not have to pay attention 
whether you have written capital letter at the beginning of a new sentence or not.) 

When selecting account show aliases in submenu  
With this setting aliases are shown in a separate menu under the specific account. With this setting 
disabled, all addresses are shown in one list. 

Check spelling before sending message  
With this option the Spell-check window will pop up after you hit Send if there is any misspelling in 
your text. If there is none, the message will be sent immediately. 

Account used for a new email 

This setting helps specify which email account should be pre-selected in the From field when a New 
message window is opened 

• Current account if applicable, then default account - the email is selected based on 
which email account you're in, and in favorites, search and other mixed folder the Default 
account is selected 

• Always default account - always the account marked as Default in Menu > Accounts  

• Don't select any account - the From field will stay empty, you will need to select the 
address manually 

Mail Format 

New mails format as:  
You can set a permanent mail format for your new messages. Choose from the two following 
options: 



 

You can choose between HTML or Plain text emails. A HTML email can retain any customized 
formatting that you apply to your email (font, colors...), a plain text email will contain only the text 
with no colors, font and so forth.  

Mail format for reply: 
 You can also set a permanent mail format for your reply messages. Choose from three options: 

 
  

You can choose between HTML or Plain text emails. A HTML email can retain any customized 
formatting that you apply to your email (font, colors...), a plain text email will contain only the text 
with no colors, font and so forth. You can also use the utility to auto-detect the format from the 
original message. 

Preferred Style  
Here you can define the preferred font, font style and size that you want to be used 
automatically when you are composing a message. 

Default Paste Format  
Here you can define the default format for pasting content - either keep the formatting of the 
original, or keep just the text in plain format.  

Email Address Suggestion 

Enable @ mentions - type @ and then start typing name or address of a contact - eM Client will 
suggest people to mention in your email or chat message. 

Use all recipients from Sent folders for suggestion - all recipients from your sent emails are 
used for email suggestion when writing a new email. 

Store composed mail recipients for suggestions - with this option enabled eM Client will 
save addresses into recipients history list, including how often you send emails to specific emails. 
This way the suggestion can be more relevant and offer more often used contacts first. 

Clear recipient history... - this button will delete all items in the saved recipients history 

Show recipients... - this button will open the list with the currently saved emails in recipients history 
- it can be used to save them to contacts or clear out specific items from suggestions 



Images 

Emojis 

Suggest emojis based on text after typing colon - this setting enabled or disabled the pop-
up suggestion window for emojis/emoticons 

Search text must be at least 2 characters long - this option stops the suggestion for emoji 
to pop up unless you write at least 2 characters after the colon 

Suggest recently used emojis after typing colon - if you have favorite emojis this option can 
help you insert them quickly 

Cloud Storage Attachments 

This settings sets what should happen when you add a file from recognized Cloud Attachment 
Storage. 

You can either have the program Always Ask how the attachment should be added, Add it as 
shareable link or Add as regular attachment. 
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Replies and Forwards 
In this section you can adjust many preferences for your reply messages and forward messages.  

This section is divided into four subsections: General, Subject modifications, Reply Header, 
Forward header. 

 
  

General 
Check/Un-Check Close original message window when replying or forwarding to Close/ 
leave the original message when you are replying or forwarding. 

You can choose from various actions (see below) in When replying to a message section: 

 



You can also choose from various actions (see below) in When forwarding a message section: 

 

Subject modifications 

Here you can define the style to be used in the "Subject" field in replies and forwarded messages 
such as Re for replies and Fw for forwards. 

Reply header 
Here you can choose the style of format for your reply headers (see below), there are these 
possibilities:  

• Standard  

• Short 

• Custom Plain (plain text version without formatting) 

• HTML 

• Custom HTML (custom formatted version) 

 

Forward header 
Here you can the style of the format for header when forwarding a message (see below), there are 
again these possibilities:  

• Standard  

• Short 

• Custom Plain (plain text version without formatting) 

• HTML 

• Custom HTML (custom formatted version) 



 
  

You can check the headers in the preview windows below the selector. 
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Templates and Signatures 
You can customize your mail templates and signatures in this section. 

Here you can see how Templates and Signatures menu looks like: 

 
  

By (un-)checking Attach signature to emails sent from external applications you can enable/disable 
attaching signatures to emails sent from external applications in this device.  

By (un-)checking Attach "Sent from eM Client" signature to every mail you can enable/disable 
attaching this signature to every mail that you send.  



Mail Templates  

 
  

A Mail template is a set of font and color settings that you can first store and then collectively apply 
to your email messages. You simply choose your favorite type of font, color of background or even a 
picture for the background, store this information in the application's Templates window and the 
selected template will be automatically applied to all your future emails. 

Select template for account:  
Select the account for which you want to use the mail template selected in the edit boxes below. 

Template for new mails: 
This drop-down menu contains a list of all your saved templates. Select one to be used for all the 
new messages you create. 

Template for replies:  
This drop-down menu contains a list of all your saved templates. Select one to be used for all the 
reply emails you create. 

Template for forwards:  
This drop-down menu contains a list of all your saved templates. Select one to be used for all the 
forwarded emails you create. 

'Mail Templates...' button 

By clicking on the Mail Templates... button the Templates window will appear: 

  



 
  

This is where you manage your email templates - you can modify, import, remove existing, or 
create new templates here. 

Templates: 
Templates contain all of your existing mail templates. If you want to modify or remove an existing 
template, select it from the list and click on the corresponding button located on the right. (wheel or 
trash icon) 

Preview: 
This window displays a preview of the mail template you have selected in the Template List. 

+New 

Click on New button to bring up the New Template window: 



 
  

Enter the name of your new template in  Name field.  
Enter any pre-defined recipients into To, Cc or Bcc fields.  
Enter the Subject of your template in to the Subject field.  

  

Font type 

Font settings can be changed by clicking on the down-pointing arrow. A standard font settings 
window will open, where you can adjust the font's size, style (bold, italic...) and type (Arial, Courier 
New etc.). 

  

Font Color 

Select the text color you would like to set for your template by clicking on down pointing arrow in 
the font color section, and select the preferred font color from the roll-down menu.  

  

Background 

You can also preset the background of your mails. Simply click on the down-pointing arrow and 
select from set of simple color. It is also possible to use custom color by clicking on the Custom 
color... button and then defining your own color.  

If you want to use a picture, click on , click Browse picture... button and select the desired image 
file from the file explorer.  

At the very bottom there is a Template window, where you can edit your template and 
simultaneously see how will your emails look with the given template. 

Click OK to finish creating the new template, which will be added to the template list. 



  

Attachments 

Add any files you want to include in your messages by default, this can be useful for inserting your 
own contact file, CV, public keys for encryption or anything that you want to send out with each 
message that you cannot include in a signature. 

Import 

Import a template from an .emlt file. 

Save as 

Save a selected template into an .emlt file. 

QR Export 

Export selected templates into a QR code which can be scanned by an eM Client mobile app. 

Edit 

 Clicking on Edit will bring up the same signature construction window as Add template and will 
also allow you to modify an existing template. 

Delete 

  

To delete an existing template, click on the trash icon. 

Change order 

Change the order of your templates, the order will be the same when selecting them 
from the +New button Mail sub-menu in main window. 

  



Signatures 
  

 
  

Signatures are texts, pictures and even web links that can be automatically appended to the end of 
your email messages as your signature. You can create and save any number of signatures in the 
Signatures window and select a signature to be used for all your future emails. 

Select signature for account:  
Select the account for which you want to use the signatures selected in the edit boxes below. 

Signature for new mails: 
This drop-down menu contains a list of all your saved signatures. Select one to be used for all the 
new messages you create. 

Signature for replies:  
This drop-down menu contains a list of all your saved signatures. Select one to be used for all the 
reply emails you create. 

Signature for forwards:  
This drop-down menu contains a list of all your saved signatures. Select one to be used for all the 
forwarded emails you create. 

Signature position 

Specify if the signature should be placed Before quoted text or After quoted text. 



'Signatures...' button 

By clicking on the Signatures... button the Signatures window will appear: 

  

 
  

You can modify and remove or create new signatures here. 

Signatures: 
Signatures contain all your existing signatures. If you want to modify or remove an existing 
signature, select it from the list and click the delete button at the top. 

Synchronized signature 

If you use a Google account, you will also see a signature called 'Synced with Gmail' with the email 
address next to it. This is your server signature. You can edit it and the signature will be synced to 
the server, so you can use it in other eM Clients or in Gmail. Signature synchronization is also 
available for IceWarp and Exchange accounts. 

If you already have signatures in the webmail, simply select the signature you want to sync to 
Gmail (Settings > General) and set the signature for NEW EMAIL USE and ON REPLY/FORWARD 
USE. After those steps signature will be synced to the eM Client. 

Note: it is possible to synchronize only one signature for an account at a time. 



Preview: 
In this field will be displayed the preview of the signature you have selected in the Signatures field. 

+New  
Click on New to bring up the New Signature window: 

 
  

Enter a name for your new signature in the  Name field. 

In the field below construct a signature as you would in any text editor. Confirm the changes by 
clicking OK and your new signature will be created and added to the signature list. 

Import 

Import a signature from an .html file. 

Save as 

Save a selected signature into an .html file. 

QR Export 

Export selected signatures into a QR code which can be scanned by an eM Client mobile app. 

Edit 

 Clicking on Edit will bring up the same signature construction window as New, which will allow 
you to edit an existing signature. 



Refresh 

Refresh synchronized signatures. 

Delete 

To delete an existing signature, select it in the Signatures list and click on Delete (trash icon). 

Change order 

Change the order of your signatures, the order will be the same in the compose 
window and will determine keyboard shortcuts for the signatures. 
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QuickText 
QuickText enables you to insert pre-made chunks of text (snippets) to your messages within 
seconds. This spares you from having to type the same phrases, sentences or even whole emails 
over and over again.  

 
  

 Click Manage QuickTexts... button to create and view QuickTexts. 



 
  

+ New button  
Click to create a new text snippet which will bring up an editor window for customization of your 
new QuickText: 

 



Here you can customize your own QuickText, enter the name and then customize the text in the 
text window.  

Once you have finished your QuickText, click on the OK button to finish the process. 

Import 

Import a QuickText from an .html file. 

Save as 

Save a selected QuickText into an .html file. 

QR Export 

Export selected QuickTexts into a QR code which can be scanned by an eM Client mobile app. 

Edit 

  
Clicking on Edit will bring up the same QuickText construction window as New, which will allow you 
to edit an existing QuickText. 

Delete 

To delete an existing QuickText , select it in the QuickTexts list and click on Delete (trash icon). 

Change order 

Change the order of your QuickTexts, the order will be the same in the compose 
window and will determine keyboard shortcuts for the QuickTexts. 

  

How to use QuickText 
QuickText button is located directly in the compose email window (see below). Once you have 
created your own QuickTexts you will be able to implement them into your text in two clicks or the 
correct keyboard shortcut. 
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Privacy 
In this section you can customize the settings concerning the privacy and potentially unsafe content 
in received messages. 

 
  

External Images and Other Content are objects in an email that are not directly a part of the 
email, but that are downloaded from an external source once you open the message. Inside the 
given message there is only a link that will give instructions to your internet browser or email client 
to download and then display this external content, which can be an image, sound, video or any 
other file linked to an external server or even a script or code that once downloaded and executed, 
could compromise your security. 

This method can be used to track if you have opened the particular email, since downloading the 
external content will cause a connection to a specific mail server that the sender can be tracking. 
This action is not always malicious, but can be misused by spammers to check if your email address 
is still in use and by getting this confirmation of the email being read they can send you more 
unwanted messages or share your email address to other third parties for profit. 

  

Tracking pixels which are used for Email Tracking can be part of this external content are able 
to show your actual IP address every time you open the message and nowadays with GeoIP services 
that means that the sender can find out your location very accurately, down to the street or even a 
building you were in at the time, opening you up to dangers not only online but in real life as well. 

If you deactivate external content, some messages may not look as they were designed by the 
sender, since the pictures or custom fonts are missing. However, this will most likely only affect 
commercial emails, as this method is rarely used in private email conversations. In most cases, the 



blocked content will be a logo or style sheet, adding prettier visuals but not content, so you won't 
miss much by not downloading it. In the case of advertisements that are all images, you can opt to 
download the content when the message subject or text in the body is interesting enough to 
convince you that the blocked content is worth reading. 

  

When there are any external images or content in the message, you will see this confirmation in the 
information bar under the message header: 

 

Download pictures or always download pictures from this sender. To preserve privacy, external 
content was not downloaded. 

External Images and Other Content  
Block external content 

This option will block all external content by default. There are exceptions that can be set for this 
option, since it’s quite a finite one: 

- Display content from safe senders 

With this option you can block everything but content from senders in your Safe Sender list - 
which is a list of senders you can curate by adding trusted contacts into it via the option to 'always 
download pictures from this sender' in the information bar under the message header. Using the 
Manage Safe Senders... button you can view and remove any contacts in you change your mind. 

- Display content from people in contact list 

This option will use all addresses in your contact list as an automatic Safe Senders list. This can be 
useful when you curate your contacts and keep only trusted senders in them, but some email 
providers with synchronized address books can add some emails to your list automatically when you 
respond to them, so keep this in mind before using this option or check to see if this feature is 
present and desirable for your purposes. 

- Display content when email tracking is detected 

Leaving this option unchecked will allow you to download all external content but leave out the parts 
that eM Client detected are used for email tracking. Since it is rare that all images, links and other 
details in a single email are used for tracking, this option can make it easier to read the message in 
full but keep your privacy protected. If you enable it, items that are used for mail tracking will be 
downloaded automatically. 

Display content when email tracking is not detected 

This option will download external images and content only for emails that are not showing any 
signs of email tracking elements, which makes it less likely that the message is used for marketing 
or spam. 

Display unsafe content in all messages 

This option will automatically download and show all external content, no matter who it is from or if 
it contains any email tracking elements. It is the least secure option. 

External Content Confirmations 

Ask before downloading external content when editing, forwarding or replying to 
email. 

Using the checkbox for this option to you can enable or disable the warning in the information bar. 
If you are set to either never or always display this content, then hiding this confirmation can save 
you some space in the message detail section of eM Client. 

   



Email tracking 

Email tracking is a method of email delivery monitoring. It allows the sender to get a notification or 
log of the time the email is opened and viewed by the recipient. Unlike with Read receipts which 
only send one confirmation that the email has been opened (and is usually purely optional), email 
tracking can provide details such as which app the email was opened in, if it was a phone or a PC, 
or even details about your actual location, IP address and other personal details about you and your 
device, so it’s a bit more invasive and you should be able to choose whether you want to share such 
data or not. 

That is why eM Client now offers options to block Email Tracking in the mail privacy setting and 
if detected, will not by default download any content that could be used to track you. 

You will see this confirmation in the information bar under the message header: 

 
The setting options for this feature are as follows: 

Always ask 

With this option, you will always be asked if you want to have your emails tracked each time a mail 
tracking pixel is detected in a message. The option to allow download of the mail tracking pixel will 
be offered in the information bar under the message header in the message detail view. The 
tracking pixel is of course not downloaded until you confirm the choice. 

This allows you to filter out which emails you want to load fully or keep the tracking pixel blocked. 

Always block detected email tracking content 

With this option, email tracking will automatically be blocked, and you won’t be asked if you would 
like to allow or restrict email tracking for any message. This can save up space when viewing the 
message as the information bar will not pop-up, but you won’t be able to easily change your mind 
about it. 

Always allow detected email tracking content 

By selecting this option, email tracking will automatically be allowed so all detected tracking pixels 
will be downloaded, so the sender will get all information about the tracking each time the message 
is opened. 

These custom options for Mail tracking are available in paid version of the program, but free 
versions can keep tracking pixels blocked using the general option to block all external 
content. 
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Blacklist and Whitelist 
Blacklist is a special type of rule that moves messages into Junk/Spam folder based on 
the sender's email or domain. 

The Local Blacklist is used when you use the 'Move to Junk and blacklist email /domain' 
feature. 

  

Whitelist is a list on the server that will prevent a message from specific senders ever 
being put in Junk/Spam folder. 

  

 

  

In the Blacklist and whitelist settings section you can add or remove items from each list 
using the Manage Blacklist and Manage Whitelist buttons. 
This window will then open: 



 

  

• Save & Close - use this button to save any changes made to the list and close the 
window 

• Add address - use this to confirm the input of the text/email address/domain 
below. You can also use the drop-down option to add email from contacts 

• Import - import a list of email addresses/domains/queries to populat the list. 
TXT files with eat item on new line is supported 

• Export - export the list into a TXT file 
• Delete - delete the selected item from the list 
• Search field - use this field to search through the list 

 
Under the toolbar you have the main text field which is used to type in what you want to 
add to the Blacklist. 
You can add partial addresses or domains too, using the selector to the right: 

• Exact match - insert the full email address, only messages from this exact email 
address 

• Domain - match the full domain after the @ symbol 
• Contains - the text can be inside any part of the email address, for example just 

part of the domain or name part of the address 
• Starts with - the beginning of the email address 
• Ends with - the ending of the email address 
• Wildcard - you can insert a more complex query using the * wildcard (which can 

mean 0-x characters) or ? to mean 1 character 

The options work the same for blacklists and whitelists. 
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Receipts 
In this section you can set the behavior for sent and received receipts. 

 

 Delivery Receipts 
Check the Request a delivery receipt for all sent messages box to have an auto-generated 
confirmation message sent back to you when your message has been delivered to the recipient's 
server.  

The recipeint's server is the one that needs to create this receipt which is sent back to you as an 
email. Some servers (such as Google) unfortunately do not support this feature to avoid spam. 

Read Receipts 

Check the Request a read receipt for all sent messages box to have an auto-generated confirmation 
message sent back to you when the recipient of your messages has opened and read your 
messages. 

Returning Read Receipts  

Here you can specify whether you wish to Never send a read receipt or to be notified for 
every read receipt request to decide per-email if you want to send the receipt or not, or to 
always send a read receipt for your incoming emails.  
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Attachments 
In the Attachments settings you can set default actions for received files as well as specify your 
settings for attachments saved in Cloud storage. 

 

Default Actions for attachments 

Here you can delete predefined actions that you have set up for various attachment file types. 

Delete the predefined action by clicking on the cross icon:  

Cloud Storage Attachments 

Add a Cloud Storage Service 

eM Client currently supports these cloud storage providers: 

• OneDrive 

• Google Drive 

• DropBox 

• ownCloud 

• Nextcloud 

• IceWarp 

• LeitzCloud 

• vBoxxCloud 



IMPORTANT: To use these services in eM Client, you first need to install the cloud storage 
application of the provider on your computer. 

You can add these services by going to Menu > Settings > Mail > Attachments and clicking the Add 
button. You will then select the provider. 

 

Add, Remove and Set as default buttons for Service providers. 

 
Add Cloud storage set up 

 

Cloud Provider selection. 

  

The first time you use cloud storage in eM Client on your device, you will be asked to log in to the 
service and give consent for the eM Client to access the service. Depending on the selected service, 
the login will appear differently. 

Remove a Cloud Storage Service 

To remove a cloud storage service, simply go to Menu > Settings > Mail > Attachments > Select 
the service > Remove 

Set as default 
If you add a large file (>10mb) into an mail and try to send it, eM Client will ask if you would like to 
upload the file to a cloud service. 
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Automatic Archiving 
In this section you can enable /disable automatic archiving of the messages.  

Automatic archiving moves message older than selected threshold to archive folder stored locally. 
This reduces amount of storage required on the server and at the same time helps you to keep your 
folders clean. 

  

w 

  

Automatic Archiving 

Enable automatic archiving - check this option if you want to enable automatic archiving. 

Ask before archiving - check this option if you want to be asked first before the archiving 
process will be launched. 

Archive every - here you can specify the time span in which you would like your messages to be 
archived. 

Archive messages older than - here you can set up the age of the messages which you wish to 
be archived. 

Click on Perform Archiving to start the process manually. 

  

For Archiving to be performed you also need to set the Archiving scope for each of your accounts 
under Account preferences. 
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Translation 
In this section you can disable or enable message translating. Furthermore you can set default 
actions (Ask or Never) for every language in the list and specify the target language (the language 
to which you want the source language to be translated) as well.  

 
  

How does translation work? 

When you receive an email written in language different than in the language of the application, eM 
Client will automatically detect and ask you if you want to translate the foreign language to your 
default language.  

 

Translations are powered by Lingvanex. 
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Watch for Reply 
In this section you can set the default behavior for watched messages, to avoid having 
messages pile up when they are not responded to in expected time frame. 

  

Remove Watch for reply messages from Unreplied folder: 

• When received 
• In 1 day 
• In 3 days 
• In 1 week 
• In 2 weeks 
• In 1 month 
• Never 
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Artificial Intelligence 
In this section you can enable or disable the AI features. 

Unchecking the "Enable Artificial Intelligence" box will his the AI and Reply with 
AI buttons from the eM Client interface. 

 
You can find out how Artificial Intelligence works for writing emails in the Generative 
AI section. 

 

 

  

The Check Quota button can be used to check how many AI credits are available to you. 
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General 
Security is our big priority but you need S/MIME Certificates or PGP keys to digitally sign and 
encrypt your emails, or decrypt and read encrypted emails from others. You may get the necessary 
certificates from your company's intranet system, from an independent security source like 
VeriSign, or from your correspondent that encrypts their emails.  

With our new PGP support you can even create your own PGP keys directly inside eM Client - go to 
the Certificates and Keys section to find out more about that. 

  

General settings for Signing and Encryption determine how long will your password for your 
certificate/key be remembered within the application and which format of encryption is to be 
preferred. 

 
  

PGP Support 

Remember entered key passphrase: 

• Until Application Exit 

• For 5 minutes 

• Never  

Format of PGP: 

• Autoselect (PGP/MIME or Inline PGP) 

• Only use PGP/MIME 

• Only use Inline PGP  

  



PGP/MIME format lets you encrypt and sign the whole message, including attachments. 

Inline PGP encrypts the OpenPGP sections directly inside an email message and cannot 
encrypt/sign attachments. 
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the Certificates and Keys section to find out more about that. 

  

General settings for Signing and Encryption determine how long will your password for your 
certificate/key be remembered within the application and which format of encryption is to be 
preferred. 

 
  

PGP Support 

Remember entered key passphrase: 

• Until Application Exit 

• For 5 minutes 

• Never  

Format of PGP: 

• Autoselect (PGP/MIME or Inline PGP) 

• Only use PGP/MIME 

• Only use Inline PGP  

  



PGP/MIME format lets you encrypt and sign the whole message, including attachments. 

Inline PGP encrypts the OpenPGP sections directly inside an email message and cannot 
encrypt/sign attachments. 
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Account policies 
Account policies will determine when messages are to be signed or encrypted automatically. 

  

 
  

Encrypt messages by default 

Digitally sign messages by default 

Include certificates/keys in outgoing messages 

  

The All Accounts setting will be applied to all accounts by default. 
You can manually change the settings for individual accounts and aliases below. 

  

If you do not have a certificate/key corresponding to an email address/alias the settings will not be 
available and a message "No matching certificate/key found for this account" will be displayed 
instead. 
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Certificates and Keys 
In this section you can import and manage all S/MIME certificates and PGP keys. 

 
  

My certificates/keys tab will show your certificates and keys, those you can use to Sign and 
Encrypt your messages. 

Others' certificates/keys tab will show Other certificates of your recipients and senders. You 
can import these manually or directly from a received message (if the original sender attached their 
public key in their message).  

  

Click the 'Manage Certificates/Keypairs' button to open the 'Manage 
Certificates/Keypairs' window, where you can add, remove and manage your certificates and 
keys. 



  

+ Create PGP certificate  
With this option you can create your own PGP keypair inside eM Client. 

All you need to do is select the mail address/alias you want to generate the keypair for and input 
your own data. 

eM Client currently generates PGP keypairs with no Expiration date. 

 

  

Make sure to remember your password as you will need it to encrypt and sign your messages. 

Import  
With this option you can import your existing Certificates and Keys. 

If the imported file contains only a Public key/certificate it will be saved in the Others' 
certificates/keys section. 

If the file also contains your own Private key/certificateit will be imported into the My 
certificates/keys section. 



Export  
With this option you can export your keys, either just the Public key or the whole keypair. 

 

Details 

Clicking the Details button  will open the following information window: 

 

Here you can see all the information about your certificate/key but also Export them or Send your 
public key to a contact with whom you wish to converse via encrypted messages in the future. 



 
You can export the whole keypair or just the public key into an .ASC file. 

You can also right-click the certificate/key using the right mouse button to open the Details or 
access its features. 

 

Send Public key 

With this button you can quickly just send the public key of the selected certifiate or keypair to the 
recipients. 

Upload to eM Keybook / Remove to eM Keybook 

With this option you can manually upload your public PGP key to the "What is eM Keybook?" on 
page 592 service. If the key has already been uploaded, this button changes to the removal option 
instead. 

Upload to OpenPGP.org / Remove from OpenPGP.org 

With this option you can manually upload your public PGP key to the https://keys.openpgp.org/ 
service. If the key has already been uploaded, this button changes to the removal option instead. 
When you add your key to OpenPGP.org you will get this confirmation window in your browser: 

 

Clicking the Delete button  will remove the certificate/key from eM Client. 
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Key Lookup Services 
You can enable or disable specific PGP key lookup services in this section. 

 
  

Enable eM Keybook support: option that enables/disables eM Keybook support service 

Search in eM Keybook: Search for specific keys by email address 

  

In addition to the "What is eM Keybook?" on page 592, we have added two other services for 
finding public PGP keys of your contacts - ProtonMail and keys.openPGP.org. 

eM Client allows you to look up public keys stored at those keyservers. In case of the 
keys.OpenPGP.org you are also able to upload your own PGP public keys or public keys created 
directly in eM Client. 
 
You can manually search at the specific server here in Key Lookup Services settings or keep them 
enabled so when you do try to send an encrypted email to a new contact the app can automatically 
search through the enabled services. 

  

To find out how to upload your keys to eM Keybook or OpenPGP.org, go to "Certificates and Keys" 
on page 189 



ProtonMail works similar to OpenPGP.org, but you are not allowed to upload to or remove keys from 
the database. It serves the users only as a database of ProtonMail public keys for storage and 
lookup. 

Enable eM Keybook support 
We let users upload public keys to eM Keybook and then when another user wants to send 
encrypted email to that person, he does not have to ask for a public key. Instead eM Client will 
search for their public key in the eM Keybook and offer to download it for you automatically. When 
this option is disabled, eM Client won’t ask you if you want to import public keys available in our eM 
Keybook. 

  

Behavior when Enable eM Keybook support is checked: 

 
  

Behavior when Enable eM Keybook support is NOT checked: 

 

Search in eM Keybook 

Here you can search for public PGP keys which have been uploaded by our users. Just search for 
their email address and if they have a public key available, you can then choose one of these 
options 

• Import: import it into your own keybook to easily send them an encrypted message 

• Details: See details of the public key (and export it as an .acs file or send it to someone) 

• Send Public Key: Send the public PGP key to someone else via email 

  



 
  

Details of a PGP public key: 
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 Calendar  
You can access the calendar's settings by right-clicking anywhere on the calendar's main panel and 
selecting Calendar Preferences from the context menu, or by selecting Menu > Settings from the 
main program window and selecting the Calendar section in the Settings window. 

 

  

The Calendar Settings window consists of seven sub-sections: Calendar View, Work Week, 
Balloons,  Agenda (Events List), Event Detail, Invitations and Defaults. 



Calendar View 

Go to Today every time calendar is opened:  
If you check this option, then the current day will always be in focus when you open the calendar 
section. 

Show week numbers:  
If you check this option, there will always be displayed a number of the week according to the 
current year in the month view of the calendar.  

Granularity: 
This option allows you to choose the granularity of the day and week view layouts. 

The days are divided into hours by default. If you want to plan your time more accurately, you can 
split the hours into slices of 5, 10, 15, 20 or 30 minutes. This time unit is important when you are 
moving and resizing events by Drag & Dropping event boxes because you can't adjust the events by 
smaller time units than defined here. 

Show Range: 
This option allows you to set the "height" of your calendar's layout. The value specified in this field 
determines how many hours will be visible at one time in the calendar's central panel. 

So, if you set 24 hours in this field, you won't have to scroll at all in your calendar's central panel, 
leaving you plenty of room for your nocturnal activities. 

Source of event's color in multi-calendar mode: 
You can define the source of the color of an event while you are in multi-calendar mode. This option 
is there for a case when you are working with more than one calendar. You have three options:  

• Tag then calendar - will prefer tag color and neglect calendar color. 

• Calendar then tag - will prefer the color of a calendar and the tag color will be displayed 
only by tag indicator. 

• Calendar only - will display calendar color primarily while you have selected one calendar 
only.  

First day of the week: 
Set which day starts off your week. 

First week of the year: 
Set the first week of the year, so the week numbers in the app match your preference - default is to 
Detect from system, but you can manually change it to week which includes January 1st, first 4-day 
week or first full week. 

Work Week  
In this section, you can define the parameters of the work week. When it starts, when it ends and 
which days it contains. 

Balloons panel  
In this panel you can define the behavior of the popup balloons which appear when you hover the 
mouse pointer over an event box. These balloons contain the events' info.  

You can learn more about Balloons in the Calendar Views section. 

Agenda (Events list) 

Check Show groups in agenda to have groups displayed also in Agenda (Events list) 



Event Detail 

Always show advanced options 

By default, event creation window shows just few basic fields. With this option, all fields will always 
be visible. 

Invitations 

Set default behavior for the event invitations, either always ask if the invite should be sent or not, 
always send it or never send one out. 

Defaults 

In this panel you can set default meeting length. Consequently select whether you want to 
apply it to all folders or only to the selected ones.  
You can also set default meeting type, depending if you create more Online meetings or 
Standard events - but you can always have the program ask each time. 
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 Calendar  
You can access the calendar's settings by right-clicking anywhere on the calendar's main panel and 
selecting Calendar Preferences from the context menu, or by selecting Menu > Settings from the 
main program window and selecting the Calendar section in the Settings window. 

 

  

The Calendar Settings window consists of seven sub-sections: Calendar View, Work Week, 
Balloons,  Agenda (Events List), Event Detail, Invitations and Defaults. 



Calendar View 

Go to Today every time calendar is opened:  
If you check this option, then the current day will always be in focus when you open the calendar 
section. 

Show week numbers:  
If you check this option, there will always be displayed a number of the week according to the 
current year in the month view of the calendar.  

Granularity: 
This option allows you to choose the granularity of the day and week view layouts. 

The days are divided into hours by default. If you want to plan your time more accurately, you can 
split the hours into slices of 5, 10, 15, 20 or 30 minutes. This time unit is important when you are 
moving and resizing events by Drag & Dropping event boxes because you can't adjust the events by 
smaller time units than defined here. 

Show Range: 
This option allows you to set the "height" of your calendar's layout. The value specified in this field 
determines how many hours will be visible at one time in the calendar's central panel. 

So, if you set 24 hours in this field, you won't have to scroll at all in your calendar's central panel, 
leaving you plenty of room for your nocturnal activities. 

Source of event's color in multi-calendar mode: 
You can define the source of the color of an event while you are in multi-calendar mode. This option 
is there for a case when you are working with more than one calendar. You have three options:  

• Tag then calendar - will prefer tag color and neglect calendar color. 

• Calendar then tag - will prefer the color of a calendar and the tag color will be displayed 
only by tag indicator. 

• Calendar only - will display calendar color primarily while you have selected one calendar 
only.  

First day of the week: 
Set which day starts off your week. 

First week of the year: 
Set the first week of the year, so the week numbers in the app match your preference - default is to 
Detect from system, but you can manually change it to week which includes January 1st, first 4-day 
week or first full week. 

Work Week  
In this section, you can define the parameters of the work week. When it starts, when it ends and 
which days it contains. 

Balloons panel  
In this panel you can define the behavior of the popup balloons which appear when you hover the 
mouse pointer over an event box. These balloons contain the events' info.  

You can learn more about Balloons in the Calendar Views section. 

Agenda (Events list) 

Check Show groups in agenda to have groups displayed also in Agenda (Events list) 



Event Detail 

Always show advanced options 

By default, event creation window shows just few basic fields. With this option, all fields will always 
be visible. 

Invitations 

Set default behavior for the event invitations, either always ask if the invite should be sent or not, 
always send it or never send one out. 

Defaults 

In this panel you can set default meeting length. Consequently select whether you want to 
apply it to all folders or only to the selected ones.  
You can also set default meeting type, depending if you create more Online meetings or 
Standard events - but you can always have the program ask each time. 
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Weather 
In this panel you can define the settings for a feature which displays reliable weather forecast 
information for several upcoming days in the calendar. Specify the city you are located in and 
choose whether you would like to have the temperature displayed in degrees Fahrenheit or 
Celsius. 

 
Copyright © 2025 eM Client s.r.o. 

Thámova 18 
 Prague, 186 00 
Czech Republic  

info@emclient.com  



Contacts 
Contacts settings window:  

 

Contact list 

Show groups in contact list 
In List view this option will show Groups for your contacts depending on how you sort them. 

File as 

File new contacts as: 
Here you can set up whether you want to file new contacts as Surname, Name; Name, Surname; 
Surname Name or Name Surname. Then click on the Update Contacts... button to activate the 
manner in which the contact should be filed. The very last step is to select the contact folder(s) that 
you would like to update. You can also adjust whether you want your contacts to be shown in 
groups in contact list. 

Avatars 

eM Client automatically downloads and displays avatars for your contacts from the web. We 
download images from Gravatar, domain icons and more. 

https://gravatar.com/


If no image is saved for your contact on server or in your Contacts section, the contact's initials or 
empty icons will be shown instead, depending on these settings: 

Download avatars from external sources 

This option will determine if images from external sources are downloaded or not. 

This does not include images from your Contacts. 

If you uncheck this option, Apply the change, and then check again, you will reset your 
avatars cache and new images will be downloaded. Otherwise, already downloaded images are 
updated once every 30 days. 

Show monograms when no other avatar is found 

This option determines if initials are shown. If you uncheck the option only a basic silhouette icon 
will show instead. 

Contact Details 

Show tag bar 

Show or hide the tag bar in People view in the top right corner - easy way to see and assign or hide 
tags for your contacts. 
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Tasks 

 

Tasks List 

Show groups in tasks list 

Here you can choose whether you would like to show groups in tasks List view. 

Task form 

Always show advanced options 

By default, eM Client shows a shorter list of options in the New Task window, such as Dates and 
Name, but not others like Note/Details. 
With this option all available fields for the task will be visible by default. 

Task Detail 

Show tag bar 

Show or hide the Tag bar that lists assigned tags or can be used to add/remove them in the top 
right corner of the Details view. 

New Tasks  

Autofill start date with the current date 

Autofill due date with the current date 

Using these checkboxes you can decide if either Start or Due date should be pre-filled with current 
date when you create a new task. 



Invitations 

Invitation sending behavior 
Using this selector you can decide what should be the default behavior for invitations when you add 
people to your task/assign a task to them. 

• Always Ask 

• Always Send 

• Never Send 
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Notes 
This feature is available only to Personal, Business or Pro license users. 

 
  

Show Tag Bar:This settings will toggle displaying the Tag Bar in the upper right corner of your 
Notes. This makes it much easier to quickly see and manage your Tags within Notes. 

Show notes in groups:You can check if you want your messages to be displayed in groups. Setting 
is currently available only for 'Last Modified' argument. Your Notes will be now sorted in groups like 
"Older" , "Two weeks ago" etc. 

Show full date: This extends the date of when the note was last modified. 

Use compact layout in widths smaller than [x] pixels: Here you can customize your compact layouts 
by selecting the number of pixels. 

Compose 

Automatically save notes every [x] minutes: This adjusts how frequently notes are autosaved. The x 
value can be set between 1 and 99 minutes, or disabled completely by unchecking the box. 
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Chat 
In this menu you can specify the settings for your communication via Chat.  

You can enable: 

•  sending messages on pressing Enter 

• showing quick answer in message notification 

• using automatic status changing, which involves specifying the amount of time after 
which your status will be automatically changed to "Away" and "N/A"(Not Available). 

If you check the "Auto accept incoming files" field, any files coming in through Chat will be 
automatically accepted and stored in the directory that you specify below. 

  

 
  

If you do not enable "Auto accept incoming files" you will need to confirm incoming files 
manually when the window pops up: 
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 Online Meetings 
  

eM Client currently supports these Online meeting providers: 

• "Google Meet" on page 212 
• "Microsoft Teams login and permissions:" on page 213 
• "Zoom login and permissions:" on page 214 
• "Webex by Cisco" on page 216 
• "IceWarp Video Conferences" on page 217 
• "GoToMeeting" on page 217 
• "Meetn" on page 217 
• "Vivomeetings" on page 219 
• "SmarterMail" on page 219 

Add an Online Meeting Provider 

To add online meeting integration, you can go to Menu > Settings > Online Meetings > 
General. 

Then click the Add button at the bottom of the window and select the online meeting 
service you wish to add. 

 



  

Next, you will sign it to your online meeting service using your normal login credentials. 

Then, you will need to accept the permissions for eM Client to connect to the online 
meeting service 

Finally, the service will be added to your list of online meeting providers, and you can 
select that service when creating an online meeting. 

  

Google Meet 

By default, users who have enabled Google Calendar access already have Google Meet 
added as an Online Meeting provider for every one of their Google Accounts in eM 
Client, and they can only be removed by disabling the Google Calendar service for that 
account. 

  



Microsoft Teams login and permissions: 

 



 

  

Zoom login and permissions: 

Adding Zoom to eM Client may require a manager’s permission, depending on the setup 
of your organization’s Zoom account, otherwise (as a single user with Admin rights) you 
will need to click the Pre-Approve button. 



 

 
Then you will be able to Authorize the account for eM Client: 

 

  



If you don’t have admin rights for your Zoom account, or eM Client isn’t pre-approved in 
Zoom by your organization, this means that you will need to set up Zoom in eM Client 
twice. First to send the pre-approval request, then to actually add the Zoom service. You 
will need to take the following steps. 

1. Initially try to add Zoom to eM Client 
2. Send the approval request to the Zoom admin 
3. Click Cancel in eM Client because the application locks up while approval is being 

sought 
4. Wait for the request to be approved (you will receive an email upon approval) 
5. Add Zoom to eM Client again. 

  

Webex by Cisco 

For Webex you will need to just login via the oAuth window that pops up: 

 

  



IceWarp Video Conferences 

By default, users who set up an IceWarp account using SmartDiscovery will have 
automatically enabled access to IceWarp Video Conferences in eM Client. 

  

GoToMeeting 

For GoToMeeting you will need to just login via the oAuth window that pops up: 

 

  

Meetn 

You will be prompted to create or insert a Room name when adding Meetn to eM Client: 



 

  



Vivomeetings 

 

In a separate browser window you will be prompted to sign into your Vivomeetings 
account with your standard login credentials for the service. 

If you are already signed into your browser, simply click Authorize. 

SmarterMail 

SmarterMail is added for Online Meetings automatically when you add a SmarterMail 
account using the Automatic setup in Menu > Accounts. 

Or you can add the URL of your domain manually. 



 

Remove an Online Meeting Provider 

 To remove Microsoft Teams or Zoom, select them from the list of providers and click 
the Remove button.  

 

Because Google Meet is tied to the Google Calendar function, the only way you can 
remove the service from eM Client is by disabling your Google Calendar service, which 
means your Google Calendar will no longer appear in eM Client.  

If you still wish to remove it, you can go to Menu > Accounts > Select your Google 
account > General Tab > Services > Uncheck the box for Google Calendar. 
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Widgets 
Widgets are useful add on applications that can be customized to personalize your account. You can 
use them to display your favorite web pages or to read the latest news from a RSS feed.  

The Widgets Settings window: 

 
  

To create a new RSS widget, click the Add New button, select the RSS Widget and press Next >. 

 
  



Enter an arbitrary name for your new widget and enter the URL of the desired RSS feed. A sample 
CNN news feed is shown in the picture below, you can find many RSS feeds using your favorite web 
search engine. The form of the URL may vary depending on the RSS feed provider. 

 
  

To create a new Web widget,click Add New Widget, select Web Widget and press Next >. 

 
  

Enter a name for your new widget and enter the URL of the web page that you want to display. 



 
  

You can simply delete existing widget by clicking on Remove Widget button and modify existing 
widget by clicking on the Modify Widget button. 

By clicking on Modify Widget button, following window will appear: 

 
You can arbitrarily change the existing Widget's URL or name. 
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Logging 
Logging enables generating of very detailed diagnostic log files into the selected logging directory. 
With every startup a new log file is created. Logs are generally useful for troubleshooting. 

 

Logging 

By clicking the three-dot button you can specify the directory in which you wish your logs to be 
saved.  

Log the following 

You can choose to log following for different troubleshooting:  

Global options: 

• Database 

• Import 

• XMPP Registration (for newly created XMPP accounts) 

• Rules 

• Reminder 

• IceWarp API (if an IceWarp account is in your Accounts section) 

• Cloud Storage 

• Online Meeting 

• Attachment Indexer 

• Translations 

• Licensing 

• Automatic Archiving 



• Authentication 

• Security 

• Operations 

Account-specific options:  

These will be available depensing on what type of accounts you use, whether email (IMAP, POP, 
SMTP, Exchange), calendar and contacts (CalDAV, CardDAV, Google Calendar and Contacts) and 
more. 

  

By clicking on the Send Logs button an email with the log files attached to it will be created and 
sent to eM Client team. 

Clear Logs will delete all created log files so you can free up the space on your device from old 
files. 

Copyright © 2025 eM Client s.r.o. 

Thámova 18 
 Prague, 186 00 
Czech Republic  

info@emclient.com  



Logging 
Logging enables generating of very detailed diagnostic log files into the selected logging directory. 
With every startup a new log file is created. Logs are generally useful for troubleshooting. 
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By clicking on the Send Logs button an email with the log files attached to it will be created and 
sent to eM Client team. 

Clear Logs will delete all created log files so you can free up the space on your device from old 
files. 
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Main menu and toolbar 



Toolbar 

 
  

Toolbar provides you with different quick-access options depending on which section of the 
application you are currently working in. When you are in the email section, the email toolbar is 
displayed, which provides you with quick access to various email operations. The same toolbar will 
provide you with different options to perform different operations when you are in calendar mode or 
task mode. 



Menu 

 
  

The Menu contains some of the most common functions and settings sections: 

• Print... - you can print your messages, calendar, events or contacts using our print preview 
where you can adjust many aspects of the final layout of the page about to be printed.  

• Backup... - You can backup your data. 

• Check for Update...- if you click on this option, the application will try to look for available 
updates for your license online. If an update is found, a list of new features will be displayed 
and you will be prompted to confirm that you want to install the update. 

• Operations... - You can view ongoing operations, any errors that might have popped up or 
the operations log that can be useful for troubleshooting. 

• Rules...- You create rules here. You can find further information about creating rules in the 
topic Rules. 

• Quick Actions... - You can manage Quick Actions here. 

• Tags... - Here you can manage your tags active in the eM Client. You can find more 
information about managing tags in the topic Working with Tags.  

• Reminders... - View the Reminder window with pending reminders for your events or tasks. 

• Settings...- When you click on this button, a window with settings will appear. You can find 
more information about settings in the topic Settings. 

• Accounts...- When you click on this button, a window for working with the accounts will be 
displayed. You can find more information in the topic Accounts. 



• Data Files... - Opens the Data Files manager. 

It also contains six further sections - File, Edit, View, Message, Tools, and Help. 

Those further options can be brought up only by clicking on the menu button first.  

Under all these you have the Exit option to fully close down the app. 

File 

 
Menu File has these items: 

• Open - You can open a saved email (an eml file). 

• Save as - You can save a chosen email to an eml file. 

• Close - Close current window. 

• Import... - You can import data to the application. 

• Export... - You can export data from the application. 

• Restore... - You can restore your data. 

• Work offline - When you choose this setting, the application will work without connecting 
to Internet. If you send an email, it will be saved and it will be sent after connecting to 
Internet. 

Back to menu. 

Edit 

 
Menu Edit has many items: 



• Undo - If you delete something, you can undo the operation of deleting. 

• Redo - If you performed undo operation, you can now perform redo and the retrieved 
operation will be deleted. 

• Cut - Cutting copies selected item into clipboard and removes the item from its current 
place. 

• Copy - When you click on this button, it will make a copy of the selected item. 

• Paste - Paste will insert the item currently stored in clipboard (one that was previously cut 
or copied). 

• Select all - All items will be selected. 

• Find... - You can perform textual search - either simple, or you can specify advanced 
options for your search.  

• Clicking on Find option will bring your focus to the Search in the top right corner of 
the window, opening the Advanced Search pop-up (see below). 

• Find in Body... - This option will bring up a simple search window to search inside the body 
of currently opened message. 

• Empty All Trash Folders - This option, as the name suggests, will permanently delete all 
messages in all Trash folders in the program (the Local folders and all your accounts' 
folders). 

  

Advanced Search  

Advanced search represents a smart utility that enables you to search with predefined rules which 
will filter out particular emails from the global folders, i.e. folders where all your emails are stored. 
As you can see in the picture, search window consists of two parts: textual form of query and the 
visual form of query.  

 

To learn more about working with search queries and about creating a filtered folder see Search 
Folders.  

  



Back to menu. 

View 

 
  

Menu view has many items: 

• Columns... - You can select columns which you want to see in the list of emails. You can 
also change the order of columns. 

 

• Layout - You can change position of the panel with messages - Messages on the bottom, 
Messages on the right, Messages panel off.  

• Sidebar- You can change layout of the sidebar. 

• Conversations - Enables you to customize and specify conversations. 

• Show tag bar - Enable or disable the bar with assigned Tags above the message header in 
message preview. 

• Previous message - The selected item is changed to previous message. 

• Next message - The selected item is changed to next message. 



Back to menu. 

Message 

 
Actions menu differs according to the section where you currently are (mail, calendar, tasks, 
contacts etc.) 

  

Actions Menu has several items: 

• Reply - When you click on this button, you will reply to a selected email. 

• Reply All - When you click on this button, you will reply to all people in a selected email. 
(for example to people in CC) 

• Forward - You can send a selected email to another person. Moreover you can choose from 
three actions: Forward..., Forward as Attachment..., Forward as Original... and Resend... 

• Flag - by clicking this, you will add a flag to your message (event etc.) - for example to 
mark the emails you need to reply to etc. 

• Tag- you can choose a color tag that will be added to the message. 

• Mark as Read - You can mark your unread email as read. 



• Mark as Unread - You can mark your email as unread. It is useful when you read an email 
but you don't have a time to answer it so you can mark it as unread. 

• Mark All as Read - You can mark all your emails as read.  

• Snooze - Snooze your message to be re-added to your inbox at a more convenient time. 

• Archive -Move the message into the Archive folder. 

• Move to Junk - You can select from three options: Move to Junk, Move to Junk and 
blacklist email, Move to Junk and blacklist domain.  

• Copy to Folder… - You can copy a selected item into another folder. Last 10 folders you 
copied messages to will be remembered in copy history. 

• Move to Folder... - You can move a selected item to another folder. Last 10 folders you 
moved messages to will be remembered in move history. 

• Download Selected for offline use - You can download selected items. 

• Create Meeting from Message - You can create a meeting directly from the message. 

• Create Task from Message - You can create a task directly from the message.  

• Create Rule from Message- Quickly create a rule based on this messages sender or 
subject. 

• Add Note - Add a local note to your message without altering the original. 

• Format - Easily switch the view of current message from HTML to Plain text and vice versa. 

• Delete - Deletes the message. 

Back to menu. 

Tools 

 
  

Menu Tools has these items: 

• Subscribe to Internet Calendar…  - You can set up a calendar access directly from 
here. 

• Contacts - Clicking on Contacts will bring up the Address Book (see below). This feature can 
be used for selecting the particular contact that you want to send a message to. Start writing 
contacts's initial letters to search for particular contact. 



 
  

• Deduplicator... - Deduplicator is a tool which enables you to get rid of duplicate (multiple) 
items in following areas: mails, events, tasks, contacts. Click on Deduplicator to bring up 
following window:  



 
  

Select the item type and click on Next: 

  

 
  

Here you can select folders that will be searched for duplicate files and moreover you can specify 
whether you want to search for duplicates in each individual folder or over a group of folders. When 
you are finished click on the Next button. 



  

 
  

Here specify the action to be done for duplicated items found. Click on Finish to finish the process.  

• Automatic Replies - With a Google, Exchange/Office365 or IceWarp account you can set 
up automatic responses for all your messages when you're out of office or away on holiday. 

• Mail Forwarder - With an IceWarp account you can set up automatic forwarding for your 
messages. 

• Theme Editor - Open the Theme Editor to create your own theme or tweak one of the 
existing ones to your preference, find more details in Themes settings. 

• QR Export - used to export data to mobile version of eM Client via a QR code. 

Back to menu. 



Help 

 
  

Menu Help has several items: 

• Documentation - When you click on this button, a web browser window with the eM Client 
documentation will display. 

• FAQ - link to the Frequently Asked Questions section of our website 

• Video Tutorials 

• Blog - link to the company blog which can provide more details on certain features and 
updates or current issues. 

• Forum - Community forum for all users, main support hub for users with Free licenses and 
expired VIP Support 

• License - Here you can view, activate or deactivate your license. 

• Get VIP support -link to the online support web pagefor Pro license users with active 
VIP Support subscription.  

• Open Log Directory - opens the Logs folder containing all created .log files 

• Profile for 10 seconds - Create profile log that runs for 10 seconds and then saves into a 
text file, which can befound in the Logs folder. This can be useful for freezes and other issues 
in eM Client that do not have dedicated logging options in the Advanced settings. 

• Record Memory Usage - Creates special log file to analyze memory usage of the 
program. 

• Terms of Use - link to eM Client Terms of Use 

• Privacy Policy- link to eM Client's Privacy policy 

• Invite to eM Client - when you click on this button, a window with invitation to eM Client 
for your friends will appear. You can invite them using: email, Twitter or Facebook.  



• About - You can click on this button to see more information about this product and can 
copy the currently installed version here. 

 
  

Back to menu. 

Touch Input interface 

eM Client supports touch-operated devices, if your device has such utility, you will be able to switch 
to touch-operated mode by clicking on the appropriate icon in the right upper corner of eM Client 
window: 

 
  

If you switch to the touch mode, all icons and features of the application will become a little larger 
in order to easily control the application. 

In the touch mode: 

•  You can scroll in all menus by touch movement (context menus etc.). 

•  In calendar view you can move in all directions by touching the screen. 

•  By the pinch-to-zoom action you can change the number of weeks displayed in the month 
view of the calendar as well as zoom in/out in the week view.  
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Search  

Search Bar  
The Search bar in eM Client is located in the middle of the top title bar, above the toolbar: 

 
  

Using the search bar, you can simply search for your emails (or other items in other sections of the 
app). A list of several useful command tools will appear in the context menu when you type a 
question mark in the search bar. 

Click inside the search bar to view the folder selection on the left and the settings for 
search and Advanced search button on the right side. 
If you performed some searches before, clicking inside the search field will bring up search history 
so you can repeat your recent search. 

 
  

Folder options on the left - this section dictates which actual folders the search will be performed 
within: 

 

• Current folder 

• Current folder and subfolders 

• All folders 

• Custom Folder Selection 

  

Click on the pointing down arrow to bring up the context menu for search bar: 



 
  

Recent history - view the recent searches. 

Part of the message - this section dictates which actual part of the message will be searched 
within, so for example if you set to search in Subject, you will only search inside the subject line 
and not other parts of the message like sender address or inside the attached files. To search inside 
attachments and message bodies you need to have the messages downloaded for offline use or use 
server-side search. 

• Subject, sender, recipients, body and attachments 

• Subject, sender, recipients and body 

• Subject, sender and recipients 

• Subject 

• Body 

• Sender 

• Recipients 

Use server search if available -this option means that if the account has server-side search 
available, eM Client will execute the search on the server instead of locally inside the eM Client app. 
Server-side search can be used for all Exchange accounts and also IMAP accounts whose servers 
support this feature (for example Google). This way you can get more complex results quicker 
without having to download your messages for offline use. IMAP servers need to use RFC 7377 and 
RFC 6203 extensions for server search to work. 

 
Create search folder.. - create a new Search folder which is a set search parameter that stays 
in your folder list, which can be useful for commonly repeated searches. 

https://tools.ietf.org/html/rfc7377
https://tools.ietf.org/html/rfc6203


 
  

Search keywords 

Keywords are quick way to specify your search without needing to use the Advanced search 
interface. You can use the ? symbol to have the search bar list all the keywords options you can 
use. 
Then just use the keyword, then colon : and then the words or argument that can apply (for 
example from:johnwill look for messages where the sender has name set as john or john is part of 
the email address). 

  

Using numerous keywords and searched terms one after another will work as AND argument 
between them (from:john read:no will work for messages received from sender john and marked 
Unread). 

OR argument inside single keyword can be done simply with comma , between the arguments 
(from:john,clara will list messages received from john or from clara). 

OR argument between different keywords can be achieved with curly brackets {} and space 
between the keywords ({from:john subject:party}will look for messages either from john or those 
with word party in the subject line). 

NOT argument can be used to leave out results with specific words and can be used to negate 
specific searched term or even whole keyword using the minus/dash - (google -alert will look for 
word google in all sections of the messages and leave out those that include the word alert; from: 



google subject:-alert or from:google -subject:alert can specify messages from google, but alert 
cannot be in subject). 

  

Keyword list: 

Mail 

• text - searches for words in subject, body, email, name of the attachment or content of text 
attachments 

• content - searches only in subject and body 

• -text - searches for messages that do not have the given words in in subject, body, email, 
name of the attachment or content of text attachments 

• subject 

• body 

• attachmentContent 

• attachmentName 

• notes 

• from 

• reply 

• to 

• cc 

• bcc 

• email 

• recipient 

• flag 

• read - yes/no, if the message is marked as Read or Unread 

• signed - yes/no, depending if message is digitally signed using S/MIME or PGP technology 

• encrypted - yes/no, depending if message is encrypted using S/MIME or PGP technology 

• attachment - yes/no, depending if there is an attachment 

• importance - low/medium/high or 0/1/2 respectively 

• before   

• after 

• within 

• received-before 

• received-after 

• larger 

• smaller 

• received-within 

• tag 

• category - name of the assigned "Inbox Categories" on page 290 

Calendar 

• text - searches in title, description of the event and the set location 



• -text - searched words are not in title, description on location 

• title 

• description 

• location 

• onlineMeeting 

• attachment 

• before 

• after 

• tag 

Contacts 

• text - searches in name, note, street, county, country, zip, city, email address, display name 
for email address, organization, office, profession, department, hobbies, chat UIN, chat 
name, phone and webpage 

• im - chat name or unique id 

• email - email address and email display name 

• -text - searched words are not in name, note, street, county, country, zip, city, email 
address, display name for email address, organization, office, profession, department, 
hobbies, chat UIN, chat name, phone or webpage 

• firstName 

• middleName 

• lastName 

• fileAs 

• displayName 

• nickName 

• prefix 

• title 

• name 

• emailAddress 

• emailName - display name of the email address 

• imUin - chat id number/UIN 

• imName - chat name 

• phone 

• organization 

• office 

• profession 

• department 

• hobbies 

• street 

• county 

• country 

• zip 



• city 

• address 

• note 

• birthday-before 

• birthday-after 

• anniversary-before 

• anniversary-after 

• anniversary-within 

• birthday-before-day - ignores year 

• birthday-after-day - ignores year 

• anniversary-before-day - ignores year 

• anniversary-after-day - ignores year 

• webpage 

• attachment 

• tag 

Tasks 

• text - searches in title, note and location 

• -text - searched words are not in title, note or location 

• title 

• note 

• location 

• attachment - yes/no  

• before 

• after 

• status - search based on status the task is in 

• tag 

Attachments 

• text - searches in file name, subject of the item source, content and name/address of the 
sender or recipient 

• -text - searched words are not in file name, subject of the item source, content and 
name/address of the sender or recipient 

• filename 

• itemSubject - subject line or title of the email/event/task/etc. which has the given 
attachment 

• content 

• senderReceiver 

Notes 

• text - searches in title and body 

• -text - searched words are not in title and body 

• title 



• body 

• tag 

Chat - search in chat is available for Slack, MS Teams and Rocket.Chat at this time 

• from   

• in - specify channel or conversation 

• with - messages where contact is a participant 

• hasmy - messages with your reaction 

• has 

• reaction 

• before 

• after 
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Quick filter 
Quick filter is a fast and easy tool for sorting out all of your items in eM Client.  

It can be used in Mail, Calendar, Contacts, Tasks and Notes. It is useful for when you want to 
quickly filter the results without the need of a specific search or a new search folder. If you want to 
see only the messages with an attachment, online meetings or a task with a specific tag, Quick filter 
is the perfect instrument for the job. It offers a wide range of filter options designed specifically for 
each section. 

 

How to use the Quick filter? 

It is very simple. There is a small funnel icon (see above) in the top right corner of every item list. 
You just click on the icon, select the desired filter and confirm it. The items are going to be 
immediately filtered. You can always change the quick filter by selecting a different one.  

If you don’t need it anymore, cancel the filter by clicking on the cross icon under the funnel button 
or reselect the filter in the context menu. 

 

 Although Quick filter is usable throughout all sections with exception of Attachments, it is not 
available in certain views. In Calendar, the Quick filter is usable only in Agenda and in Contacts, you 
can not use it in the Business cards view.  

You can have only one filter active at a time. The only exception is filtering by Tags. When you 
move the mouse on the option “With tag” and press Ctrl or Shift key, you will be able to pick 
multiple tags at once. The filtered items are going to contain the specified combination of tags. 

  



Available filters: 

Mail: 

 

• Flagged 

• Unread 

• With attachments  

• Encrypted 

• Signed 

• With tracking pixel 

• Invitations 

• With note 

• With tag 



Calendar: 

 

• With attachments 

• Recurrent 

• Private 

• Online meeting 

• With participants 

• With no participants 

• With tag 

Contacts 

 

• With attachments 

• With email address 



• With telephone number 

• With post address 

• Contacts 

• Distribution Lists 

• With tag 

Tasks: 

 

• Not started 

• In progress 

• Waiting for someone 

• With attachments 

• Recurrent 

• Assigned to someone 

• Assigned to no one 

• With tag 



Notes: 

 

• With attachments  

• With tag 
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Quick Actions 
The Quick Action feature is designed to help you finish more work in less clicks. You 
can specify an order of actions with steps that should be performed when you use your 
select keyboard shortcut or select the Quick Action from the main toolbar.  

 

  

This will help you automate your common tasks, when it comes to either quickly starting 
a new email (starting it with specific template, recipients, signature, etc.) and sending it 
or managing incoming messages (flagging, copying, moving, adding a tag, etc.). 

 
In the drop-down menu from the main toolbar click Manage to add or edit existing Quick 
Actions: 

 

Toolbar in this window: 

• Add - add a new Quick Action to the list 
• Edit - Edit the selected Quick Action 
• Duplicate - make a copy of the Quick Action 



• Delete - permanently delete the selected Quick Action 
• Up - move the action up in the list 
• Down - move the action down in the list 

Creating a New Quick Action 
Clicking Add in the Quick Actions window will open this creation window: 

 

Toolbar: 

• Save & Close - save the Quick Action once you're finished 
• Add - this button will add steps to your Quick Action 
• Edit - edit the selected step 
• Delete - delete the selected step 
• Up - move the step up 
• Down - move the step down 

Under these buttons you will need to Name your action so you can easily see it in the list 
and you can assign a shortcut - including single-key shortcuts or any other you prefer 
(unless the same key combination is already used in menu > Settings > General > 
Shortcuts). 

  

Click +Add to add steps to your Quick Action, there is few different options: 



 

Email Creation 

• New mail 
• Reply  
• Reply all 
• Forward 
• Forward as original 
• Forward as attachment 



Email Settings 

• Add To address 
• Add Cc address 
• Add Bcc address 
• Add Subject 
• Add Body 
• Set Reply-to address 
• Add QuickText 
• Use template 
• Use signature 
• Add attachment 
• Set importance 

Email Actions 

• Move to folder 
• Copy to folder 
• Delete 
• Delete Permanently 
• Translate 
• Archive 
• Tag 
• Category 
• Untag 
• Flag 
• Unflag 
• Mark as read 
• Mark as unread 
• Notify me when replied 
• Notify me when not replied 
• Snooze 
• Create Task from Message 
• Create Meeting from Message 

Email Sending 

• Send 
• Send later 
• Save as draft 

  



Once you are finished with your action make sure to click Save & Close to finish it and 
start using it in your mail management! 
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About Favorite Folders  
Favorites folders (formerly called Smart Folders) are folders which contain Global folders, such as 
All Inboxes , Outbox, Sent, Drafts, Junk Email, Trash, Unread, Flagged, Snoozed, and 
Unreplied which combine all special folders and messages of certain type from all accounts that 
are active (i.e. Favorites Folders enable you to have a complete overview of all kinds of messages 
that you exchanged with your contacts.)  

You can also pin your own folders to this section to have specific folders handy at the top. Pinned 
folder can be renamed, for example if you pin numerous different Inbox or Todo folders. 

 
  

You can enable or disable this feature by going to Menu > Settings > General > Folders and 
checking/unchecking the box for Favorites. 



 
  

By right-clicking on a particular Favorite folder you can perform various actions: Show in new 
Window... , Mark All Messages as Read, Collapse All, Display and Folder Color. 

 
  

Show in new Window... will open this folder in a new program window. 

Mark All Messages as Read will mark all messages in this special folder as Read. 

Collapse All will collapse all accounts and folders at once. 



Expand All will expand all accounts and folders at once. 

Folder color will let you set a specific color for the folder if you want to color code your folder list 

By clicking on Display a context menu will appear, showing which of Favorite folders can be 
displayed at one time (see picture).  

  

 

  

How to add your own folders to Favorites Folders 

You can add links to your most used folders from your specific accounts so you can quickly access 
them. 

For example, if your work email account has a folder called Invoices which you use a lot, you can 
add a copy of that folder to the Favorites Folders section so that you can quickly access it. This copy 
of the Invoices folder will automatically update when the original Invoices folder is updated, and 
vice versa. 

You can easily add account folders to your Favorites folders by dragging and dropping that folder to 
the Favorites Folder Section. Or you can right-click on the folder and select Add to Favorites from 
the context menu. 



 

How to remove folders from Favorites Folders 

You can remove an added account folder from the Favorites Folders section by right-clicking on the 
folder and selecting Remove from Favorites from the context menu. 
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About Favorite Folders  
Favorites folders (formerly called Smart Folders) are folders which contain Global folders, such as 
All Inboxes , Outbox, Sent, Drafts, Junk Email, Trash, Unread, Flagged, Snoozed, and 
Unreplied which combine all special folders and messages of certain type from all accounts that 
are active (i.e. Favorites Folders enable you to have a complete overview of all kinds of messages 
that you exchanged with your contacts.)  

You can also pin your own folders to this section to have specific folders handy at the top. Pinned 
folder can be renamed, for example if you pin numerous different Inbox or Todo folders. 

 
  

You can enable or disable this feature by going to Menu > Settings > General > Folders and 
checking/unchecking the box for Favorites. 



 
  

By right-clicking on a particular Favorite folder you can perform various actions: Show in new 
Window... , Mark All Messages as Read, Collapse All, Display and Folder Color. 

 
  

Show in new Window... will open this folder in a new program window. 

Mark All Messages as Read will mark all messages in this special folder as Read. 

Collapse All will collapse all accounts and folders at once. 



Expand All will expand all accounts and folders at once. 

Folder color will let you set a specific color for the folder if you want to color code your folder list 

By clicking on Display a context menu will appear, showing which of Favorite folders can be 
displayed at one time (see picture).  

  

 

  

How to add your own folders to Favorites Folders 

You can add links to your most used folders from your specific accounts so you can quickly access 
them. 

For example, if your work email account has a folder called Invoices which you use a lot, you can 
add a copy of that folder to the Favorites Folders section so that you can quickly access it. This copy 
of the Invoices folder will automatically update when the original Invoices folder is updated, and 
vice versa. 

You can easily add account folders to your Favorites folders by dragging and dropping that folder to 
the Favorites Folder Section. Or you can right-click on the folder and select Add to Favorites from 
the context menu. 



 

How to remove folders from Favorites Folders 

You can remove an added account folder from the Favorites Folders section by right-clicking on the 
folder and selecting Remove from Favorites from the context menu. 
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About Search Folders 
Search Folders represent a smart utility that enables you to create a new folder with predefined 
rules which will filter out particular emails from the Favorite Folders. If you receive a new email that 
fulfills the rules of the search folder you created, then it will be automatically included in to the 
folder. Search folders can be also created for messages, tasks, events and contacts.  

Search folders will not show the unread message count. 

Creating a Search Folder 

You have three options how to create a search folder. You can either: 

1. click on Menu >  Edit > Find from the Menu (shortcut Ctrl + Shift + F) to access the search 
field and define the rules for a new search folder or  

2. right-click on the Search Folders section in Folder list (if you already have Search folder) and 
select New Search Folder... 

3. open the Advanced search pop-up next to the Search tab and (after setting your 
preferences) click Create Search Folder... button. 

  

 
  

When creating or editing the search folder, this window will appear. 



 

Once you select the option to create a new Search folder, you will be able to set the Search 
Folder Name which will be the name of the folder in the folder list.  

 

Adding other Fields and managing Fields 

You can add other arguments by clicking on the Choose fields button - .  

A list of the available arguments will show up, select the one you want to add. Remember that some 
fields can contain more than one value. For example in the picture (Tag) there are 2 different tags 
selected: Home and Personal- this means that the query will search emails within these 2 tags.  

Removing fields - to remove a filed simply open the 'Choose fileds' option and uncheck it. 

  

To finish the creative process of the search folder click on the Okbutton. Once the search folder is 
created, it will appear in the Email section of the Navigation Bar. Search folders can be renamed or 
deleted or editor via right-click > Properties. 
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About 'Inboxes' folder 
Inboxes is a section that contains - as the name suggests - all of your Inbox folders. 

You can show/hide Inboxes in the Menu > Settings > General > General section using the Show 
Inboxes folder option.  

If you are using any other special folders such as Favourites, Search folders or Tags, you can also 
easily right-click on one of them, move your mouse on the last option “Display” and control the 
special folders from there. Once you display Inboxes, you are going to find them in the left panel at 
the top of the folder list. 

 

How to use Inboxes? 
This feature will take the Inboxes of all your accounts in eM Client and show them under the special 
Inboxes folder. From there, you can easily access every single one of them without the need to 
scroll down through all your other folders.  

Clicking on the root Inboxes folder will display all the messages from all the inboxes together or 
you can open the one you need at the moment. 

  

This feature is similar to what the "All Inboxes" folder in Favorites does, but you don't need to 
keep an eye on which account has the new message that just came in - you can have them all 
handy, but separate so you don't mix up which message is in which account. 
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Composing Email 
You can create new emails by clicking on the New button on the toolbar. 

Notice that if you type in a contact that is paired with a Chat contact, you will be able to see 
whether this contact is online (green dot) or offline (red dot). 

  

 
  

Menu 
The roll-down menu after you click on the Menu button at the top of the email window will contain 
following options: 

  

File 

• Save - saves the message into a draft.  

• Save as - gives you to option to save the message into .eml file, .pdf or 

• Print 

• Close 

Edit 

• Undo 

• Redo 

• Cut 

• Copy 



• Paste 

• Paste as text 

• Find... 

• Replace... 

• Edit Source...  

Message 

• Send 

• Send as Mass Mail - PRO feature - sends one email per recipient, so it in result gives an 
impression that the email has been composed for each recipient separately. Inserting a 
Variable is interrelated with sending mass emails (see below). 

• Send later... - PRO feature - with this setting you can send the message at a later time. 
Just specify the time and date when you wish the message to be sent.  

• Flag 

• Tag 

• Reply to address - select from your available addresses or add a custom address 

• Request Read Receipt 

• Request Delivery Receipt 

• Format - select if the message should be in HTML or Plain text format 

• PGP Format - if the message is encrypted using PGP you can manually select if inline PGP 
or PGP/MIME should be used 

• Delete  

Insert 

• Signature   

• QuickText - QuickText enables you to insert pre-made chunks of text (for example 
snippets) to your messages within seconds. For more information see QuickText settings 
section.  

• Date and time 

• File... 

• Image... 

• Image as Link... 

• Link.... 

• Text... 

• HTML... 

• Table... 

• Symbol... 

• Line 

• Variable.. - Variable is a function that allows you to insert information that might need to 
change upon sending, such as a variable date, variable contact name etc. For example, when 
you select the variable full name, following text will appear: "{Full Name}". Now insert any 
number of recipients into the TO field, and when the email is sent, the name of each single 
recipient will appear instead of the variable. In other words {Full Name} will be displayed as 
John Doe, Alex Brown etc.  
Fallback option is there when the target field is blank or not found. For example when you 
want to greet each recipient with Hello "Given Name", add several contacts to the recipients 



line and some don't have the field "Given Name" filled in, the fallback value (for example 
"Customer") will be used instead. 

• My public PGP key 

You can insert several types of items, for example Inserting image as link will allow you to 
insert image that is uploaded on the Internet or you can Insert a table, parameters of which you 
can further specify.  

Tools 

• Spell Check Language 

• Use Automatic Spell Check 

• Check Spelling 

• Translate with Bing Translator 

Help 

• Contents 

Email Header 

To: 
Enter the recipient of this email here. 

Subject: 
Enter a basic description of the Email.  

Add Cc & Bcc:  

You can click on  button to bring up two additional lines for: 

Cc: (Copy) 

Enter the email addresses you wish to send a copy of this email to. 

Bcc: (Blind copy) 

Enter the email addresses you wish to send a blind copy of this email to. Recipients in To: and Cc: 
fields will not see this recipient, the copy is secret to all but you and the Blind copy recipient. 

Toolbar  
Components of toolbar are separated into two sections. First section concerns more with the 
elements of the message and the second part is more concerned with the editing of the message 
(Email Editor). The separation of the two sections is also indicated by the design of the email 
window itself.  

Send  

Click this button to send your email. 

In the drop-down menu you can also select to send the message as Mass mail or to Send it later, if 
you use PRO version of eM Client. 



 

Account drop-down menu 

You can choose an email account from which you want this email to be sent from (it is set to your 
default Email account by default). 

Attachment  

You can add the attachments to your email by clicking on small paperclip icon. 

Important  

Clicking this icon will set your email to be urgent . 

Signature  

Click this button to choose the signature you wish to use for the message (you can set up your 
signatures in Settings - Signatures, or you can access the signatures management window by 
choosing the Manage option from the menu). 

QuickText  

Click on this button to insert predefined QuickText of yours. For more information about how to 
create QuickText visit the QuickText settings section. 

Watch for Reply  

You can set up a notification either for when a reply to this message is received or if the recipient 
has not replied to your message in a specified amount of time. 

Sign  

Click to digitally sign your email with a security certificate so that the recipients can verify its 
authenticity. For more details refer to Signing and Encryption section. 

Encrypt  

Click to digitally encrypt the contents of your email with a security certificate saved in your 
eM Client, your system or uploaded to eM Keybook or other key lookup services. For more details 
refer to Security Certificates and how to configure security settings. 

Flag  

  



Email Editor 

 
  

Bold - The selected text will be bold. 

Italic - The selected text will be written in italic. 

Underline - The selected text will be underlined. 

Paint Format - Select certain area of the text while holding right mouse button, click on the Paint 
Format button, and then hover over different area of the text to transfer the format of the original 
text to the newly selected area. 

Font Style - click on the Font Style button to bring up following menu  

  

 
  

Ordered list - create a numbered list 

Unordered list - create a list of points 

  



 
  

Left Align - justify the text to the left. 

Center - justify the text to the center. 

Right Align- justify the text to the right. 

Justify Both Sides - justify the text on both sides 

Emoticons - add emoticons, gifs or stickers to your email. 

  

Click on the  button to bring up following additional features that could not fit in the 
toolbar: 

  



 
  

Read Receipt-Add read receipt to your email. Read receipt represents a notification that is 
delivered to you after the recipient opens your email  

Delivery Receipt- Add delivery receipt to your email. Delivery receipts confirm that the email has 
been delivered to recipient's mailbox.  



Reply to address - Set a different Reply-to address if you need the recipient to send a reply to 
different address than the one used for sending. 

Tags- Mark your email with arbitrary colorful tag. 

Save - Save the message to drafts 

Check spelling.. - Open the Check spelling window 

Print 

Format - Select Plaint text or HTML formatting for your message 

Paint Format - Copies format from selected part of the text, then you can apply it to another 
selection 

Cut - Cut a part of text to clipboard. 

Copy - Copy a part of text to clipboard. 

Paste - Paste the text from clipboard. 

Remove Format- Remove all formats from selected text.  

Undo - erase the last change done to your email.  

Redo - repeats the most recently undid action. 

Outdent - Move selected text to the left (if this text was indent before). 

Indent - Move selected text to the right. 

Left to Right 

Right to Left 

Insert Link - add a hyperlink to your email. 

Insert Image- add an image to your email. 

Insert Table - add a table to your email. 

Insert Symbol - add a symbol to your email.  

Spellcheck language - Change the spell check language 

Customize- customize the layout of your email window. 

  

Please note that you can customize what tools you want to have present on the toolbar by clicking 
on customize button from the roll down menu.  
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Reading Emails 
This is a picture of the application window. 

 
  

 In the middle section you can see your messages (in this case, these are grouped according to date 
- more on grouping here). In the default setting, you can see the contents of the selected message 
to the right of the message list. This can be changed in View > Layout  (or alternatiely Menu > 
Settings > Appearance > Layout). 

You can either have the message displayed right of the message list, on the bottom (below the 
message list) or turn the message panel off altogether. 

 
  

The message list changes from single-line layout to compact, multi-line layout if the width of the list 
is lower than the value specified in Menu >Settings in Mail section (where it can also be turned 
off). This settings panel can also be accessed by right-clicking the column header and clicking 
Customize current view. 

You can change the order of the columns in the message list, or add/remove columns by right-
clicking the column-header and choosing Columns configuration from the context menu. You 
can see more on columns here. 

  

Reading your message can start even before that though so if you do not want to use Message 
preview window on the right or below, you can do without it completely. 



 
The message list contains Avatars so you can see the sender right away, as seeing a familiar face, 
logo or any image is faster than reading the name or email address directly. 
Avatars can be easily enabled/disabled via right-click at the top of the message list and checking or 
unchecking the Show avatar setting. 
The size of the avatar can be changed in the Message list options in "Read" on page 139 Settings. 

  

You can also see the preview of the actual email text under the name and subject of the email. This 
preview can help you determine quickly which message needs to be read in full or replied to first. 
You can set the preview to contain either 1, 2 or 3 lines or disable it of you don't want to use this 
feature. 
The change can be done either via right-click at the top of the message list, Preview and then 
select the preferred option. Or you can find this in Menu > Settings >Mail > Read under 
Message list options. 

  

Email Context Menu 
If you right-click on an email, the email context menu will be displayed. You will be offered a list of 
several actions that you can execute with an email. Utilizing most of them is quite straightforward, 
however, let's hold on for a moment at the option Download Selected. If you click on this option, 
the whole email will be downloaded, including embedded content and attachments. Thus the email 
will be available to work with when you turn offline.  

  



 
  

To open a message, double-click on it in the message list - the following window will pop up: 

 



Below the section that contains the fields Subject: From: etc. you can see the attachment bar. On 
this bar, all the attachments enclosed to the email can easily be accessed. To open/save the file, 
just double click it and select from the dialog window. 

  

If you receive an email that contains pictures that are online, these will be initially blocked by the 
application, as a measure of security (to download the pictures, your computer needs to access the 
server, which is an ideal situation for any evil scripts that are waiting to gather your personal 
information. However, if you trust the webpage, you can easily un-block the content by clicking the 
appropriate button. 

  

 
  

Changing message format 
If you need to switch between the HTML and Plain text message format for a specific email (for 
example if it's unreadable in one of the formats) you can easily do so either via 
Menu>Message>Format or via right-click inside the message and use the Format selector. 

 



Changing to light mode when using Dark theme 

In the dark mode you will see a simple switch with Sun and Moon icons. Click it to switch from one 
mode to another. 
This option can be useful if the HTML of the message makes it incompatible with Dark mode or you 
need to see the message in its original colors. 

 

 

Default Action for Attachments  
You can also adjust the actions that you would like to implement with different types of files while 
downloading attachments to your computer. For example when you receive a picture (e.g. .jpg) as 
an attachment and you click on the file, you will be asked whether you want to save or open it. 
Notice the checkbox which says "Do not ask me again for the attachments with the same 
extension." If you check this box and then click on one of the actions (Open/Save) the action you 
choose will be remembered for every .jpg file you receive in future without asking. 

  



 
If you want to cancel the action that you established for a specific attachment file type, then go to 

Tools > Settings > Attachments and just click on the red cross button (on the left)  and the 
default action will be canceled. 

  

 
  



Automatic Resizing of Images 
If you receive an image attached to your email it will be automatically displayed in the bottom of 
the email preview. There is a smart utility that automatically and simultaneously resizes the 
attached image as you resize the window of the email preview. If you want to display the image in 
its original size but still keep the email preview window arbitrarily resized, then click on the arrow 
symbol which can be found in the left upper corner of the image as you can see in the picture. 

  

 
  

Move to Junk Button  

  

 
  

Move to Junk button has three options: Just move to Junk, Move to Junk and blacklist email and 
Move to Junk and blacklist domain. To perform one of those actions, you have to click on the little 
arrow on the right. 

  

Note: Remember that if you enter a Junk E-mail folder there will be Move to Inbox button which 
works in the same way as the Move to Junk button. The only difference, of course, is that you 
remove emails from Junk back to Inbox and can remove email addresses and domains from 
the Blacklist.  

  



Move to Junk: Moves the email to Junk, does not blacklist email (will not block emails from the 
sender in the future) and also does not blacklist domain. 

  

Move to Junk and blacklist email: Moves the email to Junk and blacklists the sender, but the 
domain will not be blacklisted (so for example emails from user john.black@activitycenter.com will 
not be received any more, but still some emails from the domain "@activitycenter.com" will be 
received. 

  

Move to Junk and blacklist domain: Moves the email to Junk and blacklist the domain, so you 
will not receive emails from the blacklisted domain any more.  

  

Clicking on the Move to Junk button without predefined action 

  

If you click on the Move To Junk button for the very first time or when you do not have predefined 
action for move to junk button, following window will appear:  

  

 
  

Here you can pre-define the action by ticking Don't ask me again option and selecting one of the 
tree options displayed. Since you have made the decision, selected action will be always performed. 
You can, of course, change your pre-definition in Menu> Settings > General > Confirmations. 

  

  

Removing blacklisted users from Blacklist  
If you want to remove blacklisted users from blacklist, go to Menu > Settings> Mail> Blacklist 
and Whitelist. 
You can manage local and synchronized Black and White lists here.  

  

Click Manage Blacklist and following window will appear: 

  



 
  

Click on the Delete button and the action is complete, don't forget to save the change via the 
Save & Close button. 

  

Removing Junk content via Move to Inbox button 

  
While you are browsing Junk section of your emails, you can use Move to Inbox button to restore emails 
from junk back into the Inbox.  

  

 

  

If you are restoring content which email is blacklisted you will be asked by following window 
whether you want just move it to Inbox or if you want to move it to Inbox and remove blacklisted 
email.  

  

 
  



Choose one of the two options and finish the process.  
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Inbox Categories 
This feature sorts your messages in your Inbox into separate email categories. The 
supported email categories are Personal, Promotions, Social, Updates and Forums. It is 
also possible for a message to have No Category. These categories can be synchronized 
with mail servers that support them, such as Google, which is why the names or number 
of categories cannot be changed. 

You can also organize these categories into specific tabs, such as Primary, Other, keep 
specific categories as separate tabs, or just show All. 

 

This feature is designed to help you prioritize messages in your Inbox so you can check 
just specific categories first. 

  

You can customize the default tabs for all your accounts in Menu > Settings > Mail 
>Categories section. You can also turn off/on the full feature here. Read about its options 
here. 

Automatic Categorization 
For Gmail accounts, categories are synchronized from the server while eM Client uses its 
own algorithm to sort messages for other accounts. 

If the default categorization does not fit your preference, you can manually "How to 
change a category of the given message" on page 292.  

  

If the initial categorization failed you can try to repair it via right-click on the Inbox > 
Properties > Repair tab > click Categorize messages. 



 

  

How to change the Category tabs view 
While you can set the defaults in menu > Settings > Mail > Categories you can change 
the category tabs at any time directly in the main window. 

 
Simply right-click the tabs or top of the message list and then hover over the Category 
tabs section. 
You can customize the tabs differently for a specific account or Hide Categories Bar for 
this inbox. 



 

  

How to change a category of the given message 
The easiest was to specify a new category the message should be sorted into is via right-
click on the message and then selecting Category and specifying one of the options - 
Personal, Promotions, Social, Updates, Forums or No Category. 

 

  



You can also drag and drop the message onto the desired tab, though if you use a 
combined tab such as Primary, Other or All you will need to specify which category 
should be selected. 

 

  

In both cases, a confirmation window will pop up about Category Rules that can be 
created based on this manual change. 

• The default action will create a rule to assign the same category to all future 
messages send to or received from this contact. 

• If you press and hold 'Shift' key the category will also be changed for all past 
messages sent to or received from this contact. 

• If you press and hold 'Alt' key (Windows) or 'Control' key (macOS) then the 
category is changed just for that single message and no rule is created. 

 

  

Custom rules and all category settings can be modified or removed in menu > Settings > 
Mail > Categories section. 



Note: Creating and editing rules for Google accounts is not available with Free license. 
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Conversations 
eM Client enables you to view your messages in three different conversation modes. To set 
particular conversation mode go to Menu > View > Conversations and here you will be able to 
choose from three different modes: Show Conversations in All Views, Show Conversations 
in Message Details Only, Disable Conversations.  
Below you can choose if new messages should be shown on bottom(default, that way you can 
read messages chronologically from the top to bottom) or on top (older messages are below). 

  

Lets explore the different modes one by one: 

Show Conversations in All Views: 
If you select this option you will be able to see conversations in the left panel. Every conversation 
will also display a number that indicates number of individual messages contained.  

 
  

If you click on the particular conversation all the messages contained will be displayed in the right 
panel. If there exist more unread messages in the conversation, the most up-to-date unread 
message will be selected and displayed as first. In case there is just a single unread message, it will 
be that message which will be selected and displayed. The last scenario is that all messages in 
conversation are marked as read. In such case the most up-to-date message will be displayed. Also 
note that those messages that are unread will be expanded (rest collapsed). If there are no unread 
messages then most up-to-date message will be expanded (rest collapsed). 

  

 
  

You can easily view previews of the messages in the conversation: 



 
  

You can click the message counter to show the Conversations as a Thread. Threads are a feature 
available in the Pro, Personal or Business version of the application. 

 
The Threads feature allows you to expand your conversations to get quicker recall of the context of 
conversation or to work with a particular email.  



The first item in the thread contains the avatar of the person you are talking to, subject of the 
conversation and preview of the last email. From this view you can reply to the specific email, flag it 
or just open it. 

To get more context of the conversation you can enable 2 or 3 lines message preview in Menu > 
Settings > Mail > Read > Message List section > Message preview. 

  

Show Conversations in Message Detail Only: 
If you select this option you will be able to see all inbox messages ordered according to the date of 
receiving. If you select any message in the right panel and it is included in a conversation then all 
messages from the particular conversation will be displayed. If there will be more unread messages 
in the conversation then all of them will be expanded. If all conversation messages are read the 
most up-to-date message will expand.  

 
  



Disable Conversations: 
If you select this option then conversations will not be applied and you will encounter what you 
might have been familiar with if you have been using eM Client before the version 7: in left panel 
the messages are ordered according to the Received date and what is displayed in the right panel is 
always only the selected message with the previous conversation displayed in classic textual form 
(see example below). 

  

 
  

By clicking on the little down-pointing arrow on the right, you will bring up a menu which relates to 
the displayed message only. Therefore in order to reply to, forward or otherwise interact with a 
particular message in a conversation you have to select the appropriate action from the list of this 
drop-down menu:  
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Send and Receive 
  

There are several different operations you can perform on an Email. 

  

Refresh 

Click Refresh button to download and upload new data to all your accounts - this data can be new 
messages, change of Flags or Read status, etc. 

Click on the little triangle next to Refresh to bring up following drop-down list 

 
  

Click on Send and Receive to send all your outgoing emails and check for incoming emails at the 
same time. 

Receive all  
Check your email accounts for incoming emails. You can setup a regular time to check for new 
emails under -Menu> Setting > General > General and then Synchronization. 

Send all 

After you have completed writing an email, you can send it by click the Send button. You can also 
send saved emails. 

  

  

 

Reply 

Reply an incoming email by selecting it in the main panel and clicking Reply in the mail toolbar or 
select Menu -> Message -> Reply 

Reply All 

Reply all recipients of original email.  

  

Forward 

You can forward an email by selecting it in the email list and clicking Forward in the mail toolbar 
or select Menu -> Message ->Forward 

Note that you can forward the email either as Attachement or as Original. This can be selected 
from the drop down menu: 



 
  

Mark 

Select how would you like to mark your email from the drop down menu: 

 

Follow Up 

Manually mark your email if you want to follow up on it in future.  

Mark as read 

Manually mark an email you haven't opened as read by Right-Clicking it and select Mark as read. 

Mark as unread 

Manually mark an email you have already opened as Unread (perhaps to remind yourself to read 
more carefully later) by Right-Clicking it and select Mark as unread. 

Move to Junk 

You can select from three following moves: Move to Junk, Move to Junk and blacklist email, 
Move to Junk and blacklist domain 

Delete 

You can delete an email by Right-clicking it and select Delete, or simply press the Delete button on 
your keyboard. 

Tag 

Assign tag to your email. 

  

Click on the down-pointing or up-pointing arrow to move to previous or next email, subsequently.  

  

Various functions are also displayed when you right-click on email in your inbox. Following drop-
down menu will appear, where most of the functions are already explained above and those which 
are not, are listed and explained below: 



 
  

  

Move to folder... 

You can move your emails to another folder by Right-clicking the selected email(s) and select Move 
the folder. 



 
In the mini-explorer that pops up, select an existing folder or create a new one to which you wish 
your email(s) to be moved to. 

Copy to folder... 
Same as move to folder, except a copy of the selected email(s) will also be kept in the original 
folder. 

Show mail header... 
Opens a window with the header of the selected email. 

Show mail source... 
Opens a window containing the source of the selected email. 

  

  

Copyright © 2025 eM Client s.r.o. 

Thámova 18 
 Prague, 186 00 
Czech Republic  

info@emclient.com  

  



Composing Email 
You can create new emails by clicking on the New button on the toolbar. 

Notice that if you type in a contact that is paired with a Chat contact, you will be able to see 
whether this contact is online (green dot) or offline (red dot). 

  

 
  

Menu 
The roll-down menu after you click on the Menu button at the top of the email window will contain 
following options: 

  

File 

• Save - saves the message into a draft.  

• Save as - gives you to option to save the message into .eml file, .pdf or 

• Print 

• Close 

Edit 

• Undo 

• Redo 

• Cut 

• Copy 



• Paste 

• Paste as text 

• Find... 

• Replace... 

• Edit Source...  

Message 

• Send 

• Send as Mass Mail - PRO feature - sends one email per recipient, so it in result gives an 
impression that the email has been composed for each recipient separately. Inserting a 
Variable is interrelated with sending mass emails (see below). 

• Send later... - PRO feature - with this setting you can send the message at a later time. 
Just specify the time and date when you wish the message to be sent.  

• Flag 

• Tag 

• Reply to address - select from your available addresses or add a custom address 

• Request Read Receipt 

• Request Delivery Receipt 

• Format - select if the message should be in HTML or Plain text format 

• PGP Format - if the message is encrypted using PGP you can manually select if inline PGP 
or PGP/MIME should be used 

• Delete  

Insert 

• Signature   

• QuickText - QuickText enables you to insert pre-made chunks of text (for example 
snippets) to your messages within seconds. For more information see QuickText settings 
section.  

• Date and time 

• File... 

• Image... 

• Image as Link... 

• Link.... 

• Text... 

• HTML... 

• Table... 

• Symbol... 

• Line 

• Variable.. - Variable is a function that allows you to insert information that might need to 
change upon sending, such as a variable date, variable contact name etc. For example, when 
you select the variable full name, following text will appear: "{Full Name}". Now insert any 
number of recipients into the TO field, and when the email is sent, the name of each single 
recipient will appear instead of the variable. In other words {Full Name} will be displayed as 
John Doe, Alex Brown etc.  
Fallback option is there when the target field is blank or not found. For example when you 
want to greet each recipient with Hello "Given Name", add several contacts to the recipients 



line and some don't have the field "Given Name" filled in, the fallback value (for example 
"Customer") will be used instead. 

• My public PGP key 

You can insert several types of items, for example Inserting image as link will allow you to 
insert image that is uploaded on the Internet or you can Insert a table, parameters of which you 
can further specify.  

Tools 

• Spell Check Language 

• Use Automatic Spell Check 

• Check Spelling 

• Translate with Bing Translator 

Help 

• Contents 

Email Header 

To: 
Enter the recipient of this email here. 

Subject: 
Enter a basic description of the Email.  

Add Cc & Bcc:  

You can click on  button to bring up two additional lines for: 

Cc: (Copy) 

Enter the email addresses you wish to send a copy of this email to. 

Bcc: (Blind copy) 

Enter the email addresses you wish to send a blind copy of this email to. Recipients in To: and Cc: 
fields will not see this recipient, the copy is secret to all but you and the Blind copy recipient. 

Toolbar  
Components of toolbar are separated into two sections. First section concerns more with the 
elements of the message and the second part is more concerned with the editing of the message 
(Email Editor). The separation of the two sections is also indicated by the design of the email 
window itself.  

Send  

Click this button to send your email. 

In the drop-down menu you can also select to send the message as Mass mail or to Send it later, if 
you use PRO version of eM Client. 



 

Account drop-down menu 

You can choose an email account from which you want this email to be sent from (it is set to your 
default Email account by default). 

Attachment  

You can add the attachments to your email by clicking on small paperclip icon. 

Important  

Clicking this icon will set your email to be urgent . 

Signature  

Click this button to choose the signature you wish to use for the message (you can set up your 
signatures in Settings - Signatures, or you can access the signatures management window by 
choosing the Manage option from the menu). 

QuickText  

Click on this button to insert predefined QuickText of yours. For more information about how to 
create QuickText visit the QuickText settings section. 

Watch for Reply  

You can set up a notification either for when a reply to this message is received or if the recipient 
has not replied to your message in a specified amount of time. 

Sign  

Click to digitally sign your email with a security certificate so that the recipients can verify its 
authenticity. For more details refer to Signing and Encryption section. 

Encrypt  

Click to digitally encrypt the contents of your email with a security certificate saved in your 
eM Client, your system or uploaded to eM Keybook or other key lookup services. For more details 
refer to Security Certificates and how to configure security settings. 

Flag  

  



Email Editor 

 
  

Bold - The selected text will be bold. 

Italic - The selected text will be written in italic. 

Underline - The selected text will be underlined. 

Paint Format - Select certain area of the text while holding right mouse button, click on the Paint 
Format button, and then hover over different area of the text to transfer the format of the original 
text to the newly selected area. 

Font Style - click on the Font Style button to bring up following menu  

  

 
  

Ordered list - create a numbered list 

Unordered list - create a list of points 

  



 
  

Left Align - justify the text to the left. 

Center - justify the text to the center. 

Right Align- justify the text to the right. 

Justify Both Sides - justify the text on both sides 

Emoticons - add emoticons, gifs or stickers to your email. 

  

Click on the  button to bring up following additional features that could not fit in the 
toolbar: 

  



 
  

Read Receipt-Add read receipt to your email. Read receipt represents a notification that is 
delivered to you after the recipient opens your email  

Delivery Receipt- Add delivery receipt to your email. Delivery receipts confirm that the email has 
been delivered to recipient's mailbox.  



Reply to address - Set a different Reply-to address if you need the recipient to send a reply to 
different address than the one used for sending. 

Tags- Mark your email with arbitrary colorful tag. 

Save - Save the message to drafts 

Check spelling.. - Open the Check spelling window 

Print 

Format - Select Plaint text or HTML formatting for your message 

Paint Format - Copies format from selected part of the text, then you can apply it to another 
selection 

Cut - Cut a part of text to clipboard. 

Copy - Copy a part of text to clipboard. 

Paste - Paste the text from clipboard. 

Remove Format- Remove all formats from selected text.  

Undo - erase the last change done to your email.  

Redo - repeats the most recently undid action. 

Outdent - Move selected text to the left (if this text was indent before). 

Indent - Move selected text to the right. 

Left to Right 

Right to Left 

Insert Link - add a hyperlink to your email. 

Insert Image- add an image to your email. 

Insert Table - add a table to your email. 

Insert Symbol - add a symbol to your email.  

Spellcheck language - Change the spell check language 

Customize- customize the layout of your email window. 

  

Please note that you can customize what tools you want to have present on the toolbar by clicking 
on customize button from the roll down menu.  
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Sending Email 
Once you have "Composing Email" on page 304 you naturally want to send it - the most 
straightforward way is to click the Send button in the top left corner, naturally. But there 
are some options that might make sending more interesting. 

 

  

Mass Mail - Pro feature 

This is a Pro feature, but a very useful one for sending the same email to numerous 
recipients. Simply add all your recipients or a distribution list into the To field and then 
use the Send as mass mail option - eM Client will then create a separate copy of your 
message for each contact, so they see only themselves as the sole recipient of your 
message.  
You can achieve a separate email for each recipient by using the Bcc line, but then the To 
line will need to either be left empty (ending up in "Unknown recipients" line in message 
header) or contain some kind of placeholder address, making it obvious that the email 
was not sent just to this person. 
 
You can find the Mass Mail option under the Send button or via Menu > Message > 
Send as Mass Mail in the new message window. 

If you use any Variables  (Right-click > Insert > Variable) for details saved in your 
Contacts, they will be filled in accordingly for each recipient. 

Send later 

This Pro feature can be useful for scheduling your messages for specific time. This can be 
helpful when communicating overseas or if you want your message to arrive at a specific 
time in the morning or evening to get full attention from the recipient. 
You can use this from the Send button drop-down menu, via Menu > Message > Send 
later... or you can set a default Send later time in Menu > Settings > Mail > Send which 
you can find here in the "Send" on page 148 settings. Setting a default delayed send is a 
Pro feature. 

  



Other Sending features 
There are also few features that can help with sending your messages that are not part of 
the compose window. 

Undo Send - Pro feature 

Setting for this feature can also be found in Menu > Settings > Mail > Send. This 
feature allows you to hit Undo(in a Message has been sent pop-up at the bottom of your 
message list) once you have sent your message and realized there was something wrong - 
either a typo, missing attachment or detail or even a wrong recipient. This feature can be 
set to wait for 3, 5 or 10 seconds until actually sending your message, so you can get it 
back to drafts and edit it if needed, and send it again, without any mistakes. 

 

Resend 

This feature can be used to quickly send your message again, as is, with all the details, 
attachments and recipient. Find it under the Forward drop-down options in the top 
toolbar or via right-click on the sent message itself. You can also use the shortcut Ctrl + 
Alt + R. 

Copyright © 2025 eM Client s.r.o. 

Thámova 18 
 Prague, 186 00 
Czech Republic  

info@emclient.com  



Generative Artificial Intelligence 
eM Client provides features for composing emails with the help of text generation and editing made 
by Artificial Intelligence, also called AI. 

The feature requires an AI Add-on to work, as using the AI features uses up Tokens. 

  

The AI features are located in two places at this time: 

• AI button in compose window   

• Reply with AI option in the Reply button drop-down 

 

 AI in compose window 

In the compose window you can click the AI button to generate or edit text. 

The AI window contains several parts. The toolbar with available actions, Instructions for 
AI field and Generated text. 
 

 
  

Toolbar 

The toolbar contains several buttons to help you customize the outcome of your query to the AI 
server. 

  



Accept & Close button  

Once you have a Generated text in the lower part of the window, this button will move the text 
over to the Compose window, where you can manually edit it or hit send! 

  

Generate text   

 
These are the main options to specify what to do with the given text or query. If you have written 
nothing yet, you woukd 

• Generate text - this default option will just generate text based on the written prompt or 
original email with no other specified length or style. 

• Shorten - make the inserted text shorter, simplify the text so it can be said in less words. 

• Lengthen - expand the text into more words and sentences. 

• Summarize - summarize a longer text so the information is presented in a more concise 
manner. 

• Proofread - check your text for typos and grammatical errors. 

• Rephrase - use different words and synonyms to phrase the given text differently. 

• Rewrite in first person - provided text is rewritten to be in first person, as if you directly 
wrote it. 

• Translate - translate into a selected language in Options. 

  

 

Start button sends the prompt to the server to perform the AI text generation or editing you 
indicated. 

  



 

Options contains additional options for customizing the final text for length, tone and language. 

• Short    

• Medium 

• Long 

————————— 

• Friendly 

• Formal 

• Strict 

————————— 

• Language - select a language to write the text in or translate into, the default is your 
application language set in General > Language settings. 

  

Instructions for AI  
This field is for the text prompt sent to the server - it can be text you type in or if you selected the 
previous reply or text in the compose window, it will be included here. 

Generated text  
The result from the AI server will be shown here. You can still change your prompt in Instructions 
for AI field and run the AI again to have the AI server change the text. Once you are happy with the 
text or want to do any further changes manually, simply press the Accept & Close button - that 
will take you back to the compose window where you can either edit the text yourself or send it out. 

  

  

Reply with AI 

The reply with AI option will take the received message and analyze the content, drafting a 
message for your based on the context and the type of message you specify. The message will be 
opened in a Compose window with the pre-filled text.  

If you just click the Reply with AI button, the program will generate a neutral response based on 
the original text. If you use one of the drop-down options, the reply will be customized based on 
your selection. 



 
  

• Reply - the default option, reply is made based on the original text only. 

• Thank you - a reply that includes a thank you to the sender. 

• Not interested - a generic reply specifying you are not interested in the proposed topic or 
offered product. 

• Maybe next time - a reply will indicate you are not interested in offered topic right 
now, but might be interested in future emails. 

• Never - a reply will indicate you are not interested in offered topic and never want to 
hear about it again. 

• Tell me more - a reply indicating you are interested in hearing more. 

• Interested - a reply that will indicate you are interested in hearing more about the 
proposed topic. 

• Not sure - a reply indicating you are not sure if you want to know more or not. 

• Resolve with someone else - this will draft a reply with the context that the message 
needs to be resolved by someone else - you will need to edit the final reply yourself to 
include who. 

  

The generated response will pop up in a Compose window, so you can still make any additional 
changes and check the text before clicking Send. 
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About Cloud Attachments 
Cloud attachments are attached files uploaded to a cloud storage service, so instead of 
sending the file directly, you are only sending a link to the given file to the recipient, 
which he can then use to download the file from the Cloud server. This way the message 
you are sending is much smaller in size and this can be especially useful when sending a 
large files or a big amount of files. 
Linked attachments have also a number of other perks - since you have instant access to 
your cloud storage you can update or remove the file at any time. You can also protect 
your file with a password or set an expiration date. This gives you better control over 
your data and makes sending files safer overall. 

  

eM Client currently supports these cloud storage providers: 

• OneDrive 
• Google Drive 
• DropBox 
• OwnCloud 
• Nextcloud 
• vBoxxCloud 
• LeitzCloud 

  

You can set up your preferred Cloud Providers in Attachments settings and read about 
using Cloud attachments in your messages. 
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large files or a big amount of files. 
Linked attachments have also a number of other perks - since you have instant access to 
your cloud storage you can update or remove the file at any time. You can also protect 
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eM Client currently supports these cloud storage providers: 

• OneDrive 
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using Cloud attachments in your messages. 
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Using Cloud Attachments 
eM Client currently supports these cloud storage providers: 

• OneDrive 
• Google Drive 
• DropBox 
• OwnCloud 
• Nextcloud 
• vBoxxCloud 
• LeitzCloud 

Depending on the setup and capabilities of each provider, you will have different options 
for what you can do with the cloud storage attachment, by right-clicking it and selecting 
from the context menu. Some options are only enabled from a certain provider if you 
have a subscription to that cloud storage service. These options are available at the 
providers’ discretion. 

  

Add a Cloud Attachment 
To attach a file from your cloud storage as a link, first click the Attachment button the 
same way you would attach files normally. 

 

Then go to a cloud folder set on your device and choose a file you wish to add to your 
email as a link. 

Tip: Remember that you first need to download the cloud storage provider’s application 
on your computer and add it to eM Client 



 

  

A dialogue box will open, giving you a choice to link the file instead of physically 
attaching it. To link the file, click 'Yes'. 

 

Additionally, the option to attach the files uploaded to cloud storages only as links can be 
set as default behavior by clicking the box for Don’t ask me again. This default can be 
managed in Menu > Settings > Mail > Compose > Cloud Storage Attachments 

The credentials of your cloud storage account are required to proceed the first time. The 
password can be saved and remembered. Depending on the selected service, the login 
will appear differently. 

  

Upload attachment to a Cloud Storage 
You can also first add your attachment and then upload it to the set up cloud service via 
the right-click option Upload to cloud storage.  



 

Attachment options before upload 

  

After the file is uploaded to your prefered Cloud storage you also get a number of other 
options, namely Setting a password, Setting an expiration date for your download link 
and Allowing editing for text files. 

 

Attachment options after upload 

Open attachment 

This option is always available for all attachments, regardless of whether they are locally 
attached or attached with a cloud service. It opens the attached file, in case you want to 
check it one more time before sending the email. 



Send as a cloud storage link 

This will send the attachment as a link via your selected cloud service, instead of a 
locally attached file. Unchecking this option will revert the attachment back to being 
locally attached. 

Set password 

Available for Dropbox, Nextcloud, OneDrive, OwnCloud. 

This will enable you to set a password to protect the linked attachment. This ensures that 
no one except the intended recipient who knows the password can open the attachment 
link. There’s no way to recover this password if you forget it, but you can just send the 
same file again with a new password (or without one). 

 

  

Set expiration date 

Available for Dropbox, Nextcloud, OneDrive , OwnCloud. 

This option allows you to set an expiration date for the attachment link. After this date 
and time has passed, the recipient will no longer be able to access the file from the link in 
your email. 

Allow editing 

Toggle between read only and editable mode for documents of supported editable file 
types (for .rtf, .doc, .docx, .xls, .xlsx, .ppt, and .pptx files) 

The remaining options are always available for all attachments, regardless of whether 
they are locally attached or attached with a cloud service 

Save As 

It allows you to save the file on your computer. 



Copy 

This copies the attached file so you can paste it. 

Remove 

Removes the attachment 

Select All 

Selects all the attachments instead of just a single one. 

Save All Attachments 

It allows you to save all the attached files on your computer. 

Open All Attachments 

It opens all the attached files 
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Rules 
In this day and age, email has overtaken the copy machine, the notice board, and memo slips to 
become the main mode of communication in the corporate environment. With various departments 
passing on orders, counter requests, and memos, the daily email traffic in a large company can 
easily run into the hundreds. Or if you are a person like me, that has interactions with my Facebook 
friends, bosses, colleagues and parents all converging in my Inbox, then you would need something 
to help compartmentalize your emails. You would need Rule based filtering. 

  

Rules are special logical statements that can be used as guidelines for the application to separate 
your incoming emails into different groups. For instance you can make a rule like "All emails from 
your friend Bob go to a special folder called 'Bob's emails'" or "All emails from the accounting 
department with the Keyword 'weekly report' in the subject to go to the folder 'weekly accounting 
report.'" All you have to do is to make those two rules and apply them, and all the emails from Bob 
and all weekly accounting reports will be taken out of your Inbox and put into their respective 
folders. 

  

You can create and manage your rules by selecting Menu > Rules... 

You can make a new rule, modify or remove the existing ones. You can also change the priority of 
rules and apply rules... 

  

In the window you can see a list of your rules, their names, when they are to be invoked and on 
which accounts. 

  

 
  

There are two types of Rules in eM Client: Local and Server-side rules. 

  

Local rules 

Local rules are only applied when eM Client is running, and the changes are only synced to the 
server once eM Client is connected to the internet.  

Therefore, if you set up a local rule "After a message has been received from 
bob@example.com, move to folder "Bob's emails" then this rule will only be applied once you 
check your email in eM Client. It will not be applied if the eM Client application is closed and you 
check your email via webmail instead. Local rules are usually applied directly after an email has 
been received/sent, but you can apply Local rules to old emails at any time in eM Client by clicking 



the Apply button within the rules window, or by right-clicking an email folder and selecting “Apply 
rule”. 

  

There is a pre-made Local rule in eM Client, Spam filter - This is the default SPAM filtering rule 
that takes suspicious messages and moves them to a Junk folder. This rule cannot be altered but 
can be turned off. 

  

Server-side rules 

Currently available for Exchange/Office 365, IceWarp and Google/Gmail mail servers 

Server side rules are applied directly on the mail server. This means that the server rules you create 
in eM Client will show up and be applied in other places where you check the email, such as webmail 
or your phone. The available rule creation templates are fewer for server side rules (such as not 
being able to set a rule for when an email is sent) because of the limitations of the providers’ APIs. 
Additionally, there are some rule conditions available from servers that aren’t supported yet by eM 
Client’s UI. This doesn’t mean that the rule won’t be applied, it just means that you won’t be able to 
edit the conditions of that rule within eM Client. Finally, it’s important to know that server side rules 
are only applied on incoming messages. It’s not possible to apply a server side rule on old messages 
within eM Client. Running server rules on old messages must be done within your webmail. 

You can switch between your lists of Local and Server side rules (if available) by clicking on the 
drop-down menu next to the + New rule button. If this drop-down menu isn’t available, that means 
that you haven’t added a mail account which supports server side rules in eM Client. 

 
  

Edit rules 

You can edit rules by selecting the rule and clicking the Edit button. The edit window is the same as 
the rule creation window you see when you create new rules - you can define conditions, actions 
and exceptions. 

Duplicate rules 

Use the Duplicate button to create a copy of an existing rule. This can be helpful when creating a 
lot of similar rules - perhaps you just need to change who the rule is from or where to move it. This 
way you can create copies quickly and then just tweak the details. 

You can also use Ctrl + C keyboard shortcut to copy a certain rule and then Ctrl + V to paste the 
copy of the rule - this can be used for copying rules among different account rules. 



Delete rules 

Removing the rules is quite easy - just select the rule from the list and click Delete. 

Change priority of rules 

Just select the rule in the list and click  Move up or Move down. 
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department with the Keyword 'weekly report' in the subject to go to the folder 'weekly accounting 
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In the window you can see a list of your rules, their names, when they are to be invoked and on 
which accounts. 

  

 
  

There are two types of Rules in eM Client: Local and Server-side rules. 

  

Local rules 

Local rules are only applied when eM Client is running, and the changes are only synced to the 
server once eM Client is connected to the internet.  

Therefore, if you set up a local rule "After a message has been received from 
bob@example.com, move to folder "Bob's emails" then this rule will only be applied once you 
check your email in eM Client. It will not be applied if the eM Client application is closed and you 
check your email via webmail instead. Local rules are usually applied directly after an email has 
been received/sent, but you can apply Local rules to old emails at any time in eM Client by clicking 



the Apply button within the rules window, or by right-clicking an email folder and selecting “Apply 
rule”. 

  

There is a pre-made Local rule in eM Client, Spam filter - This is the default SPAM filtering rule 
that takes suspicious messages and moves them to a Junk folder. This rule cannot be altered but 
can be turned off. 

  

Server-side rules 

Currently available for Exchange/Office 365, IceWarp and Google/Gmail mail servers 

Server side rules are applied directly on the mail server. This means that the server rules you create 
in eM Client will show up and be applied in other places where you check the email, such as webmail 
or your phone. The available rule creation templates are fewer for server side rules (such as not 
being able to set a rule for when an email is sent) because of the limitations of the providers’ APIs. 
Additionally, there are some rule conditions available from servers that aren’t supported yet by eM 
Client’s UI. This doesn’t mean that the rule won’t be applied, it just means that you won’t be able to 
edit the conditions of that rule within eM Client. Finally, it’s important to know that server side rules 
are only applied on incoming messages. It’s not possible to apply a server side rule on old messages 
within eM Client. Running server rules on old messages must be done within your webmail. 

You can switch between your lists of Local and Server side rules (if available) by clicking on the 
drop-down menu next to the + New rule button. If this drop-down menu isn’t available, that means 
that you haven’t added a mail account which supports server side rules in eM Client. 

 
  

Edit rules 

You can edit rules by selecting the rule and clicking the Edit button. The edit window is the same as 
the rule creation window you see when you create new rules - you can define conditions, actions 
and exceptions. 

Duplicate rules 

Use the Duplicate button to create a copy of an existing rule. This can be helpful when creating a 
lot of similar rules - perhaps you just need to change who the rule is from or where to move it. This 
way you can create copies quickly and then just tweak the details. 

You can also use Ctrl + C keyboard shortcut to copy a certain rule and then Ctrl + V to paste the 
copy of the rule - this can be used for copying rules among different account rules. 



Delete rules 

Removing the rules is quite easy - just select the rule from the list and click Delete. 

Change priority of rules 

Just select the rule in the list and click  Move up or Move down. 
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New rule 
  

A rule is made up of four parts: invocation condition, condition, action and exception. 

Invocation Condition: whether the rule is to be invoked when mail is received or when a mail is 
sent. Click on the underlined word received to change the condition of invocation. 

Condition: logical conditions which when met will trigger the rule. 

Action: action to be taken on the messages fitting the rule. 

Exception: conditions that act as exceptions to the rule. 

  

Basic rules 
There are seven basic types of rules that you can modify to suit your needs. Some rule templates 
are only available for Local rules: 

1. Move message from someone to a folder 

 
  

With keywords: received, people, folder. Click on each keyword to define when (received) a rule is 
applied, from whom (people) the email comes, and to which folder you wish the emails to be moved 
to. 



  

2. Move message with defined words in subject to a folder 

With keywords: received, words, folder. Click on each keyword to define when (received) a rule is 
applied, containing which wordsin subject, and to which folder you wish the emails to be moved to. 

  

3. Move message with defined words in body to a folder 

With keywords: received, words, folder. Click on each keyword to define when (received) a rule is 
applied, containing which wordsin message body, and to which folder you wish the emails to be 
moved to. 

  

4. Move spam messages to Spam folder (Local rule only) 

With keywords: received, X-Spam-Status: Yes, X-Spam: yes, Junk E-mail 

  

5. Set tag for message from somebody (Not available for IceWarp) 

With keywords: received, from, tag. Click on each keyword to define when (received) a rule is 
applied, from which senders (from people) and which tag is to be assigned to all such 
messages. 

  

6. Apply custom rule on message I receive 

Using this template you can customize a rule that will apply to received messages. Check the 
conditions and exceptions you would like to include in your rule and then specify the values by 
clicking on the underlined blue text. 

  

7. Apply custom rule on message I send (Local rule only) 

Using this template you can customize a rule that will apply to sent messages. Check the 
conditions and exceptions you would like to include in your rule and then specify the values by 
clicking on the underlined blue text. 

  

  

Additional Conditions 

Click next to proceed to the rule customization window. Here you can add additional conditions to 
your rule. Rules are made up of keywords and you can combine these keywords to form arbitrarily 
complex rules by checking the conditions you need from the list, and clicking on the underlined 
words in Rule preview to specify the parameters. 

  



 
  

Available rule components include: 

• with words found in subject  - specify word or sentences that need to be found in 
the subject line  

• from people - specify who the message is from, the sender of the message 

• processed with account - this way you can set the account on which the rule should 
be applied, if it should be just one specific account and not all accounts 

• sent only to me - you are the sole recipient of the message, no other recipients in the 
To or Cc fields or group messages 

• my name is in the To field - one of your accounts/email addresses is in the To field 

• my name is in the Cc field - one of your accounts/email addresses is in the Cc field 

• my name is in the To or Cc field - one of your accounts/email addresses is in the To 
or Cc field 

• my name is not in the To field - the message is not addressed directly to you, which 
can be a blind copy or group message 

• sent to people - sent to specific people/email addresses 

• with words found in body - specify word or sentences that need to be found in the 
message body  



• with words found in body or subject - specify word or sentences that need to be 
found in the subject line or message body 

• with words found in header - specify words that need to be found in message 
headers - header words must be specified as "Name: Value" pair, which means you 
need to include the name of the header, and then the word you're searching for, ex. 
From: John 

• with size in specified limits - minimum and maximum size of the message 

• has attachment - contains any attached file 

• has tag - a specific tag is assigned 

• is invitation - the message contains an ICS attachment that is an invitation to an 
event 

  

When using the from people condition you can set the full email address, just the domain or any 
smaller part of it using these options: 

• Exact match - the full email address needs to match the address you filled in 

• Domain - the part of the email address after @ symbol 

• Contains - any part of the email address (before or after @) contains this word 

• Starts with - the searched word you fill in needs to be at the beginning of the email 
address 

• Ends with - the searched word you fill in needs to be at the end of the email address 

• Wildcard - use special character * to indicate where the email address might change, this 
place then can be filled in with any number of characters (including none) 
For example test*@domain.com will cover email addresses test@domain.com, 
test2@domain.com, test.name.surname@domain.com and many others. 

 



Actions 

Click Next to define the actions to be taken for this rule: 

  

 
  

• move to folder 

• copy to folder 

• delete mail 

• permanently delete mail 

• archive 

• move to junk 

• forward to people 

• forward to people as attachment 

• mark message as read 

• mark as flagged 

• stop processing other rules 

• set tags 



• remove tags 

• skip notification 

• expand folder when message is moved to the folder 

• add note 

  

Exceptions 

Click on the button Next to define exceptions for the rule: 

  

 
  

• except with words found in subject 

• except from people 

• except when sent only to me 

• except when my name is in the To field 

• except when my name is in the Cc field 

• except when my name is in the To or Cc field 



• except my name is not in the To field 

• except when sent to people 

• except with words found in body 

• except with words found in body or subject 

• except with words found in header 

• except with size in specified limits 

• except when the message has attachment 

Finally, click Next to give the rule a name and select whether you wish to enable the rule right 
away. Click Finish and save your new rule. 
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Apply rule 
Only Local rules and IceWarp can be applied manually, since eM Client might not have the same 
conditions or actions are other mail servers. 

When you select Apply  button in the Rules explorer window, you will be prompted to 
specify the rule and the folder on which to apply the rule: 

  

 
  

Select folder(s) by clicking on Select folder(s): 



 
  

Click on Run to execute the rule on the selected folders. 

  

You can also apply rule by right-clicking on particular folder and selecting Apply Rule... from the 
context menu.  

Just as you can see in the picture.  
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Automatic Replies 
Automatic replies, also called Vacation responder or Out of office messages is a feature which 
enables you to set a message which will be automatically sent as a reply to any received email 
within a set timeframe. 

This feature can be accessed in Menu > Tools > Automatic replies. 

 
  

You can then select an account in the Account: drop down menu. 

  



 
  

Enabled: check this option to enable the automatic replies and uncheck when you want to turn the 
feature off 

First day: Set a first day when the replies start being sent  

Last day: Set a last day on which the messages are to be sent 

Target: 

All 

Only to my contacts 

Subject: You can set a custom Subject line to your Automatic reply 

Message: Content of the Automatic reply, usually to explain reason of your unavailability. We also 
suggest including a day of your return, so the recipients know not to contact you again before 
you're back. 

  



This feature is currently available only for users with Gmail accounts, IceWarp accounts and 
accounts which use Exchange Web Services protocol. 

  



Mail Forwarder 
  

This feature can be accessed in Menu > Tools > Mail Forwarder and is currently only available for 
IceWarp accounts. 

 
  

You can then select an account in the Account: drop down menu. 



 
  

Forwards all email to: The email address your messages should be forwarded to 

Do not forward spam: Check this option so that messages marked as spam on the server are 
not forwarded 
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Watch for Reply 
This feature is available only to the Pro license users. 

  

The Watch for reply feature is a new button available in the toolbar of the New message window. If 
you expect a reply for an important email you can set up a special reminder in eM Client thanks to 
this option. 

You can either get a reminder for when such a reply is received to draw your attention to it, or you 
can get reminded after a specific time frame that your message was not replied to, so you can 
reach out to the recipient again. 

After you enable Watch for Reply, a copy of the message will be saved in a special Favorite folder 
called Unreplied, so you can check which replies you're waiting for at any time. 

You can also disable the reminder from this folder, should the recipient reach out to you via other 
means and the reminder if no longer needed. 

Watch for reply flags can be synchronized with Exchange and compatible IMAP servers, so you can 
be reminded of your messages at the correct time on any device. 

  

 
  

How to enable Watch for Reply 
While composing a message 

Click on the eye icon and select if you want to be notified when the recipient has replied, or hasn’t 
replied within a certain amount of time. 



 
  

After sending a message 

Go to your Sent folder and right-click on an email you’ve sent. Select Watch for Reply select if you 
want to be notified when the recipient has replied, or hasn’t replied within a certain amount of time. 

  

Please note that the Watch for Reply option will not be available if you’ve already received a reply to 
the email. 
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Snooze 
This feature is available only to the Pro license users. 

  

The Snooze feature is a powerful productivity tool that allows you to temporarily remove emails 
from your Inbox when you don’t have time to respond to them. When an email has been snoozed 
within eM Client, a copy of the message will be saved in a special Favorite folder called Snoozed, so 
you can check which emails you’ve postponed replying to at any time and see until when the 
message is scheduled to be snoozed. You can also disable the reminder from this folder, if you find 
time to reply to the snoozed email sooner than expected and the reminder if no longer needed. 
Snooze flags can be synchronized with Exchange and compatible IMAP servers, so you can have 
your messages snoozed and returned at the correct time on any device. 

  

 
  

Once the Snooze timer is finished, the message will reappear back in your Inbox like a normal 
incoming email, except it will have some indication that you snoozed it, such as a bell icon or a 
different color for the time. You can then choose to leave it in the Inbox and finally reply to it, or 
snooze it again. 

 
  



How to Snooze and email 
Right-click the message and pick the option for Snooze and then select until when the message 
should be snoozed for. 

 
  

Or click the Snooze option from the Main Toolbar at the top of the page. Unless you pick a specific 
time, the default snooze will be until tomorrow at 9:00 am 

 
  

How to unsnooze an email 
Go to the Snoozed folder under Favorites, right-click the message and pick the option for Snooze > 
Unsnooze 

Or click the Unsnooze option from the Main Toolbar at the top of the page. 
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Notes for Emails 
This feature is available only to the Pro license users. 

  

The Notes for emails feature is a powerful productivity tool that allows you to add a local note to 
an email. This does not change the email itself but you can mark down things you need to send a 
reply later or mark down important details from the email so you have them handy without having 
to read through the whole email thread again.  

  

How to add or edit a Note for email 
There are multiple ways of how to add a Note to email.  

One of them is to right-click on the message and select “Add note” from the context menu. It will 
open an empty form where you can write your note and save it by clicking on “Ok”.  

 
  

In the message detail, under the recipient, you will then see the notebook icon, the text of the note 
as well as the “Edit” button.  

 
Clicking on the edit button allows you to freely edit your note anytime you want.  

  

The “Add note” option is available in every context menu referring to the specific email. 
Additionally, you can add the toolbar button “Add note” to the main toolbar (right-click on the main 



toolbar, select Customize, locate the “Add note” line in the “Available items” and add it to the 
“Items to show” column). The “Add note” button will be changed to the “Edit note” button once 
a note is added. 

 

Add Note in toolbar 

 

Edit Note in toolbar 

  

Not for email location 

As mentioned, the note will appear in the message detail, under the recipient. But it is also visible in 
the message list.  

If you are using the Compact layout, in the right side of the message, there is going to be the 
same notebook icon. Hovering your mouse above the icon will show you the note text preview.  

If you are using the Single line layout, the notebook icon is visible next to the Subject or in its own 
column called “Notes”. The note will also be visible in the separate mail window or mail preview 
from the right sidebar (Contact Details or Agenda), in the same location as in the message detail, 
under the recipient.  

Please know that all the notes you add are locally saved in your database. That means they are not 
synchronized to the server and across multiple devices. 

  

How to remove a Note from email 
To remove the note simply click the Edit or Edit Note button/option in drop-down menu and remove 
all text (if the note is long, simply press Ctrl+A shortcut to select all and then Delete). Click OK 
and the note will be removed. 
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PGP 
Pretty Good Privacy or PGP is a public key encryption program that has become the most popular 
standard for email encryption - it follows the OpenPGP standard (RFC 4880) for encrypting and 
decrypting data. 

Pretty Good Privacy uses a variation of the public key system- each user has an encryption key that 
is publicly known and a private key that is known only to that user. To send encrypted messages 
you need the public key of your recipient. To decrypt a message sent to you, you will use your 
private key to decrypt it. 

  

To explain how sending/receiving such encrypted message works, let's set and example with two 
users, Jerry and Clara: 

  

• Jerry generates a PGP keypair for his email directly in eM Client and selects his passphrase 

• Jerry sends the public part of his keypair to Clara 

 
  



 
  

• Clara receives Jerry's email with his public key and is asked if she wants to import Jerry's key 
to eM Client 

 
  

  

Clara import the key and from now on, she can send Jerry encrypted emails. 

• She composes a new email. 

• Adds Jerry to recipients. 

• Clicks on the encrypt icon in toolbar, which is available because she has her own keypair 
setup. 

• And sends the message 

  



 
  

• The message is sent through the internet completely encrypted, and only Jerry is able to 
read it 

• Jerry receives the encrypted email, types the right password and is able to read the message 

 



 
  

Find more instructions on creating keys and managing them in the Certificates and Keys section. 
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Spell-checker and Translator 
This product comes with a build-in spell checker that will enable you to make sure that there are no 
typos or mistakes in your emails. The spell-checker is turned off by default and it can be turned on 
in Menu > Settings > General > Spell-Checker (see here). 

You can also access spell-checker settings in the message composition window - in Tools. 

  

 
  

You can either choose to use automatic spell check (the system language will be used), or select the 
language manually from the list. The spell-checker works pretty much in the same way that you are 
used to (from MS Word etc.). It will underline the words that do not match its dictionary. By right-
clicking the underlined word, you access a list of suggestions and you can also choose to add the 
word into the dictionary to avoid its being underlined again and again. To save time you can click on 
Check Spelling in Tools, the following window will pop up: 

  



 
  

Translator 

This product allows you to translate your messages from and to a number of languages by 
using Bing Translator. This function is accessible from the Tools menu in the message window. 

  

 



  

If you click on Translate, following window will appear: 

  

 

  

First you need to specify the source language (by default, the auto-detect function is turned on). 
Then specify the target language by selecting destination language and then click Translate - and 
the process of translation will execute automatically as you can see on illustrative example bellow. 
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What is Archiving? 
Email archiving is the process of removing emails from your Inbox to be stored in a separate, yet 
easily accessible location. 

There are two types of Archiving within eM Client. The first type is server-side (manual) 
Archiving which moves your messages to a newly created Archive folder within your email account 
or in a Gmail account, the messages are stripped of their labels and moved to the All Mail folder. 
The messages are still saved to your account, but they no longer appear in your Inbox.  

This type of archiving is for IMAP and Exchange (EWS) accounts. 

  

The second type of archiving is Automatic (local) Archiving. For this type of archiving, older 
messages are automatically periodically removed from your email accounts, and placed into a Local 
Folder within eM Client. This means that the archived messages will no longer sync with your 
account and will only be locally available within eM Client.  

This type of archiving is good for people with a small amount of storage available in their email 
server. 

  

Server-side Archiving 

Simply click on the Archive button in the toolbar , or right-click the message and 
select Move to Archive. 



 
The messages will be moved to an Archive Folder within your account. If you’re using IMAP or EWS 
protocol, this archive folder will also be synced to your other devices where you check your email. 
The only exception to this rule are Gmail and Google Workspace accounts. 

  

Gmail Archiving 

We support the native Gmail Archive function. This is a specific function which removes the 'Inbox' 
label from a message in Inbox, leaving the message accessible in the 'All Mail' folder. 

You can read about Gmail's native archiving and what it means on Google support. 

  

Local Automatic Archiving 

eM Client contains an Automatic Archiving feature which allows you to download all messages 
older than a selected number of days from the server and keep them stored on your local drive. 

You can find this option under Menu > Settings > Mail > Automatic Archiving. Make sure to set 
Archiving scope under Account Preferences before you enable or perform archiving. With the 

https://support.google.com/mail/answer/6576


archiving scope, you set what folders and accounts the archiving will be performed on. You can then 
set how often the archiving will be made and how old the messages affected must be. 

 
  

The messages are moved to a locally stored Archive Folder. 
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About Contacts 
The Contacts section is where you store your most valuable asset, your contacts. 

Here you can store both contacts from your Email correspondence as well as those from your 
instant messaging networks. You can pair the two kinds of contacts to create a centralized contacts 
list for your quick access. 

Find out more about creating new contacts, managing your contacts, and our Contact Avatar 
downloading. 

  

Copyright © 2025 eM Client s.r.o. 

Thámova 18 
 Prague, 186 00 
Czech Republic  

info@emclient.com  



About Contacts 
The Contacts section is where you store your most valuable asset, your contacts. 

Here you can store both contacts from your Email correspondence as well as those from your 
instant messaging networks. You can pair the two kinds of contacts to create a centralized contacts 
list for your quick access. 

Find out more about creating new contacts, managing your contacts, and our Contact Avatar 
downloading. 

  

Copyright © 2025 eM Client s.r.o. 

Thámova 18 
 Prague, 186 00 
Czech Republic  

info@emclient.com  



New Contact 
There are three ways to add a new contact. 

 The first is to click on the arrow button New and select Contact... 

 

And the second way is to right-click on the Contacts panel, then select New Contact. 

 
The third is to click on the top line in one of the List views (the line is separated by thick line, see 
screen shot bellow), fill in required fields and press enter. This feature is available in any list view, 
for example in Tasks and Agenda. 



 
  

New Contact window 

 
  

Overview tab:  
You can set full name of the contact by clicking on the button Full Name...This window will show: 



 
  

You can fill the boxes with information about your contact.  

  

Company: 
Enter the name of the company this contact works for. 

Tag: 
Assign particular tag to your contact. 

Job title: 
Enter the contact's job position E.g. Financial Consultant. 

File as: 
Enter a name you wish the contact to be shown in your contact list, doesn't necessarily have to be 
his or her full name. For example feel free to file your new contact under his nickname.  

Email 
You can enter up to three different email addresses for the contact by clicking on the Add Email 
button (the cross sign) 

 
  

Display as: 

you can bring up Display as option via right-click on the email field and clicking "Show Display 
As". 

  



 
  

The display name for the contact's email addresses can provide a way to identify the Email in case 
the email address does not contain any distinguishing identifiers or your personal preferences. 

  

 
  

  

Phone numbers 

Many types of phone numbers can be filled. You can for example add phone numbers for Work, 
Home, Fax, Mobile but also select among many other types. 

 
  



Add Chat: 
You can add several types of Chat to the contact: jabber, ICQ etc. Click on the button Add Chat to 
bring up following window:  

  

 
  

click on the down-pointing arrow in the Chat service to bring up following roll-down menu which 
displays full list of available Chats to add contact to: 

  
  

Add Webpage:  
If a contact has a personal web site, you can enter it here by clicking on the Add Webpage button 
(Cross sign). 

  

Add Address: 
You can change the type of address by clicking on the Add Address button and selecting from 
custom fields provided: 



 
  

Attachments and Browse files: 
  

Like with Events and Tasks, you can attach files to your Contact profiles. 

 
Click on Browse files... to add any files relevant to this contact. Any image, power point, document 
files that are related to the person or his work can be added here. 

Details Tab 

The details tab is where you can store all the professional and personal details about the particular 
contact. 

 
Most of the fields in the General tab of contact are straightforward (full name, company, tag etc.) 
However, note the option at the very bottom, where you can easily change the folder for a 



particular contact. If you do so, the contact will be automatically moved to the desired folder. This 
utility works also for editing Tasks and Contacts. 

  

Also note that the fields present in the picture (File as, Nickname, Birthday etc.) are the default 
ones and you can easily customize the Contact Details tab by adding more of them. Simply click on 
Add Personal Details to bring up following window: 

  

 
  

or on Add Business Details to bring up following window: 

  

 
Most of the additional fields are self-explanatory, however following tags are worth mentioning: 

  

Freebusy URL: Part of calendar service. Can contain the contact's daily schedules, helpful when 
arranging events with this contact. 



Calendar URI & Calendar Request URI: These are web locations to which calendar requests are sent. 
This is handled automatically, only in rare cases need to be filled in manually. 
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Distribution List 
  

eM Client enables you to create so called distribution list, which is basically a list that can contain 
any number of contacts. Once you have created the distribution list, you can use it by filling in its 
name in to the recipient field, while you are writing a new message, and the message will then be 
simply sent to all contacts that are contained in the particular distribution list. To create a 
distribution list click on New > DistributionList and the following window will appear.  

  

 
  

At the top you have the toolbar with 

 
Save & Close button to save any changes 

Account/Folder selection - you will be able to select a folder in which you wish your distribution list 
to be located.  

Add member button - click to add an email address manually or open list of your contacts to select 
from them 



 
Check any number of contacts and then click on the OK button.  

Once you have selected some contacts they will be displayed in the in the central field of the 
Distribution List window. 

  

In the List name, fill in the name of the new distribution list.  

  

You can also assign tag to your distribution list. Simply click on the down pointing arrow in the Tag 
field and assign arbitrary tag to your distribution list. Check Private field, if you want the distribution 
list to be private. 

By clicking on the Remove button (trash bin icon) next to particular contact, you will remove 
corresponding contact from the distribution list. 

Click on the Save button to finish the process.  

  

You can also drag and drop contacts from the main window onto the Distribution list creation 
window to add them. 

  

Working with Distribution List 
  



Write the name of the distribution list to the recipient field while you are filling in the addressee 
field. Once you have selected the distribution list, you can click on the plus sign icon next to the 
name of distribution list to display the full list of included contacts . 

  

 
  

Once you click on the plus sign, following self-explanatory window will appear: 

  

 
  

  

  



Contact views 
There are three Contacts views in eM Client, which you can navigate between by using the Main 
Toolbar at the top of the window 

 

People view 

This is the default Contacts view. Here you can easily see your list of contacts for each account by 
name, email address, and photo. 

When you select a contact from this list, you will be able to select three additional options which will 
give you more personal details about the contact and your email and attachment history with them. 

 

Contact - shows you their personal details and allows you to add notes about them 

History - shows your entire email history with them and allows you to search directly within it. 

Attachments - shows your entire attachment history with them and allows you to search directly 
within it. 

 

Business Cards view 
The Business Cards view allows you to see your various contacts and their most important details in 
a display that looks like a business card. It includes details like their photo, name, display name, 
email address, telephone numbers, organization and job title, as well as any applied Tags. 



 

List view 

The final Contacts view is the List view. This displays your contacts’ information in a series of rows 
and columns like a spreadsheet or classic database. 

Each of the columns have headers which tell you what type of information is contained in that 
column, such as full name, email address, phone number, tag. 

 

Tip: There are some pre-selected sorting systems available for you to use, such as by 
phone, company, or location. Selecting Custom will allow you to view all possible 
fields and you can click on any column header to sort by that column. 
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Managing Contacts 
You can access your contacts by navigating to your specific accounts under the contacts bookmark 
in the Left Navigation Panel or in the Contacts section of the Sidebar. Browsing the Contacts 
bookmark will display your contacts in the main panel, browsing the Contacts section of the Sidebar 
will display your contacts in the Sidebar. 

  

Main panel contact overview: 

 
Once the contacts are listed, you can delete contacts by pressing delete on your keyboard or by 
clicking on the delete button on the toolbar, or you can drag and drop your contacts to any folders 
under your other accounts. 

  

Pairing Your Contacts: 
  

There are basically 3 ways how to pair your contacts: 

1. Adding a chat contact to your contact list in Contact Card Window. 

 2. Pairing regular contacts to your chat contacts while using Contact Pairing 
Assistant.  

3. Drag-and-dropping chat contact on regular contact and vice versa. 

  

ad 1: Adding Chat contact to contact list via Contact Card Window 

  

Double click on a contact to bring up the Contact CardWidow. In the Add Chatsection on the 
right hand side, click Add...(the cross sign) to add the Chat account(s) associated with this contact. 

  



 
  

  

By clicking on the Add... button you will display following window:  

  

 
  

In the Chat service section you can select service from which you would like to pair a chat 
account with your regular account. Select "Jabber" if you know that for example an ICQ, MSN, AIM 
etc. account is set up on the particular chat account then the service will be ready to use. Please 
note that the list of services contains Jabber protocol services enlisted particularly - ICQ, MSN, AIM 



etc., which will not be ready to use, when you set them up for the regular account - your paired 
account will only contain information about the other ICQ, MSN, AIM account. Click on OK button to 
finish the process.  

  

Also, please, note that if you select for example ICQ from the Contact Service list, you will be 
asked to type-in Contact ID manually.  

  

  

ad 2: Pairing a contact card to an imported instant messaging contact 

  

When you log on to your Jabber service for the first time, you will be prompted to import your 
contacts. 

Later you can select Chat Contacts Pairing Assistantin chat settings option. Following window 
will pop up: 

  

 
  

 After you have selected the Chat account from which you wish to import your contacts, all the 
contacts contained in this chat contact list will be displayed in the list below. 

To pair a particular chat contact with a regular contact, select a regular contact by clicking on 
it to bring out a drop down list (you can see it in the picture below). There are two other 
options on this list:  

Take no Action- nothing happens with the chat contact 



New Contact- creates a new contact in the selected folder and pair the chat contact with this 
new contact. 

  

 

  

Once you have chosen the regular contact, click on Pair Contacts to pair the Chat contact with 
a regular contact. Now the process of contact pairing is complete.  

  

ad 3: Drag-and-dropping chat contact on regular contact and vice versa: 

  

Please note that there is also an easier way - just drag a contact (a Chat contact) and drop it 
on the contact you wish to pair it with (we are speaking about contacts in the Contact list/Chat 
bar). You will be prompted to confirm the pairing with the following window: 

  

 
  

Contact Properties 

To get to the contact properties window, right-click on particular contact folder and select 
Properties...  

Following window will appear:  

  



 
  

Here you can customize your contacts' display, you can select up to two options - Show in 
Agenda and Show in All Contacts folder.  

If you check Show in Agenda, events such as birthdays of the users from particular contact folder 
will be displayed in agenda.  

If you check Show in All Contacts Folder, particular contacts from selected folder will be also 
displayed in All Contacts folder. By un-checking this option, the particular contacts will not be shown 
in All Contacts folder. 
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Avatar downloading 
eM Client automatically downloads and displays avatars for your contacts from the web. 

We download images from Gravatar, domain icons and more. 

  

If no image is saved for your contact on server or in your Contacts section, the contact's initials will 
be shown instead, which can also be disabled to show an empty avatar icon instead. 

  

You can manage these options in Contacts settings. 
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About Calendar 
The Calendar offers an easy way to keep track of appointments, schedule your time and share your 
calendar with other people through the CalDAV protocol, as well as contacts through CardDAV 
protocol (if available). 

Events recorded in the calendar can be reminded by visual alerts.The calendar can be arranged into 
various layouts, such as day, week or month layouts. You can send out invitations and collect 
responses for organizing meetings and other events, or even fill itself up with your regular events. 
You can also get up-to-date weather forecast for a few upcoming days. 

The following links will show you - how to get started or work with more than one calendar, how 
to work with the calendar's toolbar and different layouts, how to change the calendar's preferences 
and especially how to work with events, and add event requests. 

  

  

Creating Search Folders for Calendar 

It is possible to create a search folder from relevant search process by right-clicking on the down-
pointing arrow next to the search bar and selecting Create Search Folder... from the context menu.  

  

 
  

Please note that this is the only way to create search folders for calendar.  
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Getting Started 
eM Client sets up a default calendar for you when you create an account. Its default name is 
"Calendar" and it can be found under Local Folders in the Calendar bookmark on the left vertical 
panel of the interface.  

 
A new sub-panel will appear, consisting of two parts: 



 
  

The upper part contains a hierarchical tree of your calendars. In the calendar management window, 
you can create new calendars and edit or delete existing ones. See Using More Than One Calendar 
to find out how to fully utilize the Calendar to organize your day. Select a calendar by clicking on it 
to display the contents of each calendar in the central panel. 



The lower half of the calendar sub-panel is the calendar page of the current month. The days 
displayed in the current calendar's layout in the central panel are highlighted here. You can also 
select the day/week/month (according to the layout view currently selected in the calendar's 
toolbar) to be displayed in the central panel by clicking the corresponding place in the small 
calendar in the sub-panel (you can cycle through the months with the two arrow buttons next to the 
name of the month). 

Calendar's central panel 
When you have selected a calendar in the left vertical panel, its contents are displayed in the 
Central Panel. Depending on which layout view you have chosen for your calendar in the calendar's 
toolbar, your events in the selected calendar will be displayed in the Day, Week, or Month calendar 
in the central panel. 

The central panel is where you create and edit events pertaining to a specific calendar, see Working 
with Events. 

To learn about how to change the appearance of the calendar's central panel by selecting between 
different layout views see Calendar Views. 

  

Calendar Properties 

You can access Calendar properties by clicking on particular Calendar on the Sidebar and selecting 
option Properties...  

Following window will appear:  

  



 
  

You can change the Calendar Color used inside the application. 

  

You can also choose Default reminder time and Default meeting length for a specific 
calendar. 

  

There are two additional settings that can be checked - Show reminders and Show in 
Agenda.  

  

If you check Show reminders, the reminders from calendar folders will always be added to the 
list of reminders. If you want to deactivate this function, keep the checkbox un-checked.  

If you check Show in Agenda, the events from the particular calendar that are up-to-date will be 
displayed in Agenda.  
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Calendar Views 
As mentioned at the beginning of this chapter, eM Client's calendar supports multiple layout views. 
You can select a view type which suits your schedules the most. In this section, we will walk you 
through the individual view modes. 

Before we start the tour through the individual views of the calendar, let us present one useful tip 
for calendar users - you can create a completely custom view by simply holding the Ctrl key and 
left-clicking on particular days in the small calendar window in the bottom left corner in order to 
select or deselect the days.  

Day View 
  

 
The day view is the most detailed as it focuses on the shortest period of time. 

The arrows on top of the central panel switch between upcoming and previous days.  

Next to the arrows is a label indicating which day (or week/month in the case of week view /month 
view) is currently selected and displayed.  

  

Schedule in the central panel is divided into hours which are divided according to the value specified 
in the granularity drop down menu in Calendar preferences.  

  

Calendar events are ordered in a vertical timeline. Each event is colored (you can pick any color you 
wish in the toolbar by clicking on Calendar Color) and contains the basic information (subject, start 
time, tag, recurrency and reminder settings).  



  

Events that last the whole day or span several days are displayed in the upper section of the 
calendar, before the timed schedule (so that these events don't interfere with the daily schedule). 

You can zoom in and out by holding Ctrl and using the scroll wheel. The layout of the calendar will 
expand or condense accordingly. 

  

 
  

Events in the main panel can be drag-and-dropped on a different time or resized to a different 
length.  

To move an event, click on an event box with the left mouse button and drag the event on another 
time and release the mouse button.  

  

To extend or reduce the duration of an event, move the pointer to the upper or lower area of an 
event and after the pointer changes its shape, click the left mouse button and resize the event as 
necessary. 

Moving events to a diferent date - events can be drag-and-dropped to the small calendar on 
the left. This smart utility is very useful in case you want to change the date of the event but you 
want to keep the same time schedule - just drag and drop the event on the desired date. 

 
  



If you hover the mouse pointer over an event, a pop up balloon tooltip will appear, showing event 
details, including subject, start time, end time and description. This also works in the week view and 
month view. 

  

 
  

Week View 
  

 
  

All the functions offered in Day View can be found in Week View, the only difference is that the 
Week View displays one week at a time. If you want to see the schedule for workdays, select Work 
Week View in the calendar's toolbar. You can also zoom in and out by holding Ctrl and using the 
scroll wheel. The layout of the calendar will expand or condense accordingly. 

  

Work Week View 

  

 
  

Work Week View is the same as Week View except that only the days which you have set up as 
work days will be displayed. To set up your work week go to Menu -> Settings -> Calendar.  

  



Upcoming 

  

 
  

Upcoming View is the same as Week View except it shows today and the next 6 days.  

  

Month View 

The Month View layout allows you to see the events of the entire month. 

  

Events that last less than a single day are ordered the same way as in the other layouts. Daylong 
and multi-day events are displayed before other short events and are sorted by their starting time. 
Notice that today's date is highlighted - this has been added for easier orientation in the month view 
layout.  

  

 
  

Days that contain more events than what can fit into their window will have three little dots 
displayed in the upper right corner (see picture below). Hover over the three dots to see how many 
events are hidden.  

  



 

Agenda 

  

 
  

This layout does not display events in a calendar but instead in a comprehensible list of events, with 
each line containing the details of a single event.  

By default, events are ordered by their starting dates. Recurring events are listed only once, at the 
time of their first occurrence. 

  

 
This view is particularly useful when searching for particular events. It allows you to arrange events 
by different parameters by simply clicking on a column header. Click on the column header again to 
switch between ascending and descending orders. 

You can customize the List View by right-clicking at the column heading. Select Columns 
configuration. 



 
Add the columns you would like to see in your List View window by selecting them and pressing 
Add. You may also arrange the order in which the columns are displayed by first selecting a column 
heading and pressing Move Up or Move Down. 

You can also resize the width of columns by clicking between two columns in the table header and 
dragging the cursor right or left as needed. 

Hide Past button 

 
 Hide Past button automatically hides all the events in calendar that are out of date.  
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Toolbar 
Toolbar is located on the top of the application window and it changes according to what you are 
currently working on. You can customize the individual items you want to be displayed on the 
toolbar by right-clicking on the toolbar and selecting Customize, which will bring up the following 
window: 

  

 
here you can customize what items you want to display in the toolbar. Using appropriate buttons, 
you can Add items from Available items column to Items to show column or subsequently Remove 
them. Click on Set Defaults button to restore default settings. Note that you can add the items in an 
arbitrary order, depending on what order you add them to the Items to show column. 
The Show icons only option will hide the text of the buttons, so you can fit more features on the 
toolbar. You can hover over the buttons to have the title pop up. 

  

 

New 

This option is common to all four modules of this product, however in Calendar view it will be 
primarily bound to the New Event option. In Calendar mode you can create new events in your 
current calendar by clicking on the New button and New Event window will pop up.  . This will bring 
up the event editing box where you can create a new Calendar event. 

Print 

By clicking the Print button you will be redirected directly to the Print window. To display the 
Print Preview window go to File >Print Preview (by default Ctrl +Shift + P), where you will 
be able to see a preview of what you are going to print as well as modify any settings to 
customize the layout of the printed page. 

  



 

In the drop-down menu in the top right-hand corner of the window, you can specify 
the view you wish to print (detailed, table, week, month).  

  

In the top left-hand corner of this window you can see the following four buttons: 



 

Print - click this button to print the preview 

Page setup - click to access the following menu, where you can set up the layout of the printed 
page. 



 
  

Print settings - click to access the following menu, which contains three tabs (Week 
View, Month View and Day View) 



 

  

 
  



 
  

If you check the Print only workdays field, Saturdays and Sundays will not be printed. 

Using the drop-down menu, you can define the granularity you wish to use. 

In the Print Range section, you can specify the range you wish to print. If you check the Use 
calendar range option, the calendar settings will be used. 

  

Zoom - Here you can adjust the zoom ratio in which you would like to have the about-to-print 
page. 

  

View Options 

The calendar can switch between several layout views. In the Toolbar, you can select one of four 
ways to display and manage the events in our calendar.   

  

Day View  
The day view displays the most details since it focuses on the shortest period of time. 

The arrows at the top of the central panel switch between upcoming and previous days.  

Next to the arrows is a label indicating which day (or week or month in the case of week view or 
month view) is currently selected.  

  

The schedule in the central panel is divided into hours, these are divided according to the value 
specified in the granularity drop down menu in the Calendar preferences. 

  



 
  

Calendar events are ordered in a vertical timeline. Each event is colored (you can choose any color 
you like on the toolbar) and contains the basic information (subject, start time, tag, recurrency and 
reminder settings).  

  

Events that last the whole day or span several days are displayed in the upper section of the 
calendar, before the timed schedule (so that these events don't interfere with the daily schedule). 

  



 
  

Events in the main panel can be drag-and-dropped on a different time or resized to a different 
length.  

  

To move an event, click on an event box with the left mouse button and drag the event to another 
time and release the mouse button.  

  

To extend or reduce the duration of an event, move the pointer to the upper or lower area of an 
event and after the pointer changes its shape, click the left mouse button and resize the event as 
necessary. 

  

If you hover the mouse pointer over an event, a balloon tooltip will appear showing the details of 
the event, including subject, start time, end time and description. This also works in the week view 
and month view. 

  



 
  

  

Week View 

  

 
  

All the functions offered in Day View can be found in Week View, the only difference is that Week 
View displays one week at a time. If you want to see the schedule for workdays, select Work 
Week View in the calendar's toolbar.  

  

  

Work Week View 

  

 
  

Same as week view except that only the days which you have set up as "days when you work" will 
be displayed. To set up your work week go to Settings -> Calendar.  

  

  

Month View 

The month view layout allows you to see the events of the whole month. 

  



Events that last less than a single day are ordered the same way as in the other layouts. Day long 
and multi-day events are displayed before other short events and are sorted by their starting time. 

  

 
  

Days that contain more events than can be fitted into its window will have three dots in the upper 
right corner of the window. Click on the three dots to switch to day view, allowing you to see all 
your scheduled events in the particular day. 

  

 
  

  

Agenda 

  

 
  



This layout does not display events in a calendar but instead in a comprehensible list of events, with 
each line containing the details of a single event.  

By default, events are ordered by their starting dates. Recurring events are listed only once, at the 
time of their first occurrence. 

 
  

This view is particularly useful when searching for particular events. It allows you to arrange events 
by different parameters by simply clicking on a particular column header. Click the column header 
again to switch between ascending and descending orders. 

  

  



Searching Calendar 

 
To search your Calendar use the Agenda section which you can find on the right-hand side of the 
interface.  
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Calendar Preferences 
Access the calendar's settings by right-clicking anywhere on the calendar's main panel and select 
Calendar Preferences from the context menu, or select Menu >Tools > Settings from the main 
menu, then select the Calendar section in the Settings window. 

  

 
  

The Calendar Settings window consists of four sub-sections: Calendar View, Work Week,, 
Balloons and Agenda (Events List). 



Calendar View  

Show week numbers: 
If you check this option, there will always be a week number displayed in the month view of the 
calendar, according to the current year.  

Granularity: 
This option allows you to choose the granularity of the day and week view layouts. 

The days are divided into hours by default. If you want to plan your time more accurately, you can 
split the hours into slices of 5, 10, 15, 20 or 30 minutes. This time unit is important when you are 
moving and resizing events by Drag & Dropping event boxes because you can't adjust the events by 
smaller time units than defined here. 

Show Range: 
This option allows you to set the "height" of your calendar's layout. The value specified in this field 
determines how many hours will be visible at one time in the calendar's central panel. 

So, if you set 24 hours in this field, you won't have to scroll at all in your calendar's central panel, 
leaving you plenty of room for your nocturnal activities. 

Source of event's color in multi-calendar mode: 
You can define the source of the of an event's color while you are in multi-calendar mode. This 
option is useful when you are working with more than one calendar. You have three options:  

Tag then calendar - will prefer tag color and ignore calendar color. 

Calendar then tag - will prefer the color of a calendar and the tag color will be determined only by 
the tag indicator. 

and Calendar only - will display calendar color primarily while you only one calendar is selected.  

Number of weeks in month view: 
 You can set the number of weeks by 3 different ways: in the calendar settings; by pressing ctrl and 
simultaneously scrolling with the mouse-wheel while in month view of the calendar; or by pinch 
gesture in touch mode of the application.  

Work Week  
In this section, you can define the parameters of the work week. When it starts, when it ends and 
which days it contains. 

Balloon tooltips panel 
In this panel you can define the behavior of the popup balloon tooltips which appear when you 
hover the mouse pointer over an event box. These tooltips contain the events' info. You can learn 
more about balloon tooltips in the Calendar Views section. 

Agenda (Events list) 
Check Show groups in agenda to have groups displayed in Agenda (Events list). 

Defaults 

In this panel you can set default meeting lengths and reminder lengths. You can select whether you 
want to apply them to all folders or only to selected ones.  

Copyright © 2025 eM Client s.r.o. 

Thámova 18 
 Prague, 186 00 
Czech Republic  



info@emclient.com  



Calendar Sharing 
eM Client can synchronize its calendar with shared calendars on the server. This way multiple users 
can access the same calendar. This feature is useful for scheduling public resources. For example, 
employees can log onto a public calendar to book company cars or meeting rooms or check the 
availability said cars or rooms. 

To access a shared calendar, you proceed in the same fashion as if you were setting up a normal 
CalDAV account: 

Select CalDAV in Account wizard. 

Fill in the URL of the shared CalDAV location, your username and your password. 



Finally you need to enter your credentials in the account window or when being prompted during 
account synchronization. 



 
  

You now have a calendar account that is synchronized with a public calendar, any changes you or 
other users make will be uploaded to the same CalDAV server and displayed in your eM Client's 
Calendar. 
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Working with Events 

Creating and editing events 

Events are the basic entries in your calendars. 

To create a new event in a calendar: 
On the calendar toolbar select New>Event . 
If you are using this option for the first time, you will be provided with an option to create Standard 
event or Online Meeting: 

You can use the Always use this option to lock in your selection for next time and choose each 
time. 
You can also change this setting any time later in Menu > Settings >Calendar>General>Defaults. 

Another way to create an event is to right-click on the calendar itself in specific time then 
select New Event... or, double-click the calendar in the Central Panel.  

Both of these options will set the start date for you art the selected time and set the end date based 
on your default event duration. 

However, by far the easiest way is to draw a rectangular outline of your event by drag and 
drop your mouse on the calendar. 

The last way how to create an event is to move with your keyboard arrows from box to box 
and subsequently write a name of the event and ultimately press enter. This way of creating events 
is by far the fastest one if mastered by the user.  



 
   

Type in a name for this event and press Enter to create a default one time event with only the time 
and name you have specified. To add more details double click on the newly created event to bring 
up the Event editor window. 

Event settings 

All the basic configuration can be defined in this window: 

  

 
  

At the top you have the Save & Close button used for finishing you event. 
Next to it is the Calendar selection, you can use the drop-down menu to select a different 
calendar. If you do so, the event will be automatically moved to the selected folder. This utility 
works also for editing Tasks, Contacts and Notes. 



 

Simply click on the down-pointing arrow and select desired folder from a drop-down list.  

  

Title 

The subject of the event. This information will be displayed in the calendar window after the event is 
saved, therefore it should be as brief as possible. 

All day event 
In the all day event, the start and end time items are missing. This means that this event will be in 
progress over the entire day, but other events can be still planned for this day. The typical example 
is setting entire-day events like wedding anniversaries, symposiums, vacations, business trips, etc. 

Start  
Start time of the event. Consists of two fields, date and hour. 

End 

End time of the event. 

If the date part of end time of a given event differs from its start time date, a multiple day event 
is created. These events are listed in the upper part of the schedule, under the all day events. This 
way they don't mess into the daily schedule. 

Show as 

You can select a type of your event - You can be busy or you can be free. 



  

Reminder 

Reminder is a special function of the interface, that allows reminding of events. If the reminder is 
set for an event, an alert is displayed at the defined time that informs of an upcoming event. The 
default value is No Reminder, but any different value can be selected from the drop-down list. To 
cancel the reminder, simply choose the No Reminder option in the event's dialog box. For more 
information about working with reminder see section Edit Events. 

Tag 

In the tag drop-down menu, you can assign color-coded tags to the selected event. In the 
calendar's central view, events will be shown colored according to their tags designated here. In 
case of multiple calendars, each calendar is assigned its own tag (see Using More Than One 
Calendar). The tag's color will be shown in the event's heading (Except in a month view layout). For 
more details on Tags see About Tags. 

  

 



Recurrence 
The Recurrence tab is used to set recurring tasks which take place every given number of days, 
weeks or months. 

In this tab you can set how often will the task be recurred and when (if ever) will the recurrence 
terminate. 

Frequency 

You can set frequency daily, weekly, monthly or yearly. 

Recurrence range 

You can set here when the event should end. There are three options: 

No end date - The event will recur for ever and ever and ever... 

End after X occurrences - You can set the number X. The event will not recur after X 
occurrences. 

End by - You can set a date. The event will not recur after this date. 

Pattern 

Frequency daily - In the pattern you set the number of days when the event should recur, 

Frequency weekly - In the pattern you can set the number of weeks when the event should recur. 
You can also choose the days of the  

 week on which the event should recur (e.g. in the following picture, the event will recur every week 
on Monday and Saturday). 

Frequency monthly -  In the pattern you set the number of months when the event should recur. 
You can also set a day - you can set the number of day in month, or set for example "second 
Monday". 

Frequency yearly - In the pattern you set the number of years when event should recur. You can 
set a date for event or set for example "second Monday of February". 

Location 

Enter the geological or descriptive location of your event. eM Client will automatically offer 
previously used locations once you start typing. 



Participants 

Participants are those contacts that are invited to particular event and their status is determined by 
responding to the event request or not (their status can also be set manually). 

Private event 
If you check Private event, this event will get a private status. 

  

  

  



Event Requests 
Once an Event has been created, you can send attendance requests to others through Email.  
For Calendar providers that have an auto-scheduling feature the Invitations and Event updates will 
be sent automatically by the server. 

  

Sending an email to attendees 

 
  

You can manually send an email, reply or forward the event using the options under Menu>Event. 

  

Scheduling 

In the All attendees list type in the list of potential attendees you wish to be invited to the event. 

  



 
  

Type of resource - select type of resource by clicking on the second icon next to he 
participants name which will bring up a list of options (Required, Optional, Resource) form 
which you can choose and select one:  

 

  

Pick Previous and Pick Next- By clicking on Pick Previous or Pick Next the next or 
previous time window will be found, i.e. time period when all participants actually have time. 

 Refresh- click on  icon to refresh the information when participants have free time 

Options- click on  icon to bring up the list of options for scheduling 

  

 

  

Here you can select if you want to show only working hours/days and you can also zoom in/out.  



There are three types of requests that can be sent to each attendee: Required, Optional, and 
Resource. Each can be selected by clicking on the box next to the attendees' emails. 

Each time you add a contact to your list of attendees, if you have the Freebusy URL 
for that contact setup (see relevant section in New Contact creation), you can see 
the schedule of the attendee, which can help you organize the event. 

A response to your request can be obtained from each attendee in the form of Accepted, Declined, 
or Tentative, which will also be displayed in this window next to each attendee's email address. 
Needs Action status means no response was received yet. 

Once all the necessary details have been entered into the Event editor, click Save to finish editing. A 
prompt will appear asking you whether you wish to send invites to the attendees listed, click Send 
invite to close the editor and send invites. 

Tip: Should you delete or make changes to your events after you have sent out your 
event invites, a notice of change/cancellation will be sent to each of the attendees 
accordingly. 

Your invitee will receive an invite such as the one below in their email, they can send you a reply by 
clicking on either Accept, Tentative, or Decline respectively, which will show up in your Event 
window. 



Find out more about invitations in emails in the Calendar invites and RSVP section. 

Tip: if you have a Google account set up in application, your Google Calendar will be 
automatically synchronized to your Calendar. 

Description 

To any event it is possible to add a comment referring to various issues such as event details or lists 
of items related to the event. 
The description field contains the same toolbar options as composition of email and other items and 
you can also customize the toolbar to fit your needs. 

Location 

Location of the event - for example: at work, at home, at school... 
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Edit Events 
You can double-click the even to open it in the same window as when you're first creating it and 
change all the same details as in the Working with events section. 
There are few extra options you can use though. 

Resizing and moving events 

All event blocks can be moved to a different time by Drag & Dropping them. All Events can be 
moved and rescheduled in this simple way in all view layouts that are available in Calendar. 

To change the duration of an event in the day or week view, move the pointer to the upper or lower 
area of an event box and when the pointer changes to a double headed arrow, left-click and resize 
the box as required. 

When drag & dropping events, remember you can only change the events by the time unit specified 
in the granularity option in the calendar's toolbar. You can't resize/move events by smaller time 
units than the specified units. 

Deleting events 

To delete an event, select the Delete button on the toolbar, the Delete option from its context 
menu or simply click on the event box and press the Delete key on your keyboard. 

You can also Copy, Cut and Paste events like you would do with texts, with the standard Ctrl+C 
(Copy), Ctrl+X (Cut) and Ctrl+V (Paste) hotkeys. 

Event reminders 

For important events, you can set reminders that will regularly send you alerts as the event 
approaches. 

To set up a reminder, open the Event Editor window for a specific event (see working with events), 
in the General tab and enter the amount of time ahead of the event you wish to start receiving 
notification alerts in the Reminder: field. The default value is No Reminder, which means you will 
not receive any alerts before the upcoming event. To set a reminder, click on the drop-down list and 
select a time amount from 5 minutes to 2 days ahead of the event to start receiving reminders.  

The event reminder is displayed either in a pop-up notification or dedicated Reminders window. 
You can decide which you prefer and then tweak the options in Notifications and Reminders 
settings. 

Reminders window: 



System notification reminder: 

Both the pop-up reminders and the Reminders window offer you several ways to interact with the 
notification system and the event(s) themselves: 

Open Item 

Click the notification or the event listed in the window to open and edit the event directly in an edit 
window. 



Dismiss (All) 

Click the Dismiss button dismiss the specific reminder. Reminder alerts will no longer be displayed 
for the selected event with the exception of repeated events. 
Reminders window also has the option to Dismiss All. 

Snooze (All) 

Snooze works much like the same button on an alarm clock. Click Snooze bell icon or Snooze All in 
Reminders window to temporarily dismiss the alerts.  

Tip: you can also manually disable event reminders by opening up the Event Editor 
window and setting the Reminder field to its default No Reminder. 

Warning: The notifications and reminder window is active only when eM Client is running. 
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Calendar invites and RSVP 
When you receive an invitation to en event via email eM Client will automatically put all the details 
into an organized table where you can easily see all the details, like the title of the event, start 
and end dates/times, organizer, attendees, description and anything else the event file 
contains. 
This way no matter what calendar service or app the organizer uses, you will always see the event 
details the same way and will be able to quickly find the details you need to device if you want to 
accept or decline the invitation (or keep it as tentative). 

RSVP 
When you receive an event invitation in email eM Client will show an RSVP button in the bottom 
right corner of the message in the message list: 

Clicking this button will open the invite preview in a pop-up from which you can quickly look through 
the invite and send response quickly without having to open the message itself. 
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Using More Than One Calendar 
eM Client allows you to create multiple calendars, each of them dedicated to separate aspects of 
your life (one calendar for your work duties and another for your leisure time for example). Multiple 
calendars offer several advanced functions, like simultaneous displaying of events, distinct colors for 
events from the individual calendars or hierarchical structuring of your calendars. 

These features are provided through the Calendar sub-panel in the left-most vertical panel of the 
interface. Open this sub-panel by clicking on the Calendar label in the left-most panel (if the panel 
is already displayed, clicking on this label will minimalize it). 

The Calendar sub-panel consists of two parts: 



In the lower part you can see the calendar view of the current month. You can learn more about its 
functionality in the Getting Started section. 

The upper part contains the hierarchical tree of your calendars. All the functionality connected to 
using multiple calendars is provided by this tree. 

The root folder of the tree is created automatically and goes by the name "Calendar". This folder is 
always the top-most in the tree and cannot be deleted or renamed. 



Creating new calendars 

Right-click anywhere into the Calendar sub-panel (if you click on an existing calendar, this calendar 
will be selected as a default parent for the newly created calendar folder in the hierarchical tree). A 
context menu will appear. Choose the New calendar... option and a dialog window will open.  

Insert the requested name for the new calendar into the Name: field. In the Select where to place 
the folder: panel, you can choose, where the new calendar folder will be situated in the hierarchical 
tree (the default position is determined by the place you have right-clicked in the Calendar sub-
panel). You can also choose the color that will be used for this new calendar. When you're done, 
click OK and a Calendar will be created and inserted into the tree structure. 

Editing existing calendars 

You can also rename calendars, delete them and choose colors for the events contained in them. All 
these options are available via the context menu of the calendars, simply right-click the desired 
calendar and choose the requested option. 



About Tasks 
We have all wondered exactly when our days of youthful vigor turned into a life lived by a to-do list 
stuck on our fridge. We all inevitably have to end such musings with a sigh, check off "get more 
eggs" then go on to "pick up the laundry." What we can do however, is to make that list more 
convenient and more helpful. 

If you are ready for something a little more 21st century than that writing pad on your fridge, eM 
Client is here for you! This product's task management tool is the central storage of all your tasks, it 
can remind you of your duties with automatic alerts, and keep track of the progress of your various 
activities. The default Detail view now also utilizes the famous 'Getting Things Done' methodology to 
help you with your tasks. 

Getting started 
A default task folder is prepared for you when you create your account. You can access it by clicking 
the Tasks bookmark in the left-most vertical panel of the eM Client's interface. 

A new sub-panel will open, containing the hierarchical tree of your task folders: 

In this panel you can customize and manage your task folders. You can create new task folders, 
rename or delete existing ones. All this is accomplished via right-clicking and selecting the desired 
option from the context menu. 

If you click on any of your task folders in this panel, the central panel will switch to a task list view 
of the chosen task folder. In this view you can see all the tasks from the given task folder and you 
can also create new tasks and edit/delete existing ones here. 

Creating Search Folders for Tasks 



It is possible to create a search folder from relevant search process by right-clicking on the down-
pointing arrow next to the search bar and selecting Create Search Folder... from the context menu.  

  

 
  

Please, note that this is the only way, how to create search folders for Tasks.  

  

Copyright © 2025 eM Client s.r.o. 

Thámova 18 
 Prague, 186 00 
Czech Republic  

info@emclient.com  



Task List Display 
The default view - Detail - is similar to the Mail section, with folders on the very left, item list in 
the middle and preview of the tasks details to the right. 

 Detail view  
  

 
  

In the middle panel you can easily sort your tasks using the top bar: 

 
All - this sort will show all your tasks no matter their status 

Upcoming - only tasks that are yet to be finished will be shown 

Completed - this option will only show tasks that are Completed 

On hold - tasks that are set to be on hold or waiting on someone else 

  

The tasks themselves will be color coded and have a corresponding icon depending on their Status. 



 

• Green – this color is used for tasks that are completed and do not require more action 

• Red – this color is used for tasks that are past the due date 

• Orange - this icon represents tasks that have already started and are waiting for resolution 

• Blue – this icon is used for tasks that are scheduled to start in the future 

  

Along with the graphical change comes the power to use an advanced filter to display your tasks. 
You are now allowed to sort and filter all your tasks the similar way you are used to from your 
mailbox. As you can see from picture below, the view can differ quite a bit. 

Sorted by argument: 
This sorting will determine in what order your tasks will be shown in the list. 



 
  

Quick filter: 
This filter will filter out items from your current list that match your given criteria. 



 
  

On the right side you can see all the details your task includes, including all the start/due dates, 
location, assignees, etc. 

 List view 

If you want a simpler view, there is also the List option. The tasks are then shown in a simple list 
that contains data such as the subject of the task, scheduled deadline and the status of the task. 

 
  

Sorting tasks by columns 

 The detailed information on individual tasks is displayed in the columns. The tasks can be sorted by 
the details listed in individual columns. Click the column heading to sort tasks in the ascending or 



descending order (see the arrow next to the column's name) by alphabet, date or other criterion, 
depending on the column contents.  

Adding and deleting columns 

Users can customize the appearance of the table and the information shown. The columns can be 
added or deleted and their order can be changed. Right-click the table header, select Columns 
configuration... and specify the column settings in the Columns window.  

 
Checked columns will be shown in the dialog box, unchecked columns will be hidden. You can also 
change the order of columns. Just use the Move Up and Move Down buttons in the Columns window 
or simply use the Drag&Drop technique directly in the table header (left-click on one of the column 
headings and drag it onto the heading of the column you want to switch with). 

Adjusting the column width 

The width of the task list's columns can be adjusted. To change the column width, click between two 
columns in the table header and drag the cursor right or left as needed. Another option is to use the 
Columns window (right-click the table header and select Columns configuration...). In there select 
the desired column and specify the requested number of pixels. 

Completing tasks 

After a specific task is solved, it can be marked as solved in the task list using the checkboxes in 
front of every task. When the task is checked, its status is set to completed. 
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Creating and Editing Tasks 

Creating new tasks 

To create a new task, select New in the toolbar, the other way is to right-click a task folder in the 
Tasks sub-panel in the left vertical panel and select New task from the context menu. The last and 
by far the fastest way, when you are in the Task section, is to click on the top line (the line is 
separated by thick line, see screen shot bellow), fill in required fields and press enter.  

 A Task create-and-edit dialog will open. 

Event creation window 

 

Title: 
The title of the task. This information will be displayed in the task list and therefore it should be as 
brief as possible. 

Location: 
Location of the task. 

Start: 
Start time of the task. Consists of two fields, date and hour. The default value is the current date 
and hour. 



Due: 
Time required for completion of the task. 

Reminder: 
Reminder is a special function of the interface, which allows reminding of upcoming tasks. If the 
reminder is set for a task, an alert is displayed at the defined time that informs of an upcoming 
task. By default the Reminder: checkbox is unchecked, meaning that you won't be reminded of the 
task. But if you check it and set a date and time in the Reminder: fields, an alert will be displayed at 
the specified time. To cancel the reminder, simply uncheck the Reminder: checkbox. 

Tag: 
In the tag drop-down menu, you can assign color coded tags to the task. Tags provide a way for 
you to recognize and assess the nature of a Task at a glance, whether a Task is work related, 
personal or requires immediate attention etc. (For more details on Tags see About Tags).  

  

Status: 
Each task goes through several stages during the process of its completion. Here you can define 
what stage is the selected task currently in. 

Complete: 
Shows what percentage of the task has already been completed. 

Recurrence:  
The Recurrence tab is used to set recurring tasks which take place every given number of days, 
weeks or months. 

In this tab you can set how often will the task be recurred and when (if ever) will the recurrence 
terminate. 

Private task: 
If you check the checkbox, the task will get the private status. 

Assign to:  
Assign the task to any number of your contacts and an invitation will be send to them.  

Description: 
Detailed information can be provided for each task. 

Attachment: 
Like with Emails and calendar schedules, You can add attachments to your tasks, maps, notes, 
power point slides etc. 

Location: 
Specify location of the task.  

Folder:  
you can select a particular folder by left-clicking on the directory at the left bottom corner. If you do 
so, the task will be automatically moved to the selected folder. This utility works also for editing 
Events and Contacts. 



Note: If you are synchronizing your tasks with a specific server/service, then only 
supported fields will be shown in this window to avoid saving of data which you 
would not be able to access on your other devices. 

Editing tasks 

Existing Tasks can be edited through the same Task editor window. To edit an existing task, double-
click on it to bring up the Task window. 

Deleting tasks 

To delete a task select it in the task list and press the Delete key. 

  

Displaying Tasks in Agenda and in Calendar tasks 

To customize displaying tasks in your Agenda and in Calendar tasks, right-click on the Task folder 
from one of your accounts and choose Properties... from the contextual menu. 

The following window will appear : 

  



 
Here you have 3 options that can be used: Show reminders, Show in Agenda, Show in Calendar 
tasks 

  

If you check Show reminders, the reminders of tasks in a particular task folder will be shown 
(active), if you uncheck this option, reminders set up in this task folder will not be active.  

  

If you check Show in Agenda, the tasks from a particular task folder will be shown in the Agenda 
section on the right.  

  

If you check Show in Calendar tasks, the tasks from a particular task folder will be show in your 
Calendar view , just as you can see in the picture: 
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Reminders window 
 Reminders are a special notification type for events and tasks. In eM Client the 
reminders can be shown as separate notifications, the same way email and other 
notifications are, or you can use the Reminders window. 

Reminder window settings can be found in Menu > Settings> General > Reminders, 
find closer explanation here. 

Reminders window 
The reminders window shows all active reminders for your upcoming (and past , 
depending on your setting) events and tasks. You have a number of options available in 
the toolbar to work with these reminders. 

 

Dismiss All - Dismisses all reminder shown in the window 

Dismiss - Dismisses just the selected reminder 

Snooze All - Postpone all reminders shown in the window - click the button to snooze by 
the default snooze time or click the drop-down menu to select a specific time period 

Snooze - Postpone the selected reminder 



Mask as Completed - Applicable to tasks, you can mark the task as finished and dismiss 
the reminder in one step. 

  

Double-click the item in the Reminders window to open the given event or task in a new 
separate window, if you need to edit the item itself. 

  

The Snooze buttons drop-down menu allows you to select a time or set Default Snooze 
Interval which is one of the available time options in the list: 
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About Attachments 

What Are Attachments? 

An email attachment is a computer file sent along with an email message. One or more files can be 
attached to any email message, and be sent along with it to the recipient. This is typically used as a 
simple method to share documents and images. Attachments can also be added to other processes 
in eM Client, such as Calendar events, Notes or Tasks. 

What is the Attachment View? 

The dedicated Attachment View is a section similar to the Calendar View or Contacts View, where 
you can centrally manage all of your attachments you’ve sent, received, or uploaded in eM Client. 

How to Navigate in Attachment View 

Like the other views in eM Client, you navigate in the Attachment View primarily through the 
account folders on the left side panel. From there you can filter if you want to see attachments from 
all your accounts in eM Client, or if you only want to look for attachments from specific accounts or 
services. 

Additionally, you can filter the type of attachments which are displayed by clicking on the options 
highlighted in the blue box below 

All - displays all types of file attachments 

Images - only displays picture files such as .png, .jpg, or .gif 

Media - only displays video or sounds files such as .mp3, .mp4, .webm or .wav 

Documents - displays document files such as .doc, .xls, .pdf, .txt, .log or .rtf 

Archives - displays compressed files like .zip 

 

Searching Attachments 

After narrowing down the chosen account, service and file type, you can search further for a specific 
attachment using the search bar in the middle above the toolbar. 



The search also looks through the text within your attached document files. This makes it much 
easier to find a document, even if you don’t remember its name. 

  

Attachment View Main Toolbar 

There are 6 options in the main toolbar at the top of the Attachment View. Like any top toolbar, you 
can right-click on it in order to customize the displayed options and their order. 

 

List - Changes your display of attachments to the list style 

Cards - Changes your display of attachments to the card style 

Save as - Saves the chosen attachment locally on your computer 

Forward - Creates a new email with the chosen attachment already attached 

Open Source - Opens a window in eM Client where the chosen attachment comes from, such as 
the email where the attachment was received. 

Delete - Deletes the chosen attachment 
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About Notes 
This feature is available only to the Pro license users. 

 
  

Notes are meant as a place to store information about something. It’s like writing an email without 
a recipient. 

eM Client supports local and server-side Notes. You can write fancy notes with pictures and 
attachments, organize them via tags, and sync notes across all your devices.  

Server-side notes currently work with Exchange, Office365 and IceWarp accounts. 

You can get to the Notes View by clicking on the notepad icon in the bottom left corner of eM Client 

 or by clicking the three dots  in the lower right corner and selecting “Notes” 

  

Individual notes can be exported from eM Client in a vNote file (.ics) format. 

eM Client Notes can also import new notes from vNote .ics files. 
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Creating and editing Notes 
This feature is available only to the Pro license users. 

New Note 

There are three ways to add a new note. 

The first is to click on the top line (the line is separated by a thick line, see screenshot below), type 
a note title and press enter. This is the fastest way how to add a new note. 

 
  

The second way is to click on the arrow button New and select Note... or just click the New button 
when in the Notes section. 

 
  

The third way is to right-click the empty space below your other notes and select New 

 
A Note create-and-edit dialog will open. 



Edit Note 

Deleting notes 

To delete a note, select the Delete button on the toolbar, the Delete option from its context menu or 
simply click on the note box and press the Delete key on your keyboard. 

You can also Copy, Cut and Paste notes like you would do with texts, with the standard Copy 
(Ctrl+C), Cut (Ctrl+X) and Paste (Ctrl+V) hotkeys. 

There is no Note Trash folder. 

When a note is accidentally deleted, it can be temporarily recovered with the Undo command, but 
the note will be permanently deleted when you do another operation which supports Undo, or exit 
the eM Client application. Please restore accidentally deleted notes immediately or you risk 
permanent deletion. 

Editing notes 

Existing notes can be edited through the same note editor window. To edit an existing note, double-
click on it to bring up the note window. 

This window will be similar to an email compose window with a lot of the same features in its 
composition toolbar 

Toolbar 

Components of the toolbar in the editing window are separated into two sections, the upper toolbar 
and the composition toolbar. 

Upper toolbar: 

 
Save & Close: Click this button to save your edits to the Note and close the editing window 

Folder selection: You can choose which account’s Note folder you want this note to be saved to. 

Save: This will save your current edits on the note, but not close the editing window. 

Forward: This will generate a new email out of the Note you created. The subject of the email will 
be the Note title and the message body of the email will be the message body of the Note. 

Forward (as attachment): This will allow you to send this Note to someone as an .ics attachment in 
an email. Clicking this will generate a new blank email with the .ics file with the note already 
attached. 

Delete: This will delete the note which is currently open 

  

Composition toolbar 

 
Attachment: You can add the attachments to your note by clicking on the small paperclip icon. 

Private: This marks the note as private and the note will not be included in the folders you share 
with other people (link about folder sharing coming eventually) 

  

Note Editor 

 



Bold - The selected text will be bold. 

Italic - The selected text will be written in italic. 

Underline - The selected text will be underlined. 

Paint Format - Select certain area of the text while holding right mouse button, click on the Paint 
Format button, and then hover over different area of the text to transfer the format of the original 
text to the newly selected area. 

Font Style - click on the Font Style button to bring up following menu 

 
  

Ordered list - create a numbered list 

Unordered list - create a list of points 

  

Left Align - justify the text to the left. 

Center - justify the text to the center. 

Right Align- justify the text to the right. 

Justify - justify the text on both sides 



 
Emoticons - add emoticons to your note. 

  

Click on the Morebutton to bring up the following additional features that could not fit in 
the toolbar: 

 
Cut - Cut a part of text to clipboard. 

Copy - Copy a part of text to clipboard. 

Paste - Paste the text from clipboard. 

Remove Format - Remove all formats from selected text. 

Undo - erase the last change done to your note. 

Redo - repeats the most recently undone action. 

Outdent - Move selected text to the left (if this text was indented before). 



Indent - Move selected text to the right. 

Left to Right - change the character insertion for text to follow a Left to Right pattern (used for LTR 
languages such as English or Russian) 

Right to Left - change the character insertion for text to follow a Right to Left pattern (used for RTL 
languages such as Arabic or Hebrew) 

Insert link - add a hyperlink to your note. 

Insert image - add an image to your notel. 

Insert table - add a table to your note. 

Insert symbol - add a symbol to your note. 

Customize - customize the layout of your note window. 

  

Please note that you can customize what tools you want to have present on the toolbar by clicking 
on Customize button from the roll down menu. 

  

Deleting notes 

To delete a note select it in the note list and press the Delete key. 

  

Note List Display 

In this layout, the notes are shown in a simple list that contains data such as the subject of the 
note, scheduled deadline and the status of the note. 

 

Sorting notes by columns 
The detailed information on individual notes is displayed in the columns. The notes can be sorted by 
the details listed in individual columns. Click the column heading to sort notes in the ascending or 
descending order (see the arrow next to the column's name) by alphabet, date or other criterion, 
depending on the column contents. 

Adding and deleting columns 

Users can customize the appearance of the table and the information shown. The columns can be 
added or deleted and their order can be changed. Right-click the table header, select Columns 
configuration... and specify the column settings in the Columns window. 



 
Checked columns will be shown in the dialog box, unchecked columns will be hidden. You can also 
change the order of columns. Just use the Move Up and Move Down buttons in the Columns window 
or simply use the Drag&Drop technique directly in the table header (left-click on one of the column 
headings and drag it onto the heading of the column you want to switch with). 

Adjusting the column width 

The width of the note list's columns can be adjusted. To change the column width, click between 
two columns in the table header and drag the cursor right or left as needed. Another option is to 
use the Columns window (right-click the table header and select Columns configuration...). In there 
select the desired column and specify the requested number of pixels. 
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Chat 
eM Client has built in Chat service which will allow you to communicate instantly with other users of 
Jabber/XMPP Chat network as well as many other XMPP compatible networks.  

Multichat services such as Slack, MS teams and Rocket.Chat are supported as well. 

Follow this link to see how to add your Chat account to eM Client. 

  

Check the Working with Chat page to see the overview of how this section works. 

  



About Jabber/XMPP 
Jabber works in much the same way that Email does. There are hundreds of Jabber servers through 
which a client program can connect. Each Jabber user has his or her own account with one of many 
Jabber services. When a message is sent, the message goes from that person's computer to his or 
her nominated Jabber server. This server then sends the message to the recipient's nominated 
Jabber server. 

This way, the Jabber network can not be "down", whereas if the MSN server goes down for 
maintenance (as it did when it was discontinued), then all MSN users in the world will be 
disconnected, if one of the decentralized Jabber server goes down, only the users registered to that 
server are affected.  

XMPP Chat service is fully integrated into its Emailing and Contacts managing modules, which 
means you easily browse your chat log like you can with Emails, and send emails to your Messaging 
contacts as easily as you can with your other Email correspondents. Furthermore, the Chat and 
Email modules share their contacts pool; this way this product can merge your Email contacts with 
your instant messaging contacts and thereby create a truly integrated contacts roster. 
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Jabber services. When a message is sent, the message goes from that person's computer to his or 
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Jabber server. 

This way, the Jabber network can not be "down", whereas if the MSN server goes down for 
maintenance (as it did when it was discontinued), then all MSN users in the world will be 
disconnected, if one of the decentralized Jabber server goes down, only the users registered to that 
server are affected.  

XMPP Chat service is fully integrated into its Emailing and Contacts managing modules, which 
means you easily browse your chat log like you can with Emails, and send emails to your Messaging 
contacts as easily as you can with your other Email correspondents. Furthermore, the Chat and 
Email modules share their contacts pool; this way this product can merge your Email contacts with 
your instant messaging contacts and thereby create a truly integrated contacts roster. 
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Add a Chat account to get started 
In order to use the Chat function you need an existing chat account, currently "XMPP/Jabber" 
below, "Slack" on page 478, "Microsoft Teams" on page 482 and "Rocket.Chat" on page 486 
accounts are supported. 
Go to menu > Accounts, click +Add Account and then select the Chat/Group Chat section. 

  

 
  

  

XMPP/Jabber 

You can add an XMPP/Jabber account to eM Client in five easy steps. 

Step 1 - You can register a new XMPP account or use an existing account. 

• Select "Use existing XMPP/Jabber account" if you already have a XMPP account 
registered. 

• Select "Register new XMPP/Jabber account" if you have no XMPP account yet. An 
account will be registered for you on one of the public XMPP/Jabber servers. 



 
  

Step 2a - Register a new XMPP/Jabber account - Select a XMPP/Jabber Server Host 
from the list. 
Since the XMPP protocol is hosted by decentralized servers much like IRC, you will be asked to 
select a host server to connect to. 



 
  

Step 2b. - Enter your Username and Password. 
Once the XMPP/Jabber server registration succeeds, you will be asked to provide a username (has 
to be unique) and a password. Once the username and password are accepted, click next to finish 
the registration (skip to step 4). 



 
  

Step 3 - Using an existing XMPP/Jabber account - enter the XMPP ID 

Enter your XMPP ID and password. If you enter your XMPP ID as an email address, the system will 
attempt to generate your likely server host and username. These can be changed manually now by 
unchecking the “Automatically detect server host and username box” or later in your Account 
settings. 



 



 
  

Step 4 - Account Details 

The account name is the name that you would like to be displayed in the "From" field of your 
outgoing messages 



 
  



Step 5 - Finish - click Finish to complete the new XMPP/Jabber account. 

 
  

Slack 

To add a Slack account, select the Slack icon and click Next (or double-click the icon). 



 
  

A secure OAuth login will pop up in your default browser. Log into your Slack workspace and 
then return to eM Client when prompted. 



 
  

Name tour account - this name is used in the account list and in the Chat section. 



 
  

And Finish the setup. 



 
  

Microsoft Teams 

Select the Teams option and proceed via Next or double-click on the icon. 



 
  

A secure OAuth login will pop up in your default browser. Log into the account and then 
return to eM Client when prompted. 



 
  

Name your account - this is the name that will be visible in the account list and in the left pane in 
the Chat section. 



 
 
Finish the setup. 



 
  

Rocket.Chat 
Select the Rocket.Chat icon and click Next (or double-click the icon). 



 
  

Fill in your details, these need to be provided by your admin. 



 
  

And then Finish - these are all the steps you need to add your Rocket.Chat account. 



 
  

Once you add your chat accounts they will be available in the Chat section in the left menu.  

Go to Working with chat section to see how to use your Chat accounts in eM Client! 
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Working with Chat 
In this chapter we will walk you through the main functions of Chat. Make sure to add your Chat 
accounts first to use this feature. 

  

The Chat section is one of the options in the left pane menu at the bottom - you can find it via the 
additional options under the 3-dot button, or you can customize the Navigation options to move 
it up if you use the Chat more often than Calendar and Contacts. 

 
  

Chat section interface 

You will see your Chat account list to the left, same as you view accounts and folders for Mail 
and other sections. 

 
  

You can right-click the account name to view additional options, some of them also available in the 
"Toolbars" on page 493, some unique to this menu. 



 

• Show in new window... opens the Chat in new program window. 

• Show Online Users only users with different Online status other than "Online" will be 
hidden. 

• New contact... add new Contact to your Chat. 

• New Chat... to start a new Chat by inserting contact manually. 

• "My Profile..." on page 495 to view or edit your Chat profile. 

• "Online Status" on page 493 changes your status, such as Online, Offline, etc. 

• Change My Status Text... changes the status your contacts can see. 

• Collapse All to hide everything under account names only. 

• Expand All to show all listed items for all accounts. 

• Account Settings... will open the Menu > Accounts window 

The top "Toolbars" on page 493 options will depend on which account you have opened - XMPP / 
Jabber account, Slack, Teams or Rocket.Chat. 

  

Messages 
To send a message to your chat contacts, click on their name in the left pane list, that will open the 
specific Direct chat in the middle part of the main window.  

Multichats, Channels, Threads in the Chat collaboration accounts work the same way - open 
them in the left pane to view the old chats and add your own replies. 
 
To explain these terms, this is what they mean in the chat collaboration accounts: 

• Multichat - Multichat is a chat that includes more than 2 people 

• Channel - Channel is a chat room, usually based on some specific topic or for specific group 
of people, that users can join or be added to. Channels can be public (anyone can join) or 
private (user needs to be invited by creator of the channel). 

• Threads - A thread, in general, is a side chat under a specific message. The Threads section 
in the chat accounts is a collection of threads you participated in or were tagged in in some 
way. 
 



In the middle pane you will see the message history with the given contact or of the given 
channel/multichat and at the bottom you can write your own chat message: 

 
In the message field you get these options: 

Send File  

Click on Send File button to initiate a file transfer session. As soon as you click on the button, an 
explorer window will appear through which you can select the files you wish to be transferred. 

 

Emoticons / Emoji / Smileys  

Click on the Emoticon icon to insert an emoticon, aka a smiley, to your text message. Because the 
Chat system is capable of handling multiple chat networks, smileys are always inserted in their text 
form. 
You can also insert Gifs or eM Client Stickers which are special images provided by eM Client app. 



 
  

Send button  

Use the Send button with the paper plane to send off your message or attached file. 

  

Toolbars 

XMPP / Jabber 

 
 
Online Status 

Using this option you can set your online status for the account you have currently selected. You 
can also set Status text that will be visible to your chat contacts. 



 
  

Add Contact 

By clicking on the Add contact button you will be allowed to create a new contact - the following 
window will be displayed: 

 
  

You can type-in a name that you would like to be displayed by the Chat contact or you can click on 
Get button by which the application will try to retrieve the username based on the Jabber ID.  

You can also add newly created Chat contact to the appropriate group by selecting it from the list of 
groups that you are currently using.  

In the left pane, Chat contacts can be stored in Groups. 

You can move contacts between groups simply by drag-and-dropping them, or by right-clicking the 
contact you wish to move and selecting the group you want to move the contact into from the 
context menu. You can also create a new group and move the contact into it.  



 
  

 
  

My Profile... 

You can edit and publish your personal profile for your chat contacts on the Jabber/XMPP network to 
see. 

In the Chat Profile window you can enter general information about yourself and details about your 
work, your address and even write a little paragraph about yourself in each of the four information 
tabs in the Chat Profile window. 



 
  

When you have finished editing/updating your profile, click Publish to post your changes to the 
network. 

  

Authorization requests 

When your acquaintances add you to their Chat clients, be it ICQ or others XMPP services, an 
authorization notice will be sent to you requesting your permission for them to contact you. 

These Contact subscriptions are gathered and managedin Chat Authorization Requests system. 



 
  

In the Authorization Requests Manager window the contacts will be listed that are requesting 
to add you to their contacts list. 

You may view their user profiles by right-clicking the account name . 

You may select authorize or deny authorization to contacts individually by using the buttons in the 
low right-hand corner.  

Once authorized, your contacts will be able to see you and chat with you through their Chat clients. 
If you choose to ignore their subscription request, you are effectively preventing them to 
communicate with you through Chat. 

File Transfers 

If your XMPP server supports keeping history, you can view Incoming and Outgoing files here. 

  

Slack 

 



Teams 

 
  

Rocket.Chat 

 
  

• The Search bar at the top can be used to search current chat/channel or all channels. 

• Reply in Thread will open a Thread for the selected message, alllowing for sub-
conversation on a specific message. The Thread will be opened in the right Sidebar. 

• Add reaction will allow you to select an emoticon as a reaction to selected message. 

• Invite is available when inside Channels to add other users. 

• Delete Message will be active if you select one of your own messages and want to remove 
it. 

Some of these options can also be used via hover on an existing message, such as the emoticon 
Reaction, Open thread, Edit and Delete for your own messages. 
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Schedule an Online Meeting 
For instructions on how to create an instant online meeting, please read here. 

  

To schedule an online meeting, use the New>Event option or go to your Calendar and click the New 
button or double click on a free space in your calendar. 

There will now be a pop-up asking you to choose which type of meeting you want to create. If you 
would like to create an online meeting with one of the supported providers (Zoom, MS Teams, 
Google Meet, Webex by Cisco, IceWarp video conferences, GoToMeeting, Meetn), then 
you would select “Online Meeting”.  

If you don’t want to be asked this question every time you go to create an event in your calendar, 
simply click the “Always use this option” checkbox and select the meeting type you want to default 
to.  

Default behavior can also be changed in Calendar Settings. 

 
  

Then you will set up the subject, date, time and participants of the Online Meeting just as you would 
with a standard event. In the Online Meeting field, you can select the online meeting provider, 
based on the online meeting services you’ve added to eM Client. 

  



 
  

Once you’ve set up the details of the online meeting and clicked the Save & Close button, the event 
in your calendar will automatically update with a link to connect to your online meeting. All the 
event participants will receive this link in their meeting invite, or you can copy the link to share with 
others. 

You can easily see which events in your calendar are Online Meetings by the camera icon on 
the calendar entry. 

  

To join an Online Meeting, simply click the Join Online Meeting button at the top of the event, or 
click on the meeting Link or login to your online meeting service and you should see the event 
scheduled there and ready to join. 
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Start an Instant Online Meeting 
If you’d like to directly start an Online Meeting to quickly set up an unscheduled, ad hoc call, you 
can go to New > Online Meeting > then select your Online Meeting Provider. 

This will create an online meeting room within the service of the online meeting provider. You can 
then add more people to the call directly within the online meeting service. 

 

  

Note for MS Teams users, using this method will automatically record an event for the current 
time called “Instant Meeting” in your associated Teams account Calendar, or the Calendar of your 
default eM Client account. 

 
If you don't have an Online meeting provider set up in your eM Client, you can do so in Menu 
>Settings >Online Meetings, read more about the options here. 
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What is eM Keybook? 
eM Keybook is a public encryption key directory managed by the company eM Client. It’s an online 
service where you can upload and manage your public keys so anyone can easily send you 
encrypted messages and you can easily get public keys of the recipients you want to send 
encrypted messages to. 

  

eM Keybook stores Public keys that you upload and allows for the exchange of Public keys between 
all eM Client users. If the contact you’re writing a new message to has a Public key in the eM 
Keybook directory, eM Client will automatically download and apply it for you when you enable 
encryption for your message. 

  

eM Keybook does not save nor have access to any of your Private keys or passwords. It does not 
give anyone access to your encrypted messages or save any of your encrypted messages on our 
servers. 

  

You can read more about eM Keybook's settings in Key Lookup Services, how to use eM Keybook 
or check out the article about Signing and Encryption on our website. 
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Using eM Keybook 
  

Uploading your own Public Key to eM Keybook 

You can either upload your public key to eM Keybook during the keypair creation or anytime later 
in Menu > Settings > Signatures and Encryption > Certificates and Keys. In the Manage 
Certificates/Keypairs window you can use the Upload to eM Keybook button to make your public 
key available to all eM Client users. 

  

Uploading during creation: 

 
  

Upload after creation: 

 
  

  

Tip: This button might also be available instead under the “More” button if your window is too small 
to display all the toolbar options at once. 

 
  

After choosing to add your public key to eM Keybook, you will receive an email from 
keybook@emclient.com to verify your public key upload to eM Keybook by inputting your password 
for the PGP key (not your general email account password). 



 
Once this is confirmed, your public key will be added to eM Keybook and any eM Client user can 
easily send you PGP encrypted emails. 

How to Remove your Public Key from eM Keybook 

You can remove your key from eM Keybook in the same section where you uploaded it - Menu > 
Settings > Signatures and Encryption >Certificates and Keys. In the Manage Certificates/Keypairs 
window you can use the Remove from eM Keybook button. 

 
  

You can also remove your keys at any time in the Menu > Settings > Signatures and Encryption > 
eM Keybook section – just look up keys for your email address and then use Remove from eM 
Keybook button to delete them from the service.  

This does NOT delete the PGP keypair, it just remove your public key from eM Keybook 

  

How to use eM Keybook to send other eM Client Users an Encrypted Message 
First go toMenu > Settings > Signatures and Encryption > eM Keybook and make sure Enable 
Keybook support is selected. 

Next, start a new email to your intended recipient and make sure the  Encrypt icon  is 
selected. Compose your message and click Send. 



If you haven’t added that person’s public key to your saved keys yet, there will be a pop-up asking 
if you would like to import this user’s public key. Clicking Yes will allow you to import the user’s 
public key and you can seamlessly send them encrypted messages now. 

 
  

If they have not added their public key to eM Keybook (or you don’t have eM Keybook support 
enabled) then you will receive a message like this, asking if you would like to proceed by sending 
the email unencrypted. If you would still like to send that person an encrypted message, you must 
reach out to them directly to ask for their public key and then import it into your eM Client. 
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About Tags 
In this age of multi-tasking, we ourselves play different roles, and have different responsibilities. 
The ability to compartmentalize has become an essential skill, one that can help us bring order into 
this increasingly fragmented world. And that is exactly what this product's Tags do. 

  

Tags are just special flags that you can customize and assign to any item. These are electronic post-
it notes that can at one glance let you know whether an email, a contact, a scheduled event or a 
task is work related, personal or if it requires your immediate attention.  
eM Client supports local tags as well as synchronized labels from Gmail and categories 
from Exchange servers. 

Follow these links to learn more about managing Tags, and how to assign Tags. 
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Working with Tags 
  

Tag Manager 

You can access the Tags Manager window by selecting from Menu> Tags. 

  

In the top toolbar you have these options: 

  

Save & Close - Once you are done with all changes, click this button to save them. 

Account selection - This will show Local Tags by default as most tags are stored in eM Client only, 
but if you use a Google, Microsoft Exchange or SmarterMail Exchange account you can select it here 
to manage the Google accounts labels and Exchange categories. 

Add... adds a new Tag, opens up the Tag Editor window. 

Edit... customizes an existing Tag, opens up the Tag Editor window. 

Remove: deletes an existing Tag. 

Move Up/Move Down: affects the order in which the Tags will be arranged in the tag assignment 
drop down menus. 

 
  

The five panels below: Mails, Events, Task, Contacts,and Notes allow you to manage tags for 
those four different  

 areas. 



In each area you have the tag Color, Name and Shortcut columns which contain the existing tags - 
click inside the Shortcut column to select a specific shortcut to your most used tags. 

  

If you open the Google account tags only Mail tags will be available to be edited, but the name and 
colors will be synchronized with the server, so you have the same labels in all devices where you 
use your Google account. 

 

Customize Tags 
This product comes with a set of pre-defined, most commonly used tags, such as Business, 
Personal, School etc. You may of course wish to change the pre-defined tags or add your own. 

You can click Add... to add new tags or Edit... to edit existing tags, you will be brought to the Tag 
Editor window 



 
  

Name: Enter or change the name of the label. 

Color: The color of the label that will appear next to your labeled items. Click on Change... to bring 
up a windows standard color pallet with which you can assign a different color to the label. 

 
Shortcut: choose from the list of various shortcuts to connect them with various tags.  

Use for: Check each item type for which you wish the label to be available. In the sample case, the 
new tag is going to be assigned to Contacts, Calendar Events, Mails and Tasks. 

  



Assigning Tags to items 

Whenever you create or edit an item in, be it an Email, a contact, a Calendar Event, or a Task, you 
can assign tags to it, a way to quickly recognize and assess the nature of the item. 

Once tags are assigned, they will be shown when you view the items. 

  

To assign a tag to an item, select it in the drop-down Tag menu, you can assign multiple tags to an 
item. To remove a tag select it again from the list. 

  

Assigning Tags to Calendar Events 

 
  

Assigning Tags to Tasks 



 
  

Assigning Tags to Contacts 



 
  

You may also assign tags to items in their list views. 

 
  

You can switch from Compact layout to Single-line layout by hiding the Message detail or by 
changing the setting in Menu>Settings>Appearance>Layout. 
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Import 
You can import data from your previous email client or specific files through the Import Wizard. 

Select Menu > File > Import:  

 
  

This product can import emails, contacts and calendar events from Microsoft Outlook, Microsoft 
Outlook Express, The Bat! as well as from external eml, ics, vcf and Windows Address Book files. 

eM Client also detects from your device what programs were originally installed, so not all Import 
options might be available in your list. 

  

Find out how to: 

• Import from Microsoft Outlook  

• Import from Microsoft Outlook Express 

• Import from Windows Address Book 

• Import from Windows Mail 

• Import from Windows Live Mail 

• Import from Thunderbird 

• Import from folder with .eml files 



• Import data from The Bat! 

• Import events from iCalendar (.ics) 

• Import contacts from VCard (.vcf) 

• Import from .csv file 

• Import from Mbox (.mbox) 

• Import from XML file 
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Import from Microsoft Outlook 
To import your emails, settings, meeting attendees, free-busy. statuses, account passwords and 
much more from Microsoft Outlook Express select Menu > File  > Import in the main menu 

 
  

Select Import from Microsoft Outlook and click on Next. 



 
  



Import whole account(s)  

 
  

Select accounts that you would like to import. Please note that you can also choose whether you 
want to import specific items from the selected account (email messages, tasks, contacts, events, 
tags). 

Import selected PST data file 
  



 
  

By selecting Import selected PST data file you can import your data directly from PST files , whereas 
MS Outlook does not need to be installed.  

Click on Next to proceed to next window. 



 
  

Here select folders you would like to import and click on the Next button. 



 
  

Here you can select if you would like to import items to default folders in a specified account or to 
import data to a specific folder.  

Click on Finish button to finish the process of importing from MS Outlook. 
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Import from Outlook Express 
To import your emails from Microsoft Outlook Express select Menu ->File -> Import in the main 
menu: 

  

 
  

Select the Import from Microsoft Outlook Express option and click Next: 

  



 
  

Here you can choose whether you want application to import data to default root folders of the 
selected account by choosing the destination account or you can specify the folder path by clicking 
the Select folder... button. 

  



 
  

Next step is to select the folder which is holding your Outlook Express data. You have two options - 
you can try to detect folder automatically or specify the destination of the folder.  

  

Click on Next to finish the process of importing data from Outlook Express.  
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Import Windows Address Book 
To import contacts from Windows Address Book select Menu ->File -> Import in the main menu: 

  

 

  

Select the Import from Windows Address Book option and click Next: 

  



 

  

You can choose from two options: Try to detect file location or Use specific file. Next select the 
folder in which the contacts will be stored. 

Click Finish to complete the importing process and close the wizard. 
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Import from Windows Live Mail 
To import your messages from Windows Live Mail click on Menu -> File -> Import 

  

 
  

Choose the option Import from Windows Live Mail and click Next.   

The Windows Live Mail option will be available if you have WLM installed or it was installed in the 
past and the files are in the default folders. 

  



 
  

Here you can select either to import whole account(s) or selected folders from Windows Live Mail. 

  



Importing whole account(s) 

 
  

Finally, select accounts you want to import. You can also select what type of data you want to 
import from particular account.  

  

Importing from selected folders 

  



 
  

Choose whether you want to import items to default folders in a specified account like Inbox, Sent 
and Trash or to import data to specific folder. With the first option all other imported folders will be 
created in a root folder of the selected account.  

Click on Next to proceed to the next window. 

  



 
  

Here select Windows Live Mail folders you would like to import and then click on the Finish button 
to finish the process of importing.  
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Import from Mozilla Thunderbird 
To import your emails, events, tasks and rules from Mozilla Thunderbird select File -> Import in the 
main menu: 

  

 
  

Select the Import from Mozilla Thunderbird option, click Next. 

  



 
  

Here you can select either to import whole account(s) or selected folders from Mozilla Thunderbird. 

  

Importing whole account(s) 

  



 
  

Finally, select accounts you want to import.You can also select what type of data you want to import 
from particular accounts.  

  

Importing selected folders 

  



 
  

Here select Thunderbird folder/s which you would like to import. 

  



 
  

Choose whether you want to import items to default folders in a specific account like Inbox, Sent 
and Trash or to import data to specific folder. With the first option all other imported folders will be 
created in a root folder of the selected account.  

Click on Next to finish the process.  
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Import from .eml file 
It's possible to import your emails from an .eml file. This can be done very easily using our import 
wizard. 

Click on Menu ->File ->Import in the main menu and following window appears: 

 
  

Choose the Import from folder with .eml files option and click Next. Another window appears. 

  



 
  

Click Browse...to find the folder in which the .eml files are located.  

If the folder containing your .eml files contains subfolders, check the Include subfolders checkbox 
to import all .eml files contained under the specified location. 

Click Select folder... next to the second address bar to select a mail folder in which your messages 
will be stored. 

Click Finish to complete the importing process and close the wizard. 
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Import from The Bat! 
To import emails from The Bat! select Menu ->File -> Import in the main menu: 

  

 

Select the Import from The Bat! option, click Next. 

  



 
  

Click Select folder... to select a mail folder in which your messages will be stored. 

Click Finish to complete the importing process and close the wizard. 
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Import Events from iCalendar (.ics) 
To import iCalendar events from .ics files select Menu -> File -> Import in the main menu: 

  

 
  

Select the Import events from iCalendar (.ics) option and click on Next>: 

  



 
  

Click on Browse... to specify an Internet location or a local folder containing the .ics files. 

Click on Select folder... next to the second address bar to select a calendar folder in which your 
events will be stored. 

Click on Finish to complete the importing process and close the wizard. 
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Import contacts from VCard (.vcf) 
To import your contacts from external vcf files, select Menu ->File ->  Import in the main menu: 

  

 
  

Select the Import contacts from VCard (.vcf) option and click Next: 

  



 
  

Click Browse...to find the folder in which the .vcf files are located. 

If the folder containing your .vcf files contains subfolders, check the Include subfolders checkbox to 
import all .vcf files contained under the specified location. 

You can also select the folder into which the imported contacts will be stored. 

  

Click Finish to complete the import and close the wizard window. 
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Import from .csv file 
CSV ( or Comma-separated values file format) represents a set of file formats used to store tabular 
data in which numbers and text are stored in plain textual form that the user can read in a text 
editor. This product also allows you to import contacts from this file format.  

To import contacts from .csv files select  File -> Import in the main menu: 

  

 
Now choose the option Import contacts from .csv file and then click on Next> 

  



 
  

Now choose the .csv file from which you would like to import contacts by clicking on the Browse... 
button. 

As you can see, this application also allows you to choose different types of delimiter - choose 
between two options Detect delimiter automatically for automatic detection of delimiter or the 
second option Use semicolon as a delimiter instead of comma. 

  

Click on Select folder...  next to the second address bar to select the folder in which the contacts will 
be stored. 

Click on Next to finish the process of importing. 
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Import from Mbox File 
Mbox is a term used for the file format (.mbox) which holds collections of electronic mail messages. 
These Mbox files can be easily imported. To import Mbox file select Menu-> File -> Import and 
following window will appear. 

  

 
  

This window will appear: 

  



 
  

Now you can easily select an Mbox file (.mbox) that you want to import by clicking on the Browse... 
button and then selecting proper Mbox file. Do not forget to specify mail folder (by clicking on 
Select folder... button) in which you want the selected Mbox file to be imported.  
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Import Settings from XML file 
To import your settings from an external XML file, select Menu ->File -> Import in the main menu: 

  

 
  

Select the XML file by clicking on the Select file button and finally click on the Finish button to finish 
the process of importing. 



Export 
To get to the export menu, click on Menu ->  File -> Export... 

eM Client supports export of data into standard files for each item type: 

•  You can export emails to .eml files. 

•  You can export contacts to .vcf files.  

•  You can export events to .ics files. 

•  You can export tasks to .ics files.  

• You can export notes into .note files. 

•  You can export settings to .xml file. 
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Export E-mails to .eml Files 
To export your emails from the application to .eml files, click on Menu ->File -> Export in the 
main menu and the following window will appear: 

  

 
Choose the Export to .eml files option and click Next>.  

  



 
  

Check all the items you want to export and click Next>. 

  



 
  

You can change the default location to save the exported .eml files by clicking the Browse button 
and select the desired destination directory. Click Finish to finish exporting your email contents. 
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Export Contacts to vCard Format.  
  

To export your contacts to vCard format, click on Menu ->File -> Export in the main menu and 
following window will appear: 

  

 
  

Choose the Export contacts to .vcf files option and click Next.  

  



 
  

Check all the items you want to export and click Next>. 

  



 
  

You can change the default location to save the exported .vcf files by clicking the Browse button 
and select the desired destination directory. You can also choose whether you want to export all 
contacts into a single file or export each contact into a separate file. Click Finish to finish exporting 
your contacts. 



Export Events to iCal Format 
  

To export events to iCal format, click on Menu ->File -> Export in the main menu and the 
following window will appear:  

  

 
  

 Choose the Export events to .ics files option and click Next. 

  



 
  

Check all the items you want to export and click Next>. 

  



 
  

You can change the default location to save the exported iCal files by clicking the Browse button 
and select the desired destination directory. You can also choose whether you want to export all 
events into a single file or export each event into a separate file. Click Finish to finish exporting 
your events. 

  



Export Tasks to .ics Format 
To export tasks to iCal format, click on Menu ->File -> Export in the main menu and the 
following window will appear:  

  

 
  

 Choose the Export tasks to .ics files option and click Next.  

  



 
  

Check all the items you want to export and click Next>. 

  



 
  

You can change the default location to save the exported iCal files by clicking the Browse button 
and select the desired destination directory. You can also choose whether you want to export all 
tasks into a single file or export each task into a separate file. Click Finish to finish exporting your 
tasks. 

  



Export Settings to .xml File. 
To export settings to xml format, click on File -> Export in the main menu and the following 
window will appear: 

  

 
  

Choose the Export settings to .xml files option and click Next. 

  



 
  

In this window choose the types which you want to export: Settings, Rules, Accounts, Save 
Passwords. Finally click on the Finish button.  

Remember to specify the destination file.  

  

You can also choose to protect your Settings file with a password. 



QR Export 
eM Client 9.2 contains a feature to export selected data into a QR code, which can then be scanned 
from eM Client for Android and eM Client for iOS. More about these mobile apps previews can 
be found on our blog. 
 

This feature can be changed while the mobile apps are developed, but at this time you can export 
data from these places: 

QR Export in Accounts window 

You can export your accounts and connected settings directly in the Menu > Accounts window. 
The QR Export button is available in the top toolbar. 

 
  

Once you click the QR Export button you will get this window: 

 
 
From the Accounts window you can export your account settings and decide which parts to include: 

Include passwords - a password will be exported as part of your account, if you uncheck this 
option, you will need to type in your passwords in the phone app manually 

Include account avatars - Your set account avatar in the desktop will be exported into the 
phone app so you can easily distinguish your mail accounts 

Include signatures - All signatures connected to specific accounts will be exported and used 
automatically with your email accounts 

https://www.emclient.com/blog/come-test-the-beta-version-of-em-client-for-ios-and-android-566


Include templates - All templates assigned to your email accounts will be exported and used the 
same way as in your desktop eM Client 

Include certificates/keypairs - Your PGP keypairs and S/MIME certificates will be exported so 
you can sign and send/read encrypted mail in your phone app 

  

QR Export in Settings 

You can export settings from the Menu > Settings window as well as from specific sections 
separately. 

 
  

Clicking the QR Export button in the toolbar of the Settings window will give you these options to 
export: 

 

Include settings - export general settings currently supported in the mobile apps 



Include accounts - export all your email accounts with an optional checkbox to Include 
passwords and Include account avatars 

Include tags - export local tags 

Include certificates/keypairs - export S/MIME certificates and PGP keys of your contacts, with 
optional checkbox to Include private keys used for signing and decrypting your messages 

Include templates - export all templates for your accounts 

Include signatures - export all signatures for your accounts 

Include QuickTexts - export all created QuickText snippets 

  

QR Export in Manage windows 

You can export one or multiple of some items in dedicated manage windows, this option is available 
for: 

• Templates in Menu > Settings > Mail > Templates and Signatures 

• Signatures in Menu > Settings > Mail > Templates and Signatures 

• QuickTexts in Menu > Settings > Mail > QuickText 

• Templates in Menu > Settings > Signing and Encryption > Certificates and Keys 

  

 
  

In the next step you can click Export to generate the QR code, Cancel will end the operation. 

  



 

Once you click Export button, eM Client will create a code you can use to import your data into 
your mobile app. The data is encrypted to the transfer is safe and the data is not kept on our 
servers for longer than 30 minutes. You can read more detailed and up-to-date explanation on 
eM Client's QR Export page. 

https://www.emclient.com/qr-export
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Data Files 
By default, eM Client stores all of its data in the Database, location of which you can find 
and even change in the Storage settings. The Data File feature is designed to allow you 
to split that data and have the option to unlink it when you don't need it or to share it 
easily with others. Similar to how other programs might treat PST files but without the 
size limitations. 

What is a Data file? 

 Data File is a small separate local database that can be connected to eM Client to use 
when you need it (mount/unmount). The data file will be in our custom file format EMDF 
(eM Client Data file). 

You can, for example, move your Archived emails into a separate Data File and then 
unmount it so your "daily" folders are searched and synchronized faster. The Data File, 
since it's a separate database, can also be stored in a different location from the main 
database, even another/external drive or cloud storage, so you can have the main database 
take up less space on your C: drive. 

Data Files can be used to easily share some messages with other colleagues - instead of 
importing your messages into their own folders, they can just mount the shared Data File 
and unmount when no longer needed. 

You can create a new Data file manually or convert old PST files into eM Client Data 
Files (Menu > File > Import). You cal also drag & drop an EMDF or PST file onto 
the folder list to create and/or mount it. 

The Data Files Manager 

You can find your data files in Menu > Data Files section. 



 

  

This opens the Data Files Manager.  

 

  

Save & Close - Save all changes to your data files and close this window. 

+ Create Data File - Allows you to select a location in which to create the EMDF file. 

Mount - Add a data file to eM Client, it will be added into the Data Files section in the 
folder list.  

Both Create and Mount options will open the system's file explorer so you can select the 
location of your data file. 



Unmount - Remove the Data file from eM Client. The actual EMDF file will stay in your 
device, but eM Client will not have access to it to view it, search in it, etc. 

Up/Down arrows - Change the order of your Data files in the folder list. 

 
The section below the toolbar is similar to Accounts window, where you can see the list 
of your Data files on the left, and see the details on the right. You can change the display 
name of your Data file as well as the Avatar. 

Data Files context menus in the folder list 

 

The Data Files section will offer similar options to the manager so you can mount and 
unmount data files quickly. 

  

If you right-click a specific Data file, you get options similar to Account and separate 
Folder menus.  

 



  

You can Rename the data file here, add New folders into it. 
Copy/Move options will be available for subfolders. 
You can Show and Hide folders similarly to any other account. 

You can also directly access the Accounts settings or Unmount the data file quickly, or 
view its Properties. 
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Widgets 
Widgets are useful add on applications that can be customized to personalize your account. You can 
use them to display your favorite web pages or to read the latest news from a RSS feed. 

You can access your widgets by clicking on the Widgets button on the lower-left-hand corner. 

For information on how to set up your Widgets, see the appropriate Settings section. The same 
settings screen can be accessed by right-clicking any empty spot in the central panel. 

To remove a widget from the central panel, right-click the header of the widget you wish to remove 
and click on Remove widget 

The individual widget windows can be resized and moved around the central panel by drag and 
drop. 
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Sidebar 
The Sidebar will allow you to quickly access your contacts and their details, your communications 
history with a specific contact, list of tasks that you planned to do and a list of attachments 
exchanged between you and specific contacts. 

  

There are four sections that make up the Sidebar:  Contact details, Agenda, Invitations and 
Calendar. It can also show Threads for Chat conversations. 

You can hide the Sidebar by clicking on the arrow near the right edge of the bar. 

 
Just click on the arrow to hide the sidebar. 

Contact Details 

 Contact Details window provides you with quick access to contact details of a selected contact that 
include your contact's email address, mobile/telephone number, skype contact details, and chat 
message contacts.  

 
  

Search - Just start typing and search bar will appear. While using the search bar, you can 
search for all types of messages (i.e. mails, chat messages) that you have exchanged with 
your contact in the past. You can switch between History and Attachments by simply 
clicking on the proper button. 



 

  

 

 History panel is called so because it gathers all your written conversations with the contact. It 
includes Emails, Chat messages and also Skype chat messages into one chronological 
communications log. And thereby provide you with a holistic sense of your communications 
with that particular contact. 

 

Attachments panel contains all the attachments that are attached in the emails exchanged 
between you and the contact. Attachments are sorted in a chronological order, which you can 
customize(ascending/descending) in the Attachment history Options.  

  

Contact Details settings -You can customize your Contacts Details settings simply by left-

clicking on the Options button. This options button  will appear by hovering with your mouse 
cursor over the area next to the Contact Details header. You can choose the manner in which you 
would like to sort the order of the messages (descending/ascending) and you can also adjust what 
type of messages (mails, chat messages, skype calls) you would like to display or hide. By checking 
the option Include Other Senders you can adjust if you want to include the third party of the 
conversation (f.e. emails , where other participants are included in Bcc or Cc of the particular email) 
and by checking the option Include Entire Domain you can adjust displaying of all emails that may 
have different name of sender/addressee, but the same domain in the particular email address. You 
can select Choose Folders... to select folders from which you would like the contacts to be 
displayed. 



 
  

Agenda Section 

Agenda section provides you a quick review of the tasks that you planned to do, upcoming 
birthdays, upcoming events and email messages marked as flagged. All those items are sorted in 
the order of the upcoming date, i.e. the most up-to-date items will be always on top. The Agenda 
also uses the 'Getting Things Done' methodology for your tasks, read more about it in the "Task 
List Display" on page 441. 

Search bar - you can use the search bar for searching within your tasks and events by simply 
starting to write and the search query will appear. Simply enter the "key word" of the item that you 
want to find and the requested item will appear.  

 
  

Adding new task - You can add new tasks directly from the sidebar. First and foremost, write the 
title of the new tasks in the field (lower arrow in the picture) and then press enter. Newly created 
task will appear in the "Date:Today" section. By double-clicking on the task the window with 
possible editing of the newly created item will appear. 

  

For creating and editing tasks see Creating and Editing of Tasks for more detailed description.  

To choose folders from which you would like to display upcoming events, birthdays, tasks and 
flagged emails, simply hover next to the Agenda title and click on the cogwheel icon that pops up. 
Context menu will appear and your next step is choose the option Choose Folders... and a window 
with list of various folders will appear as you can see in the following picture.  



  

 
  

Moreover, you can choose the time horizon in which the displayed upcoming birthdays and events 
will be shown. This time horizon can be changed by selecting various points of time from the 
context menu, again the one which is evoked via the cogwheel icon next to the Sidebar section title.  

  



 
Show of Flagged Mails, Upcoming Birthdays, Upcoming Events and Tasks is active by default.  

  

Invites Section 

This section will automatically take note of the invites in your mailbox and show them in this 
section, so you can quickly resolve all meeting invitations in one place and not scroll through your 
mailboxes to find them. You can also list invites by account or use the search next to the title to 
look up specific events. 

 
  



Calendar Section 

The Calendar sidebar can show a single-day in any section - so you can have your emails open 
while checking your daily agenda on the side. The red line will show you current time to see which 
event is near. 

Using the Settings button next to the title you can select which calendars should be taken into 
account in this view. 

 
  



Threads 

The thread sidebar will only pop up when you're in the Chat section and decide to open a thread - 
this way you can keep the main conversation in the middle section, and view or reply to the side-
conversations in the separate thread on the right. 
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 Technologies (Advanced) 
The following section contains information about technologies and advanced features in eM Client. 

Calendar protocols 

Email protocols 

Chat 

Security protocols 

Security Certificates 

Startup parameters 
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What is eM Keybook? 
eM Keybook is a public encryption key directory managed by the company eM Client. It’s an online 
service where you can upload and manage your public keys so anyone can easily send you 
encrypted messages and you can easily get public keys of the recipients you want to send 
encrypted messages to. 

  

eM Keybook stores Public keys that you upload and allows for the exchange of Public keys between 
all eM Client users. If the contact you’re writing a new message to has a Public key in the eM 
Keybook directory, eM Client will automatically download and apply it for you when you enable 
encryption for your message. 

  

eM Keybook does not save nor have access to any of your Private keys or passwords. It does not 
give anyone access to your encrypted messages or save any of your encrypted messages on our 
servers. 

  

You can read more about eM Keybook's settings in Key Lookup Services, how to use eM Keybook 
or check out the article about Signing and Encryption on our website. 
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Security Certificates and Keys 

 "Three may keep a secret, if two of them are dead." 

 famously said Benjamin Franklin. We may smile at Mr. Franklin's penchant for the theatrical, and 
admire at the gothic fantasies inspired by the notion of secrets, but in the modern digital world, the 
business of keeping secrets is a much less Shakespearian one. 

  

The exact science behind modern cryptography is beyond the scope of this tutorial, suffice to know, 
that sometime between the death of Jimi Hendrix and the rise of Margaret Thatcher, computer 
scientists mixed a few prime numbers with a dash of mathematical magic, and out came 
Asymmetric key algorithms. 

And the Public-Key Cryptography is a methodology that uses asymmetric key algorithms to protect 
communications or authenticate messages. The concept of asymmetric keys has done away with the 
requirement of a secure initial exchange of one or more secret keys as is required when using 
symmetric key algorithms. 

Lying at the heart of the Public-Key Cryptography is two sets of numbers, the public key and the 
private key. Both the public and the private keys are needed for encryption /decryption but only the 
owner of a private key ever needs to know it. Using this system, the private key never needs to be 
sent across the Internet. 

The private key is used to decrypt text that has been encrypted with the public key. Thus, if I send 
you a message, I can find out your public key (but not your private key) from a central 
administrator and encrypt a message to you using your public key. When you receive it, you 
decrypt it with your private key. In addition to encrypting messages (which ensures privacy), you 
can authenticate yourself to me (so I know that it is really you who sent the message) by using 
your private key to encrypt a digital certificate. When I receive it, I can use your public key to 
decrypt it.  

 
  

Certificates 

In practice, secure messages being passed between computers rely on Certificates and Keys. 
Electronic documents which contain digital signatures to bind together digital keys with an identity 
— information such as the name of a person or an organization, their address, and so forth.  



And Email security is based on digital signatures, encryption and decryption of messages through 
the use of certificates. 

  

eM Client supports S/MIME certificates and PGP keys. 

S/MIME 
Secure / Multipurpose Internet Mail Extensions or S/MIME is a standard for public key encryption 
and signing of emails. 

Before S/MIME can be used, one must obtain and install an individual key/certificate either from 
one's in-house certificate authority (CA) or from a public CA such as one of those listed below. Best 
practice is to use separate private keys (and associated certificates) for Signature and for 
Encryption, as this permits escrow of the encryption key without compromise to the non-repudiation 
property of the signature key. Encryption requires having the destination party's certificate on store 
(which is typically automatic upon receiving a message from the party with a valid signing 
certificate). While it is technically possible to send a message encrypted (using the destination party 
certificate) without having one's own certificate to digitally sign, in practice, the S/MIME clients will 
require you install your own certificate before they allow encrypting to others. A typical basic 
personal certificate verifies the owner's identity only in terms of binding them to an email address 
and does not verify the person's name or business. The latter, if needed (e.g. for signing contracts), 
can be obtained through CAs that offer further verification (digital notary) services or managed 
Public Key Infrastructure service. Depending on the policy of the CA, your certificate and all its 
contents may be posted publicly for reference and verification. This makes your name and email 
address available for all to see and possibly search for. Other CAs only post serial numbers and 
revocation status, which does not include any of the personal information. The latter, at a minimum, 
is mandatory to uphold the integrity of the public key infrastructure. 

  

PGP 

Pretty Good Privacy or PGP is a public key encryption program that has become the most popular 
standard for email encryption - it follows the OpenPGP standard (RFC 4880) for encrypting and 
decrypting data. 

Pretty Good Privacy uses a variation of the public key system- each user has an encryption key that 
is publicly known and a private key that is known only to that user. To send encrypted messages 
you need the public key of your recipient. To decrypt a message sent to you, you will use your 
private key to decrypt it. 
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Security protocols 

TLS and SSL protocols 

Transport Layer Security (TLS) and its predecessor, Secure Sockets Layer (SSL), are cryptographic 
protocols that provide secure communications on the Internet for web browsing, email, Internet 
faxing, instant messaging and other data transfers. There are slight differences between SSL and 
TLS, but they are largely the same. 

TLS involves three basic phases: 

1.  Peer negotiation for algorithm support 

2. Key exchange and authentication 

3. Symmetric cipher encryption and message authentication 

During the first phase, the client and server negotiate cipher suites, which determine the ciphers to 
be used, the key exchange and authentication algorithms, as well as the message authentication 
codes (MACs). The key exchange and authentication algorithms are typically public key algorithms, 
or as in TLS-PSK pre-shared keys could be used. The message authentication codes are made up 
from cryptographic hash functions using the HMAC construction. 
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Calendar protocols 

CalDAV protocol 
CalDAV or Calendaring Extension to WebDAV is a standard allowing the client to access scheduling 
information on a remote server. CalDAV works by modeling events, which may be meetings or 
appointments or other engagements, as HTTP resources. Events are encoded in standard iCalendar 
format and organized into WebDAV collections to allow browsing and synchronization. A CalDAV 
server supports a number of operations such as generating free-busy time reports and expanding 
recurring events. With this functionality, a user may synchronize his or her own calendar to a 
CalDAV server, and share it among multiple devices or with other users. The CalDAV protocol also 
supports other non-personal calendars, such as calendars for sites or organizations. 

WebDAV protocol 
Web-based Distributed Authoring and Versioning, or WebDAV, is a set of extensions to the 
Hypertext Transfer Protocol (HTTP) which allows users to collaboratively edit and manage files on 
remote web servers. The group of developers responsible for these extensions was also known by 
the same name and was a working group of the Internet Engineering Task Force. The protocol 
facilitates "Intercreativity", making the Web a readable and writeable medium. The protocol 
provides functionality to create, change and move documents on a remote server (typically a web 
server or "web share"). This is useful for, among other things, authoring the documents hosted on a 
web server, but can also be used for general web-based file storage that can be accessed from 
anywhere. Important features in the WebDAV protocol include locking (overwrite prevention), 
properties (creation, removal, and querying of information about the author, modified date, etc.), 
namespace management (ability to copy and move Web pages within a server's namespace) and 
collections (creation, removal, and listing of resources). Most modern operating systems provide 
built-in support for WebDAV. With the right client and a fast network, it can be almost as easy to 
use files on a WebDAV server as those stored in local directories. 

  

Some servers can have their own protocols for Calendar, one that we support is Google Calendar. 
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Supported protocols 

IMAP protocol 
The Internet Message Access Protocol (commonly known as IMAP or IMAP4) is an application layer 
Internet protocol operating on port 143 that allows a local client to access email messages on a 
remote server. IMAP4 and POP3 are the two most prevalent Internet standard protocols for email 
retrieval. Virtually all modern email clients and servers support both. 

IMAP supports both connected (online) and disconnected (offline) modes of operation. E-mail clients 
using IMAP generally leave messages on the server until the user explicitly deletes them. This and 
other facets of IMAP operation allow multiple clients to access the same mailbox. Most email clients 
support either POP3 or IMAP to retrieve messages. However, fewer Internet Service Providers 
(ISPs) support IMAP. 

E-mail messages are generally sent to an email server that stores received messages in the 
recipient's email mailbox. The user later retrieves these messages with either a web browser or an 
email client that uses one of a number of email retrieval protocols. While some clients and servers 
prefer to use vendor-specific, proprietary protocols, most support the Internet standard protocols 
SMTP for sending email and POP3 and IMAP4 for retrieving email, allowing interoperability with 
other servers and clients. For example, Microsoft's Outlook client typically uses a proprietary 
protocol to communicate with an Exchange server as does IBM's Notes client when communicating 
with a Domino server, but all of these products also support SMTP, POP3, and IMAP4. 

IMAP allows users to access new messages instantly on their computers, since the mail is stored on 
the network. With POP3, users either download the email to their computer or access it via the web. 
Both methods take longer than IMAP, and the user must either download any new mail or "refresh" 
the page to see the new messages. 

Advantages over POP3 protocol: 

• Connected and disconnected modes of operation 

• Multiple clients simultaneously connected to the same mailbox 

• Access to MIME message parts and partial fetch 

• Message state information 

• Multiple mailboxes on the server 

• Server-side searches 

  

Case-sensitivity for IMAP folders 

Although RFC 3501 (IMAP protocol) treats folder names as case sensitive (with the exception of 
"INBOX" folder) the actual behavior varies with different servers. Some servers allow case sensitive 
folder names, while others treat names differing only in lower/upper case letters to be equal. It may 
depend on the platform or file system the server is running on. Moreover, it may even depend on 
the folder hierarchy where some parts are case sensitive (eg. personal folders), while others are not 
(eg. archive stored on a different file system). RFC 3501 provides no provisions for detecting 
whether a server or particular folder hierarchy is case sensitive or not. This all stems from the 
original design of the IMAP to work on a variety of existing message stores. It doesn't accurately 
reflect the current situation where many IMAP implementations are deployed as cloud services or 
where a message store format is dictated by particular server implementation. 

Similarly, clients don't always handle case sensitivity correctly. For clients that use the local file 
system as folder storage, the case sensitivity of the file system could play a role. Traditional MBOX 
or MailDir storage systems will behave as case-sensitive on most Windows systems thus causing 
issues when server contains conflicting folder names differing in a letter case. 

In eM Client we try to preserve the case of folder names as entered by the user or sent by the 
server. However, we do not allow two folders with the same name differing by the letter case to be 
present at the same level in a hierarchy. We have to work with a large variety of servers and 
interoperate with mailboxes accessed by multiple different clients (including mobile ones). In 
addition, we allow offline operation where we cannot immediately get a feedback from a server on 



what operations succeeded and which one didn't. This involves many use cases where 
interoperability problems could occur if full case-sensitivity was allowed. The number of servers and 
clients properly supporting case-sensitivity folder names was deemed so small that we found 
supporting it was not worthwhile 

  

POP3 protocol 
Post Office Protocol version 3 (commonly known as POP3) supports end-users with intermittent 
connections (such as dial-up connections), allowing these users to retrieve email when connected 
and then to view and manipulate the retrieved messages without needing to stay connected. 
Although most clients have an option to leave mail on server, email clients using POP3 generally 
connect, retrieve all messages, store them on the user's PC as new messages, delete them from the 
server, and then disconnect. 

The fundamental difference between POP3 and IMAP4 is that POP3 offers access to a mail drop; the 
mail exists on the server until it is collected by the client. Even if the client leaves some or all 
messages on the server, the client's message store is considered authoritative. In contrast, IMAP4 
offers access to the mail store; the client may store local copies of the messages, but these are 
considered to be a temporary cache and the server's store is authoritative. 

SMTP protocol 
Simple Mail Transfer Protocol (commonly known as SMTP) is a relatively simple, text-based 
protocol, in which one or more recipients of a message are specified (and in most cases verified to 
exist) along with the message text and possibly other encoded objects. The message is then 
transferred to a remote server using a procedure of queries and responses between the client and 
server. To do this a mail client must use POP3 or IMAP. Another SMTP server can trigger a delivery 
in SMTP using ETRN. 

Either an end-user's email client, a.k.a. MUA (Mail User Agent), or a relaying server's MTA (Mail 
Transport Agents) can act as an SMTP client. An email client knows the outgoing mail SMTP server 
from its configuration. A relaying server typically determines which SMTP server to connect to by 
looking up the MX (Mail eXchange) DNS record for each recipient's domain name (the part of the 
email address to the right of the at (@) sign). Conformant MTAs (not all) fall back to a simple A 
record in the case of no MX. Some current mail transfer agents will also use SRV records, a more 
general form of MX, though these are not widely adopted. (Relaying servers can also be configured 
to use a smart host.) The SMTP client initiates a TCP connection to server's port 25 (unless 
overridden by configuration). SMTP is a "push" protocol that does not allow one to "pull" messages 
from a remote server on demand.  

Tip: If you are not sure whether to use POP3 or IMAP protocol, then use IMAP 
because of significant advantages over POP3. 
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Startup parameters 
You can use a number of different startup parameters to simplify your work. 

Here is a short overview: 

/dblocation PATH 

This parameter will determine which folder will eM Client load the main database from. If the given 
folder does not exist, eM Client will create the folder and a new, empty database in it. Without this 
parameter, eM Client will load the database from the currently set default location. 

  

/localmutex 

Use this parameter when deploying the application in a Remote Desktop Services or Terminal 
Services environment where accessing global mutexes (short for „mutual exceptions“ in 
programming) is forbidden – the application will use local ones instead. 

  

/mailurl RECIPIENT 

Use this parameter to create a new message with a pre-defined email address compliant with RFC 
6068. Example: MailClient.exe /mailurl "mailto:user@example.org?subject=hello&body=bodytext". 

  

/open PATH 

With this parameter you can open any .eml, .msg, .vcf, or .ics file in eM Client. 

  

/newmail 

This parameter will open a window to compose a new mail. 

  

/newcontact 

This parameter will open a window to create a new contact. 

  

/newevent 

This parameter will open a window to plan an event. 

  

/newtask 

This parameter will open a window to create a new task. 

  

/importsettings PATH [-s] [-p PASS] 

This parameter defines a file which contains eM Client settings and its password, which needs to be 
used to import the data. It needs to be an .XML file and can contain application settings, account 
configuration, templates, quicktexts, and rules. PATH is the location of the file. The rest of the 
parameter options are optional. [-s] stands for „silent“ and means that the settings will be imported 
without opening the UI. [-p PASS] is for inserting the password, if there is one protecting the file. 

Example: MailClient.exe /importsettings "c:\Temp\settings.xml" -s -p MyPassword 

  

/activate 



If this parameter is used on startup, eM Client will try to activate a license. For activation to be 
possible eM Client needs to have a LastActivationKey entry in its database with a valid Activation 
key. Usually, the LastActivationKey value is set using the /importsettings parameter. 
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 About eM Client 

Company Information 

eM Client Ltd. is a young software company on a mission to provide the best desktop email client for 
Windows and macOS on the market.  

We combine our previous experience with both email and calendaring software to create a powerful, 
but easy to use email client. 

  

Contact Information 

Email: 

Pre-sale support & questions - info@emclient.com 

Suggestions - suggestions@emclient.com 

Sales Department - sales@emclient.com 

  

Address: 

eM Client s.r.o 

Thámova 18 

Prague, 186 00 

Czech Republic 
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